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2018 % 11 A 23 H
SDN=Ua0 DHFHEE WERBLVBRREADHEEZUTICRELES,

MIDI $&E

Dorico 2.2 I£. Y7 ILBA L MIDI $xEHReziEFHELEL-,

#EASKRE: Dorico ZEBNT HHIIC. MIDI F—R—FHMAaE1—2—ITHEKEsh.
BRAAD>TNDZEEFERLET, Dorico [FIREFATIE, ETHIC MIDI T/ A
ADEGIREDELZRETEFE A,

Flz, KEHEANETEIRIC, Vv IICEHOE TEMGV X LEAALTHS
EC. VAT LDLAT OO —%F VI HEEHTIOLET  HIELTIE, #HR
TROzINERIBLT. TL—Y—%EML. 4/4 O/NEIZEWLOMEMLET, (EL
ODRFERIRNLTHREEFIBLIZD, VUV IICEHICZALZEHET 4 78H
ZEELTHEY,

4 NERFBPEIVDHTAICHNCEREINDIZLITBENTLLEID, CDEE. REHR
EDIBE | DR—CDIFE 1D avIZEFHFLGERSNIZIMIDI AALSATIY
—##1E (MIDI input latency compensation)]A 73> MDfE% 50ms HEIZER
ELT, PYLHLTHTIZELY,

HLLERLEEFHIC 4 DEFHIBLYRASICERESINDIEE . TRE (Edi)) » TT/
AREETE (Device Setup) | TN\YI7—H A XEFHOLLTH TS, FAYT T
EORELGWVRELI-BEEZITLEASR/IEDEEERLES, Windows 72>
TELN A —TAXTNAREZFERTHEE . EREOSWVTILIALANE
TEZBEITDEN AT —DNELNGWNMGENHYFET . COZE.ASIO I
g b USB ERONBA—TAF A0 2—Tz—RADBEAEETITHLET,
MIDI F—HR—FI[& USB A —TAA AU 3—Jx—RICEEERITILELEHYE
HAh, AVELI—R3—DF—TAA YTV RATLDOLATOV—N+HETHIX.
MIDI F—AR—KI(& USB TaAvEa1—4—IZ##KI NIE+5 T, Dorico &fE
¥ 5LETIL, Steinberg UR ¥1)—X®D USB A—TA4F AV 3—J1—ANHTT
HTIN. EMmEL ASIO FIAN—ZEHF DA —TAFAF—Tz—XTHNIEE
NTLREHYFEE A

FED MIDI AATNAREEMET S MHRETIE. /N\—FvI)L MIDI 5—7
IWOERTHROT TV r—aV A& &S, Dorico [FarEa—F—(T#Eiantz
ED MIDI THRAAMBTH MIDI ANZEZELET . HED MIDI T/ALZAHDS
D AHN% Dorico MZELLGVKIEMETHICIE, REZEDOIHE (Play)iN
—IIZHAIMIDI AAT/8L4 X (MIDI Input Devices)l/REZ2&E91)v9IL T, TR

2R—=T Steinberg Media Technologies GmbH



Dorico 2 /N\—2av R

@ steinberg

INBEATAY TCRERTNAADF IRV IREXATIZLET,

D)y ORE: BREEHRT SIS [BEA T av IcHLGEMSN T YUv)
(Click) IR—=D T AR/ —LOVYIDEREEHER T AIEEHITTOHLET . VY
VOB OURE BERE—TEL ARG TOANANO/— LRIV D EEEDY
YIED 2 BEMBIRTEET, Dorico DIHPRETIXE—TAFERSN, /M
o 1 HEIZEEVENBLEN, 2 BB URIZIKEST/NESHDENBLSNFE
T, HASBICHEISNSIGE . HOBIZIESSITEVNENERSNES , CCTE
9% 3 DOBREEINETNEYFERAST—ERETEET,

Dorico D#IHARE TIE, BMAFTIEHIE R EISN T EE5HAFTILEL DB
NET, COEG. TESAFTHESE (Subdivide beats in simple time
signatures) | LT & HFTHZESHF (Subdivide beats in compound time
signatures) DA 7L 3> THIEHITEET,

Dorico X MIDI B HIXEICV)VIFBLLET M. Y—IL/IN\—DZ &
TSV RR—F TR T EHREAVED )V ITBHET. BERIZEHEI Y
HEEBLEET,

9D FERDR—2 P L—A—IDoricoBeep IZ&k>TRBINET . VUvY
[CERAT AT NAREERTHIHE(E. BEE—RTEALINYIDRIYINYT —
DIAVEA—LZFERALT, VUvIZEED VST AVRARYILAVMNIFEHTIL—T
AV TCEET . FHIZKBVIVIDIN—T1U T 71156, TDHETADT
HMZEMT BT RTOEHRA UV ARSILAVMIHLUERICEDIL—T1VTEITH
SHENHBEITEEL TS, Dorico 1I2&BAV AR ILAV D EEIIL—T 4
VUICRTIBEIE. TBE (Play)l » TBETVFL—b (Playback Template) | h
BT 24 FDBETUTL—FONTAMNERERLTESN,

NI/ Dorico MAMAARE T, FERWBATICE 1 DEDHVURA DT
BONETH. CHIETBEFTav 1 0I9)v9 (Click)IR—DTIAIUR 2D
INETEE (Number of bars count-in) 2 ZEBE 5L THRETTEE T, 7O0—DEA
MEBELYERAOUETHREZHIRT H15E . REFRMEIYVAICHEET HEED
NBEDNAIUMUE—RICBESH . FHRNOBREDMEZTIBELOI LY E
ED

DAVBAXDEERTE: BRI HEEOABIHRVD. BULEIA A XDEREEITE
WET, zERIE ERTINEDFIC 8 R EFIVENEHOBTHANELALH
TIHEWEHLID>TWEERIE. VAV A XD ELLY 8 R ERICHETHIRET
Y VAV AMREERTHICE. BREREDIBE (Play) IR—2Tlo42484X
#7232 (Quantization Options)1&#2')voLET .

BEJXLOBHREEFRRAOEFICIE BRICIF AL XA T aVNAEBEINT
WET . EFZEZTLLRVIEA DM TR BEIE. TEFERE (Detect
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tuplets) 14 7I=LT. Dorico ASEENEEEHELBIMT HTLEHLLET,

& EZMM8 T % Dorico TIREBEHRITEMD/NILHEERTETE A HER
RETIC, TRE/NE N EBHDAR—ZAMNMERFH THAH_ELHRL TS E
EICIHFREMNBRESNTLDIZEEL, [Shift]+[B] L T/MNETL/NTIRDOR YT
F—N—%ZFE. BT H/NEHBEASNLT [Return] 29 LT ERD/NETE
REGEMTEEY,

BEZHIIBT ARIE. BRETHERDERFIIARFERIRNLET, Dorico 12D
ERICHEEIOIRVDEMICHEELTT  ET/BEDKERDA VALY ILAVE
8RBT HLEE. AFREEFAMADERODBTFIEIKRFEBIRTIVLEL
HYFEL A, Dorico [FMADERICEFET T HEHIML. EVvFICRVNEFZBEBH
[CETORERICIRYSTET,

Dorico IZHEDEBADHEE . FEXEROFADERDOA~NDEEEIET
T556. REEFABTIUEICFrLYMERRL, ELLEHNERIN TS
EEXVLYNEDAV D —3—THRBLET . [V] 2T &L FEHNERICEET
ML HTYEDHY. [Shift]+[V] 2B TL EEOFEDAMEF SIZFHLLELR
DIERZEERBTEET

Dorico @R ETIE, BREETEOIFRMOBEDEFIIIRNTLEESLFT,
FRISFREI S EFICREAREY—VI S5 BRERBAIICHNEE—FEA
VISLFET ([Q] Z#9).

ELGEIRTES. TBE (Play)]l » T&EF (Record)IZ:&IRT 50, [Ctrl]+[R]
(Windows) #F1-1& [Command]+[R] (Mac) Z##LT. FEZ/HIBLE T,

FRERBAIOAV OO BELEETAICE. TBEATav 10T 9Uvd
(Click) IO R—TI AU D INE# (Number of bars count-in) 1ZEXEL
Y,

BREFIE/NEFLEEFROBEANYELBELET A, BEE—FTIEEFIERRSN
FEA LML BAE—RFTHREZTEIGEIX. HEEXRDAV ALY ILAVED
E7/B—ILICERNRREINFET BRELFELTHE, BEE—FOEEICHEE
NBENRTRINET,

JEEREEED MIDI A AT 2R BAP(E, MIDI F—FR—FZEERLTT
A—N\YIENBFEHEFTFETN, ChIFRaTICRESIFEA BERITESRL
BEEHRLTEEL2IEzH NSRRI UVIEE. FHEHD MIDI AR
T—ARRMEEEFERALT. ChERa7ICRETEET,
BARIZF—R—FTERLIEHE. BEEELLTHL, BELEEFEANTS
ERT.ANTINEDOERFIIAFTERIRLT.TBE (Play)l » TERER
M MDI AHTF—4%i§H (Retrospective Record) |Z &R I % H .
[CtrI]+[Alt]+[R] (Windows) Ff=I& [Opt]+[Command]+[R] (Mac) Z#LFE T,
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FEERETRD MIDI ANT—2EHEED/N\YI7—(TBLERBOEITEESND
=&, BRI BERIBIYATISER SN B R IIETTEEE A,

BERITEREIRE 5 BETETERTINDAURMYILAVMIEE T HE.
Dorico [FIRBHREDIFEFDANLEE (Note Input and Editing)JDR—IZ
HEFINEEIFXTVIRADAA (Input onto kit or grid)JIDA T avIZitNE
T, INICKY, ANSNEBERD (FEREBFLIEABTEEICKT D) ERAEIC
ST DM FUEMDERTEN—HYa vy T TIRESNDE Y FICEEHET 5H
DWThNEEIRTEET, 1= Dorico [, BAVRMYILAVMIERTHEERIC
DNTIFHMITEBIYMNERE (Edit Percussion Kit) IF 47O ICHEESNDEE
DIRY S FIZHNET

BT RE—K: Dorico D#HAETE TIL. MIDI HFEFOTURIETO—NDT
UIREEBICRVET . ChEFERLBDITURTRELTEIGEAIL. THBE (Play)l
» TEEFYHRE—FK (Fixed Tempo Mode)|ZAIZLET, ZhiZ&kY Dorico
DERERLUBERICEE SN T URESEERTHLIIHVES . FEAET
UIRE—RDF A TIE Y= ILIN—DEIZ RSV RAR—rD . HO B ERDTE

x2Uv09 5 ETHYYEZLNET,

FUARIZHES BT

BETURE—RNAUDEZIL. BERLUBREDTURIEIRREINDIBIEEZS)
YILTLETFICRSYT 5 ETHREITEET,
BERX.BETVRTHEATATUORDERL, BETURE—RETURIZHES
E—FOYYEZELITHAFEEA.

BOAAA4X: 5L (F=X MIDI #ETHRARAENE) SHEBIAVSA
XTBICIE. B A4 XTHEREERLT. T$RE (Edit)] » TBYA 24X
(Requantize) JZ:BRLET . A4 7O NS, BEREMISHITILDERL.
MIDI S5 B DIF A4 RSB EFIEET AT avERRLET FILLREEER
LTIOK1ZEDYILET , BHDBIA 24 XN ENIHIZRITSNET,

JE—k<w—h—

Dorico 2.0 IZBITHVE—MMIREFVIE—MENOBEDHELZERELLT.
Dorico 2.2 [& D.C/D.S/A—8BEDTYUTICHTIEMERELESETIEN
[CHR—bLEFT NVE—FI—D—F.BEE—FOITRERLRS (Repeat
Structures) /3L, Ff=l& [Shift]+[R] DRYTA—/N—MSBMTEET, LA
TobATavtBEA T avOEAIC. SESFLHREBTONES LUSRICET
AT AV ABENTUVET,

Dorico TlE . VE—FI—Hh—IF 2 DIREEIIFT . DvUTREBEF . HEDSE
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BTEENOYUTIEHRDOMEEZIEEL (D.C. al Coda %&), —AVE—rEY
2avE . Ov T EHEDAME (a segno *° a coda %HE) PEEORTHE
(Fine 2&) ZHEELEY.

OYUTRBEERT S Dy TREFERIATHL O YU TREL/NED
RKEITEMT BEIE. DroTHRRrOAmMARI AN H/NEHIRERIRT 50, RD
INDBRRMEDEFEEIRFEERL, LEBEE—FDIRERLS (Repeat
Structures) I/ARILDSERED DYV TEREEY) VI T HH . [Shift]+[R] Z#IRLT
VE—FREDRYTA—N—%REET,
RyTH—N—DEXITTELRYFRRICITHEADLIICL TSSO, v T
RITLETHERE TEANTEET . RyTF—/\—ITANTEELDDHI%E L
TITRLET,

= D.C. al Fine: dcalf, DC al Fine, D.C. al Fine

= D.C. al Coda: dcalc, DC al Coda, D.C. al Coda

= D.C.:.dc, D.C., dacapo

m D.S.:ds,D.S., dal segno

= D.S. al Fine: dsalf, DS al Fine, D.S. al Fine

= D.S. al Coda: dsalc, DS al Coda, D.S. al Coda

= To Coda: toc. tc. to coda, To Coda

E—=bEI2avEERKT 5 VE— I3V FERATHAO. JE—F VY
IVEINEIDEEITEMT BRI, UL arY—h—DEmMARIZ SN D /NET#RE
BRI 0. MEIORBNEDE R IIAKRFEERL. BEE—FOIRERS
(Repeat Structures) J/ARIILMEBEDIYE— I3 E )y T B,
[Shift]+[R] L TYE—FRBDORYTA—N—ZREFET,

RV TA—N—DEXIFRIRIC, 2723 KRBT HLETEUGANTENTER
(FANDEIIEREASNTVET , ANTEDLDDHIELTIZRLET

= Segno: s, seg. segno

= Fine: f, fin, fine

m Coda: c, co, coda

HEEPOERE: O—45 0 a iKY H&. Dorico (Fa—5 &EENLRETD/METZE
B[EMIZH T2, BBIMNICHEBRICHREBEALET RO TI+/LEOXRE
SlE.FEA T3 DIYE—RT—h— (Repeat Markers) | R—T T, B H®
aA—FtHL a3 DEINT 74)LEDMEEE (Default gap before mid-system coda
section)IDEZEE T HLTRETTEET . MHE P ORIREE < IZFHE T HIZIE.
FEE—FICUYBAT. TEFDODAR—Y (Note Spacing)l'V—ILEAIZL
FI. a3V A ORBUBICRKELEAVNUFILNARTSN, ChiE
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[At+EED KX —CHBEZEGICHMARTEET, (2T [Ctrl] Fz(E
[Command] Z#J & KREBITEET )

HE D OBREICX T 23—FY—h—DT I+ MIBLRATH TEE T, EARMICIE.
BEA TSI ODTYE—FIT—HhH— (Repeat Markers)IX—T DI KL E

(Horizontal Position)1t€4 23> CIHEBORABMEBOI—F T —H—DEE

(Position of coda marker at start of system)IDA T3 EEETHIET., M

[ROHLEDERBOFIBMEICHIZ SN, FREABRREIN-EHRELHATOH

EDAR—Z DR EICHIZ 2D EERTEET,

A=A a3V ORBRMEBIC/MIBESERRIEDIGEEIE. LATIMETT o0
NhET &S (Bar Numbers) IR—D ClIa—4S OBKRHEBIC/NMNTIBEEERT
(Show bar numbers at start of codas) 1A IZLET,

EIRIDIEE LT REDRNTERSINS/NEICET S Dorico DIREDLE S %
[SHBEFEHLELT vV TTHMEBETETHFDOT AT LICHAGRELITED
NFEEA. cO®. MRS, BAE. BFESLENI—F DEFIO/NEIEI—H
D 1 MEBETERLESHESIEEELTZEL, Dorico &, I—4 ERID/METIZIE
HURESELTCORSFLIFRFEESE—VIRRLEE A, Dorico DFFRD/N—
DAVITBWT. Sv U TR S DMETETHROTATLERI-ODFHEREZIEM
$HFETT .
JE—RIX—h—DHNER: HEA T a>DI)E—,I—h— (Repeat Markers) 1D
R—=DIZF VE—rT—D—DNEREHIET 2 2DFTavbHVES, Tty
EAY 2 DAESIN. CNER—PREFONJE—rT—I—NBOT) Y
(Repeat marker appearance preset) | A =21 —TEIRTEET,
m {8 (Standard)| Tl MAHRESNDOVI/RYTRADEETRL—HEMIC
FAShDREBRACEIGRIZHYET,
= [45—JLF (Gould)ITIZ. Elaine Gould MZEZIBehind Bars]DHEEEIZHE
DI IRA Y —FEEQOEEICELNRITRYET,
2 DOT)eybDELENL, MBEE (Standard) INKYEBIhEZLSn=-X
BERAVNDILIZHL, [T —ILE (Gould)l[E&Y TR CHRMERREASIL
[ZHYET, Flz. V—IILRTIRVE— I —h—ZHEROTICEETHENHES
h3—A. BEHRSNDIOVI/IRYTRADEETIIINODIEREFLERD LICE
BETH5DMNEY—MRITY,
2 2D5VWITNHADT)EvrEBRLEHEE. TVE—FT—hH— (Repeat
Markers) IR—=CDWFINDATLavEBRICRAI TEET . chETEIE. TV
YR AZA—(IZIFREDT) 2y L TIARRL (Custom)IBARRESNET,

=3B LV S REDTFANMIATHIRESEZLEERTTBICIK, [FTHAY
(Design) 1t ar DI ERESDMEE (Scale factor for music symbols)®
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FTLavERELET . v TRBEVE—rEVavEEnEN. THE
(Engrave)] » /854 52R%4)L (Paragraph Styles)]DIJE—bT—h—TF
> 7 (Repeat marker jumps)IBEUTYE—rT—h—tH>3> (Repeat
marker sections)ID/XTT TR\ ERETHET BRIZTAUE REA)L,
DIAE LIV A RXEHETEET,

TIHIEDEE: v TiREEIE— o avid, MPRETIEEROLIZK
RENFET J—ILFTIE Dv U TREET—REBIEEROTIZRTTSHILE
HRLTWET . ZDEDICIEX. LAT7IMFToarnlEREMEE (Staves and
Systems) IR—U ISy o TREE L UIFine IO T IAIVFEIE (Default
placement for repeat jumps and ‘Fine’) JZFE&R DT (Below staff)JICEEL
F7,

HIEDEE., EAFRIYDBAREETRIRSF IR ATIGRETEH. OvoT
HBEEVE—EI a3 OmAMN, RO LICMZ T, HAEO—BTOREROTIC
LRTSNFT, CORTRAVWEFERATRICIE. TOr o TREELUTFinelDT7
#JLMMEIE (Default placement for repeat jumps and ‘Fine’) [T 5E&R D L&—
ETOERDT (Above and below bottom staff) JIZRELET

J—RSyT: Oy TREDO—EIL BT —ILRA R T SRR
HEoHE . RENVFEICRGDGENHYET . COLIEHEE. FEICRIVIE—
METRZE 2 TICHYRLTRRSBAHILIZKY . RBICOY O TETEILEDD
MYDEIEEFTEET . RLWDYUTREE 2 TICHYRTICIE. LATIE
TLar DIk AR (Staves and Systems)IR—U Tl E—khw—hH—DT—
KZwZ (Word wrapping for repeat markers) %2 {TT&TR (Show on two
lines)JISERELET

REE—FTIE—rI—h—%8BET 5 BEE—FTE. OYyoTRBEBLIUVE
—r 023 DBBEEEDHE. DFYIIVRATEAICFSYIT 5. [AlY] &
BLENOEREDRNF—%I CETITHAFET,
HEEIFTIE—II—DH—DUEZRETSH: BFEETFTR. OvUTREB L
WE—r72arORREBEDRE L. YVRTRSVT 50, [Alt] ZHLAEA
SRENF—ZWIETHTHRAFETS  VE—NI—H—ZTIAIMIBIZ) VTS
21X, THRE (Edit)] » TR av%&Utvk (Reset Position)1Z:&RLET,
E—FI—D—DTFXFRA+ELEZT S BEF T avDlYE—FT—H—
(Repeat Markers)IR—C DA T avEFRTNIE, —BRMICERAINZVE—+
I—h—DREHUNIT AR TBHETESET TTA ZELIIELIEHREREIC
KBIETRABERIEE. TONT/RIILDME—F—Hh— (Repeat Markers)]
GIWN—TTIHRALTF AR (Custom Text)IDTANT1EFUIZFBHET,UE
—rR—H—DTHFRANELEETEET,
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BHOOI—Ft—=a3: EHLGTIE—MESEEZHOEMTR EHOI— T F(F
Tt—ZaDEENDEGHEENHYET (EEVA., BENEBICEELGTIE—ME
BEEEREICHRFL IRV RG> THIE—MEEZFEALLG VW TEEL/ERM
THELEBITTOHLEY).

NEEHRTSH=6HIZ. Dorico TIEVE—rEI2avIZIR—A—AOTYIR
(Marker index)17A/NTAZFIBEL. F=Ur TR BIZIX O TEDA TV
Z (‘Jump to’ index)]FO/NRTFTAEIEELT, —HDIVE—MERIZHFIZEDI>
TYIREE|) B THIENTEET,
BEOEL——3aBLUI—FE2ELEDLSIRETEINIIDOVNTIE, FEFTa0D
M)E—k<—h— (Repeat Markers)IOR—C DA T3V FIRATEET,
RELRT QMR SvoTRELIVE— I aVOBEIIMAT. RELTD
INHREAEY RS RIBMBIEE TEDESITHYFEL, YE—MEREERY R I %%
OIS, RERTONREZIRLT, TART4/RILOTAFEE (Time
Signatures)]¥ )L—7TIn [EEZE (Play n times)IO 7O/ T4%&A2IZLET,

In [EEZ= (Play n times) % 3 B LIZERET SE. Dorico (£ E—NNEHRD
FIZVEEBORERYIRELA 2 BUETEONEILEBREBICERRASTHFAMNEKT
LET . RTIHTHFANCEDRRME (VE—MEEDRKRME. BTHE., F
IEZOMEA) [TO2WTODATLavik, FEFA T avnlY)E—bw—hH—
(Repeat Markers)IDR—IDIM)E—REH (Repeat Count)IDEIIavIZHY
F9,

JE—FDFEAE: Dorico [FHE#LGTIVE—MEETLEFMICEELEY . RYAEOD
P¥>7J (D.C. £fzI& D.S) OH L. VE—MIHIREIVIE—MEILINED &S
[SH/ONENEIRETSICIE. TBEATF L3> (Playback Options)IDIRE
(Repeats) IO R—2 T . ID.S/D.C. hoPrrTLI-RICREZBEE (Play
repeats after D.S./D.C. jump)IDFA T avERELET,

AT aviE, FanT4_RxI)LON)E—hT—Hh— (Repeat Markers) D%
IW—TTTBYRLEFIZVE—FEB4E (Replay repeats)1&4>IZd4IET. Y
E—hv—h—C¢IcLEETEET,

S XTF—T4F¥2L—3v

Dorico 2.0 AoEMENT-, /IMEHEYRLESPRAZ Y AFELGED Y X THEA
B ERRE~DYR—rEHEIEL. Dorico 2.2 TIX,. S¥ XDEERBTEIZME
FAShd (fEZLEEERICRESNDIDITTIEEL) ERAMNGEHREOREEEE
FERICHR—NFT, INSEFE v X7 —ToFaL—Pav U Gohan TR
WETHA BFICIET—TAF¥21L—ar TRIKEHBZISEVEETH S0,
Dorico TIXIEMEF (Ornaments) ]/ SR JLIZR RSN, [Shift]+[O] DRy TH—
N—ZEFEALTADEINET,

gR—T Steinberg Media Technologies GmbH
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O AT —T4X2L—LaVEBEROEAICTRTN 1 DT oUhftiFohEE
Ao ERNZIETRY T RO—=TEEITU IR BRIZIERALERIETH—ILDMT TS
NFET, INODERFEDTEMIIERXICEDONE=EDTIHARNIEMND, BEE
BFA=OITENTNITOVWTHEGLET TAVTIE LML RY—TE)TRET
DOBRICTITA—FLET . RAMNIBERNOERL. TA—IILEERMNSTRLE
ER

NEDT—T14Fal—avF AF—ICHA-HIETREMIMMBIGEE L. IR, K
BRRRICKDERTHEMINDIGEEAHYET , Dorico TIRIATEZIRUK], &E
EIRL—X | EMUET,

RE. DY A7 —T4FaL—2avOBEFYR—FENTOEE A MIDI EVF
NURGEDBRMGET V=) TRRTDICIEERIE. YT Tshiz—D3
UBFEETDN—FVILAV R ILAV LD BBHEHEENR . TNEFUH TS
IEHEG S A LTEROEFRDEMEHIBRETEIEHTLENBDELLGST-HTT,
DN RXT—T4¥aL—2a v DBEER FRKDY)—RATEMEINLAREREHYE
ER

DX RT—TAF¥1L—avEBET S DYy AX7—T4F¥aL—avEEBMT I
X, BFFELIEMEELERLC. BEE—FOERAIZHETEHEF (Ornaments) ]
N2 LDITDYX Jaz)) 1 E O avh b EBEDEETREZFZIIUVITEH,
[Shift]+[0] DRy TH—N—IZLTFEAALET,

s JAy7T: TplopITTAYTIRUE, Iplopsmooth ] TTAYTRL—X

m R9—T: [scoop ] TRI—TRUK

m Tk ift]

m FAb: TdoitI TRARRUK Tdoitsmooth ] TRAFRL—X

m J+—)L: [falllTIA—ILRUK, Tfallsmooth | T4 — /LA L—X

O RT—T4F2L—23VFHIBRT 5 O XT7—T1FaL—aviEEnsift
BIH5EFD—ETHA-H. [Delete] ZHLTHREIRTEEFEA (ChETLEIE
EREERDBIBRENET) D YIC, EFZERLTIEMET (Ornaments) /3%
LDISRX (Jazz)loavIZH5THIER (Remove)lR2VEH) Y FBHILET
HIBRTEEY,

DN AT —T4F2L—a ERET S OvXT7—Ta4Falb—avid, Fhbifd
BT3B RICHLEBMICEEINET ., (TR BHES. FRAEZOEFLEND
555 TNODMBLEBINET , Dv X7 —T4F2L—av B DER
DEFICMAGHEE. Dorico [FPVY X7 —T4Fa1L—2aVEZTNTNOFEICEN
EHEDFCERB TEAME, SESFRKFEHAEBICERBIN v X7 —FT1Fal
—2 AV ENEFRRAMICRTINEINELLR LT, ENLDKFLLEEZRZA S
FRETHEELEEEITHENET, £f=. Dorico TIE 1 DORAR—RIZRKRRT
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EFHONVRXT—T4FaL—23vE 1 DEFTHSH. VTRF—I—FTETAR
TOFMEBITOY AT —T4F2L—aVERRTERVNEELHYET,

BIDEODKEARDLEWMER®., ALHMFIHERD O Y X7 —T1FaL—
DAVEBISEIFHITONTIE, BFEA T avIicH L GEBMSN O X7 —
T4¥aL—3a> (Jazz Articulations) JOR—U TR TEET,
RAL—RBOXRT—T4F2L—3ar: RL—XRYTh, AT RARERIED
A—IEERTBIEE. TNETNDRDTIHILEDRSLAEIL. BEAF Ty
DI XF7—F14FaL—2ay (Jazz Articulations) | OR—S TRETEET,
FEEFTRENETNOROBRIGMNEZRE TES-O. MORSLAETBEH
[CEBETEFY . MEEBRLTH L [Tab] ZHLTERFORImEVIVEZ . [AlL]
LGNS RENF—THBLRAGLET, [RE (Edit)) » RSLavEYRyk
(Reset Position) IZ:&IRT 5L DL EBEZEZT I+ YR TEET,
AL=—RGOwXT—T4F¥2L—2av DD REA )L (RIR., TR, KIR) OT2
AIWLE FEF T VDO XF7—T1F2L—3> (Jazz Articulations) 1D
R=UTEETEET, [Shift]+[0] DRYTA—N—THERIN=OXXT7—T«
Falb—2aV([ETIAHINCDBRD R EFERALET A, ARV SERLIZGE
(X, SRV TCEIRLIZARIVIZRIBD R I TERSNET . O X7 —T14F2
L—2ab DD RPN IIVET IHILMZY T BI2(E, TERE (Edit)) » T98%E
Jtvk (Reset Appearance)lZEIRLET,

ZOMDI Y XDEME: LTV T RIT7 . O¥ X 2= (FzlEizM9). N
VED 4 DDV ADEBRMGERBENANTEEFT . CLETENHT
(Ornaments) 1/SRILICFHLGEMENTOw X (Jazz) DI a3V hbRIRTS
. [Shift]+[0] DRy TA—/N—IZTflip]l, I'smear]. Ishakel]. lNazzturnE =%
fbend JEAHLETY,

Dorico D UBI D /N =23 TR.CALDRSEIEZEHE (Playing
Techniques)J/SRILDTEE I (Brass)IDtEILavITA>TULVEL=AS., LIET
D=3V TERLETRD VM ERKIRIZIE. ShoDER AT BEIMICEY)
BEMBICEBRINET,

SDECH, INLDOYADEHENBBMICEBESNSGEFHYEE A,

TURNIYI DHEHAHEEAH

Dorico 2 /N\—2av R

BRE, TV 5 —LD=ODEEERICENTIE., EHBEE-(THFEMEICETIR
NELN, F2—PTACIIFOBEICEEADBELLELIENILKHYET,
Dorico 2.2 [&. MIDI Z7AILDSDTURM VI DERARAH . £-IFRAEDTOY
TODEDTURMNYIDEESHLETESHEETEALELT,

TURRI Y EIZ RIRICIE MIDI I7 0L h DT RIEHR T TIEEL,
SMPTE #7tvh  FREELI—h—REF(SVTICEHET 2 BEMLERE
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@ steinberg

BT HD T, Dorico Tlk, MIDI FZ7MILMEINEDBEZRDO—EEIETRTE
HAAH, IO—IZBEBEDLDEBERZI DD REFDOMOBERIEFRFZLENS
J0—%BELET,

WEDIO—IZTURMNSYIERARADICE. TITFPALIL (File)) » THRARAH
(Import)] » IF2RrSYSY (Tempo Track)IZRBIRLET ., TURINSVIZED
MIDI 74V EEIRT HE UTOEAT7RT BNRRSNET,

@ - Import Tempo Track

Import inte flow:

Flow 1

Import and replace:

B4 Timecode display offset
Tempo changes
Time signatures

2 Markersas JSERICIENN  System Text

[ Cancel m

FA47RYT EBD) A SHEARAAFDTIO—ERIRL, HAHARLTATLDOEZA

TEBRIRLET

» B4 La—FRRDA TV (Timecode display offset)Jl&. 7O0—FitAGI &
DRVIDEA LA—FDHUBERELET .

n [FUREE (Tempo changes)lld. 70— DT RTHEETUREELS LY
BFEHTREEL . MIDI 774D SHARAATZLDEEEBRRFET,

= [AFEE S (Time Signatures)lE. 70— DT RTHHAEFEEEE MIDI 77
AILDERAAATZEDEEZTMZAFET,

» FR%IZ.MIDI 7ML DT—hH—%ET?—hH— (Markers)]ELTHRARAL A,
M TH R (System Text)JEL TEHRARLMEIRTEET . v—h—&LT
SARATHE. JO—FICBEEDV—H—([EITRTESBRI SN T TN, HET
FRMELTHEARARZIGE L. BEOMEBETFRAMIEIBRINEFRA (BRET
BRETHXRAMHIRE T RRICEEMRAON ST A TLEHI A TELRN=OHT
9)o

TOKIZYwITBHE BIRLE=TATLARIRLI-DO—IZHAHRAENET .

TURNSIYIEEZTHTICIE.TT7M4IL (File)y » TEEHL (Export)] »
[Tempo Trackl#ZFRLFET . ESHT MIDI FT7MILDIT7AILBDANZERD
BNET, ZDT7AI)L%E Cubase HED DAW TiRAAH, FA—DEAIVJ1E
BEINZTNDOTODTIMNIERETEET,
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@ steinberg

J0—RHL

BHOIO—%&ETTODIMTE HILLWIA—2R—C D& b CTHIET HLE
NHAGEENHYFET, CHITFICEBRDEENSLIERD AU ARG LA RN
—MIKEON,. EDEEORTHEDICHEITHLWEEN RSN LD N —
AR TY, CNFETIL, Dorico TIEEHDT7O—% 1 DOEMIL—LIZEE(C
RRTEDITEDDOLT . BELGRHL (AL, EHIELRE) OERKIZI—Y
—IZFRoh, FETTHFANIL—LEZEMTEBENHY . LATIMIEA—D
DLEEEHFEELELT

Dorico 2.2 OHLWLWIO—RHLEEETIE. F70—DHIIRTTEINBEERET
U5 —UIDFENRENFEIZGYEL,

.

-t

2. From C major to D major

e

T B

JO—RHELEAEMET S JO—RELEFRIOCIrORE TIEERIC
BoTWET, [FI4IULMDTILATAF (Default Full Score) |l FI4+ILED/S—
ke (Default Part) IlIADIRA—R—SDEYLDIZH (First) JIOTRZ—R—
JI2FTaS s OMERNSD I ERSIN, JA—RHELARH DO TA—DH]
[CHASNDESIZRYFELR, TADIMRICTZO—A 1 DEFTHNIE, 70—
RHELEAIICTBIESNKGEELHYET,

LATIATLar DIR—IOHTE (Page Setup)]R—DI7A— (Flows)lD+

g avizHLGBmMEN =4 T3 Io0—RHHLERFR (Show flow headings)]

TlE, 7JO—RHELERTTIEHEIRETEET.

s [EIZHEL (Never)l: 7B—RELAENLSI. BEMICRRSNGABYE
ER

» [RFIOZ7O0—LIS (Not for first flow)]: JA—RHLIE. LAT IO ZERHTID
7A—LUADTRTOIA—IZRRTEINET , i FHTEHIIREZ—R—T0D
tyb 2, BBERINBIHRM (First) I ODR—SORF7HAEEN. COTRED
(First) IOR—=ORF7IZTAD IRV TIFELTB—2 /LR RSN D
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58, ZYNI7O—DRITIA—DEANLNEET HDEHEET,
s [FRTOHOZO— (For all flows)]: ZA—RHELATRATHOIA—IZRTINE
ER

JO0—RHELOLETICTEMENSTIHILEDORBLICTIEELEY, 7B—REL
(TEEFHEBICRESNSG=O. EBRBITEEFERAIAFEEAN. THRA
FEICERAINET, THREANELODHE. JO—RELO—FTDIL—LD
TiHA. ETOI70—DRYDMEED—F LDERDE 5 RICHEMLET,

TRHIDTAI—R—C%EFERH (Use ‘First’ master page) D74 T ard#L<
BMEINELIZ, CSTIE. THRY (Firs) IOIRA—R—CEERTHDIELAT
FOBRGIBEDA LTS (TRADZA—DH (First flow only)l) . R—CD—
BELENSHBTEIA—IRTET D ((R—VD—FBLTHKITSIA—T AT
(Any flow starting at top of page)l) m. —HIfEALALY (TEIZEL (Never)))
MEETEFET,

JO—RELEHRET S JO—RHELEIRZ—R—CDEvbO—ETHY. TR
A—R—TDYMIFEFNhEFNHEDIO—RHELERETEFET, [TI4HILED
Z)LA7 (Default full score)l&lTFI4ILRMD/3A—ka (Default part) IO R4
—R=VDEYMIEEFLAETN 1 DOTO—RHELAFRESN, CHhIZETHRD
(Firs) IDIRA—R—CDRTFTELRLE®HR. 2FY.78—4214F)L
(H{@flowTitle@} I D +—H > %EH). 70—DEdhE ((@flowComposer@} #
HH) BRVTO—DEGFAE (@flowLyricist@} #FER) NRRSNFET, h
SNDh—2> TP/ (File)] » TFOTHMER (Project Info)jcoa—C
LISTEESN-IBEBRONEASINET,

EBEE—FOARID/R)LIZToO—REL (Flow Headings)ID+EZavhgEHL
GEMEh, EDITRE—R— (Master Pages) 723> GEIRESNTINVS TR
B—R—T DY TCHEATIIA—RELARTINET,

J0—RHELEHRETS5E. [70—RHL (Flow Headings)lt913a>T74a
VEASITNI)YITHE, JR—RHELOITA—DBHEET, COIT(5—(FE
AMIZERRI—R=DDITAI—LRILEDTT M, BES5LDTHIHILEEAT
5012 BLGSERBTRRINET, THEVI. JB—RELER—DDER
TREDEDLLHEWNZOIZ 1 R=ULhRTINGENIEE, BITL—LAIET7O—
RHELO—EELTIEER TEGRNIETY,

JO0—RHELOIL—LIF . R—COECIZEHRBELTHLEWER A, Dorico [F—F&
FOIL—LDLEIHE—BETDIL—LDTimhb, FJL—LIZHEASNST7O—R
HLDTEZERELET, 7JO—RHELEEKDESIEHEEIRINEIKLT, ZL—AIC
INFLEEDEFZVELULITHSIHEWNKSICTEILENHYET,

J0—RHLIEERIL—LIZHTIHERMMEICEASN, ZTNHAETS70—D
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RYOMEICHLT. EEARICEBESMICBEILET . COH. 7B—RELDT
L—LRFEEARAOERFMEEZF T . A—C0—FBLFEATICAOYIINEILE
EHYEE A TODODHY. EEVWT IO ELITEADR—JIHIH L CEE TEE
ER

JO—RHELOEE: IRA—R—UDEYMIEBEHOTIO—RELEZRETESE
o TIAIMMIIBETEST70—RELIE 1 2T TIA. BEFEDEDELEICTH
HoO—RELZERLTHLIEFRIO—RHL (New Flow Heading)lD% A7
A5 TlMe47 (Type)l&lF7+ILk (Default) JIZERETSZET. TIAIWNEER
TEFEY,

TN DTIO—RHELZERTEEE. LA7VMDEEOR—TI2T70—
RHELOEEZEAL. COTA—RELEZZOR—JEFICERT 50, LIBET R
TOR—DIFEATEIMEELET . [R—T (Pages) I/ ARIILTHEDR—DFH
UL TCAVTHFRAMZ2—%2RRL. [JO—RHLOZEEZHA (Insert
Flow Heading Change) I ZZ#IRLTUT DA M T7RJT ERRTSEFET,

K} Insert Flow Heading Change

From page: E ,E Displayed: 5
Use flow heading: | Default ~

Range:

From This Page Onwards

Current Value

D Heading Top Margin: IﬁS.UO H ‘

(3 Heading Bottom Margin: |

TRA—R—=DDtYMNIETHT70—RHLEZITJO—RHELEMER (Use flow
heading) IO A=a1—Mo:ERL . EEDOMNREEEZREDR—DHA (Current
Page Only)J&TBREDR—ULIEE (From This Page Onwards) 1D WLV b5
ELFET . T . FHRAIO-—RHELICERSNSLHMETHORBL LEEZTEEY,
CCTLEEZFRELGWMGE . LAT7OM T arTlRESNIzRALS MDY IZE
RAInZEY,

JA—RHELEBRE TS LAT7IMIEBMSh-O0—RELIE, th&ERLH7ELE
DIL—LTHAHEEDOMYPTTBOIZ. TIL—LHI R THEINET , Zih
DO7O—hMEHFEINDE JO-RELIF. ThAAETH70—DEADOHEERIZED
ETCEBNIIBEILET, ERORR—UTY—ILEFERALT. 78—D—F LD
HEREBELIGE. JR—RELLZNICERLET . JO—RELZENTHE.
—HBLDERAO/NESONEADN\VRILTIELGL HE2EBAOREVLAED />
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FLEERT ZBENBYET,
JO—RHLOTL—LBEKSL, $ET—FOBEOHATBETEES A, ChE
TEIER—DDEEENHELEL. LBRIEZTDOR—DIZEFTEZIL—LDOLAT IR
ST 2 EBEENSTEDOAEEYET,

R=—VN—FLOI7O—RKHL: JO-RHELAR—SD—FLIZKDIFHE. LAT
INAT avFERETO-RELOZECHRESN - EBRBAEERSNFE A,
J0—RHUEEMIL—LO—F LI, LBRBGLTERESNET,

B FHRTOD I TIA—RHELER—CD—FBLEITKLIHEE R—DD—F
LIZREENTOAIANYE —OR—DUFFSLEHMIERTICHEYET, Chid—
RREVGHIRYD ., ERDECLHDOIILFYICETHIEEICHSIBDTY . LA17IH
ZFTa DIR—TUETE (Page Setup)IDR—IICIF, COEEEEEY HF TS
IVDHY . ENENDEREFERTICTINEINMEETEFT,

BRI /07O —RHL: FRERTOD /R TRIA—RELAF VITH
2TLWETH. BENTOP IR TIEA ZIZH->TLET , “hld Dorico 2.2 TH
WEEITHEBNEREINSEEFLL T B TY  f1ZL. #H/\—a> THRED
TaPzIrEHEICE. TRTOIRI—AR—=2D YNNI, TIAHILED TR E—
JA—RELOTUTL— D BEHMICEMENES, ZD=H. LATIMEF T3
VCREEAVICT BT TIOO—RELEFERTEET,

BEQTODIIREERLT, BN—a TEHTEMEINTFRANIL—LOD
MOYICEEFIVO—RHLEZFERTAHGEE. LATINADOR—20D L EEZTZHERT
ZHERHY. CNICEOTEEDLATILDOYLELARBELLIIGENHYE
¥, BE70—RELERBL:- ETERHEICINFESEEDEICXT S Dorico D
FIBF &, 1—F — D FETIR—RHELEELTHES-LET DI &(E, (ZIFFEREIC
BEL51-6TY,

BAF Vb

JO0—RH LHREZ#5E T B T, Dorico 2.2 [ELAT7 IR DTRTHOIL—Y—
NAFIyrTHSHIA—DUEBELEYR—IFT, TL—Yv—"T70— (BLKULAT
IR [CEYSBTORTWVEANSEEEFH-GUNEE . Dorico [E70—2&KIZxt
TEHRKFE. TUOREBBLYN—YILI—IIRELEHTRRLET, Dorico 2.2
Mo, LATINMITL—VY—DEY LB TSN TLWVENIO—FFTHESIZHY . Ch
[ZIF7R—RHELDOHEICTacet IDTFRANRTENET,

AFIVPERTESEDICIE, 7A—DLATIMIBIYETONIRET,. ZOLAT
DEONTHRDTL—Y—£ZDOT70—IZEIY HTONTULVELVREEICLET,

AFIvbERTT D FFTVNERNCT BT av(E LAT AT av Dl
L—¥— (Players)|OR—CDIZFvb (Tacets) DI avIchHYET, #i8

ERENF-T OO O TREEAFIVMNIMBRE TAUICLGOTOET A BEIFEDT
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AR TCINERDIZTBICIE. TFL—r—REYHTEATLVELNTIO—ZS
Fryh%EFET (Show tacet for flows where no players are assigned) %4>
[CLET . COATLavEon—RELOFEREEIRLGCTIAUICTTEEIA. O
no 2 DOBEERRFFICERTSIEEZETIOLET . €535 &IEY. 47T
YRR EDTO—ITHIET DM FARILNLELUEH A EIITHYET,

JO—HDITRTDIL—V—NEF v THIHERITRTT HTXANERET
EFT, PR ETIETacet JEWLVSITHF AR, [$#E (Engrave)] » /85557
AL )L (Paragraph Styles)lIZ#F=ISBMENF=ERD/INSTSTREAIILIAF
bk (Tacet)JITHELIZRAFAILTRIRINET , MHZE T, Tacet | DTF
AMFEBRDOTZO-RHELMA—B TRATESIIITRBTHENTVET . TF
APEEDRABIUVBROREIDA T ar o, BiREFERRIZTEFTav(E.
FEL T avIZHFzIEBMENZTZF Yk (Tacets)IDR—IIZHYET,

AFIIEDTHRALEED LOTOO—RHELEDMERIX. FFzvbD LAIKB
(Margin above tacet) |IOA T3 TRESNFET ((Z7O—RHLOTHIRE
(Flow heading bottom margin) IQEIFZCTIIERALEEA), FFTvbEH &I
H<ZA—RHELEDMRREIE. T2FzyrD FTRIREB (Margin below tacet) J DA
DAVTRESNET,

ERDAN—L VT BEE—RTERODAR—DUITERETHEE 2F VML
ZNEATHEREL TR, KEVEADNVFLTR—UDETITEEHTESR
T, SRICIEBEEMF TNz —RELEEBHRLET .

=L ERDAR—2 0T D—EDEEE . FFoYMIESRALGNIEIZLEE
LTLEZSLY, 122 L [AlY] ZRLGALRTY I LT BIRLIERKIYV EFET
ITARTDEREDERELEHIMICER T HIRELENINIZH-VET . FF Vb
[SIFEERDELZO. [Alt] #HLEASRSYT LTERILBEILEE A
IL—LRYY: 2FybNIL—LOBREEIZRIRINSKLIICTHICE. FE
E—RFTEFzVvrDOTHFRALEHRZERRLT [Shift]+[F] @I, . [HE
(Engrave)] » TEHIL—LOWKEETE (Format Music Frames)] » [JL—LA
XtJY (Frame Break)] Z#ZEIRLT. 2FVvrDOFFIZTIL—LRUYEERLE
ED

kL

Dorico 2.2 TlIh))ILD2EMGRELAITEHNELT-, Dorico DLIFID/N\—
VT MIILOBERERT O LD EICBREFESERRTEELEZN. Ch
(FHARIZENTEFDOEDOTLE, BBRFRESIIRAEDF—Z RBLAGW O o
BREBOLATINMIRRIEIHELE . BLLBBFRELELTRITTILEN
HoTH, TN TEFEEATLE=, Dorico 2.2 DRJILIEFIhEYT 2640 TF)PT
UMIBMELET . RAED/NET DR S DREE RS ST THLEDIKREEIC

17 R=Y Steinberg Media Technologies GmbH



Dorico 2 /N\—2av R

@ steinberg
BEBELAHILLTE, MLOSRORTAELENH PN LRRTEET,

b ¢r
tr~—~ fr~=_»
) ][!i- g
ﬁ I
U |

FIILDER: FICHFRBEEEETICMIILEERLIZES. Dorico IEMJILAET
SEHMO—FBLOEFZFEAL. REDFX—L. RL/NEFRNORIIZHAIEFTHEA
SNSEEH LB ERLTEREHELET . 2ERIE. C AOy—DX—IZHITS
E 7TFaSILDORIIIDERIE.F FFaJNICTRAM>THERTYT (FF.HE 2
E) LHVET, z1ZL, EAFRC/MTADRIZHIRLA VE—T DEFIZU v
— A <IEEIE. FJILDEREIX F v—TI2Ah>T 1 R7v7 (88. K 2
) L5YFET, MIILDOERRIL [Shift]+[0] DRy TA—N—h5, F=FTAN
TAINRILDTR) IV (Trills) 1D T IL—T(2H BT EFRE (Interval) IO TONT1%EF
VISLTHRETEFET . RyTAH—/N\—TERZIEET SIC(E. [Shift]+[l] DRvT
F—N—TCERERZIEEITIDLRLEXZFERALET,

» BFEATE. BEOF—LNIILENIBROEEZHEALTHERLLZTEN
BESNFET . DFYN2IELFRITE TS 2 EITGYFET,

" EEREEEEIAICE. NI XFOMIZEALES & ETm211d5RE 2 EIC
BYET REEBZEETSICIE. AXFOIMIZFERALET &R ETM2]1E
R’ 2 EITGVET,

" EEFREETETAICE. TpIZERALET, X Tp5IlEESR 5 EITHYE
ER

m BEERFIEETSICE. TauglZERALET . & (ETaugdl E1E 4 E(2iY
FY L HMEREIEETAICE. dimIZERALES . A ETdim51ERE 5 &
[ZRYEY,

FIILDBREIE. ZADDEHAYDFEDHETHNIE, EDFIIUT TLEETE
T, BRELTEIBHICIE, [Shift]+[N] Ff=IE [Return] ##HLT/—rADZERH
IR BIETHRYLYMNERTRIE . NIDNETHHEDIBLNVT AN ERICHEIS
FrLybEBELT, [Shift]+[0O] #HLTCEMBTORY TA—N—%2[Z. FED
BREANLET . EROERIFBRES. /NJIYFREMILOER., F£=E+v
LyrDEEDFEOREICMAHEBERELTRRINET,

FIILDERE LZETH=-HICTER (Interval) IO TO/NTA+ZHZYIZF LT
EE. ZOTANTAFEMIILDOBERESN-BREDERICEESATVET . SN
[Z&Y. FAETT HREBE LA REIBELOITALRYET,

FIILDERRONE: MPRETIE. MIILOERETH |BED LICEBFTESEL
TERRSHETH. AbYIZAUDYRORIRANHL, $RT9T (£F) £THT.L
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1 R797 (88) #IWT.ILLRETEFET . BEENE 2 EFER 2 ELY
REVSE. HHEROETRRINETS, CNIFNSLEFELZLOBEFHEIMIC
A2=ED T MIANET HERDICHBEICRTSNET,
FIILOBRERONBRZEZHIEMTE2A T avid  BEA T avDNEHE
(Ornaments)IOR—J(ZFHLGEMESNIZTR) LD EFFE (Trill Intervals)IDJ )L
—7 (IBA—=2a>TIKNEBREES (Accidentals)IDJ IL—TE>1=4M) [CHYFE
T, BB ELIENIIYRREASVIZKEZERERTT MBI, ¥ IBED
E.TFTFEEEEOVWTNAZIEETEFE T FMHTISLTTW.TIODNHEIE, LK
DHDRZAILDSEIRTEET M ERONERICET 24T a3 ELCHFIC
HYFET, CCTIRIRFEE, TFLOHYEL, BLUSEISFHERFLE ST SM
[ROKRESLGENIEETEET,

BATOEANT-F L DRADHFEDTaL—a0h, 16 FEFUTLEFE
SR & (T RAR— VT DENERHIET 51012, HBEFIIRVDOFEDH
ETIEFEL 2 DHOUBORVNT1L—2avDEFOHEIZRTLEEFESIAKE
ELBYET  HEEFEIADOUENYDERALDFBEICHEESEDIEEDT 1L —
AV OLEWVMEIL, FEAF T ar OIEMHE (Ornaments) I TEETEET .

ML DEBRSEFERIST S MLOBRERTTINESND Dorico D
Wi 1. TEST A/ SRILDTRYIL (Trills) 1D IL—T TIEGREERE (Accidental)]
DTANTAEAVITLT, TFERTF (Hide) IF=ETRT (Show) IDWLFhZER
EYAHETLEEETTEET,

L DIRED EFEDONELEREFFRR ST LS. DFEVHEBIB RO N\IDYRREAILD
HTIWRIW.T.IDRETHIEE . CNZEIERRITTBICIE. EFFTRYIL (Trill)]
DT IL—T DI (Appearance)lDTONT1EAVICL TER DM EREERRFED
SICHREL. LD KSICTEEEEES (Accidental) IO T O/ T4 % {F AL CTEEREE
BEERTICLET,

FILHBEBDOEYFICH->THRUSIGEE . EVYFHNELLIEICNIILEBEDO LICE
BABERRINET . EHOBTFICH>TEEENEHLLAEWEEIL. BEIZIG
CTIEHEOBFHICRCA)ILOZFTEMNFFIZES (dentical trill intervals on
successive notes) DA T avEFALT. NUDYRRFSILDRI LD EFEEIE
RNICTEEY, L RS LHMEREEICRREINET,

RJILEERRFECS: Dorico (&, /NEIICR RSN DRI T ERO DRI LD LD
ERERBLET . YR ETIE. LOBTHRELELSEIONABSOELLESTH
BIEEERVT, MJILBRIZEEARTINE T, BL/MEICH IR0 E F O
HBEICEH>TLOEFRNEILT HIGA. NLIZIXEICEENRTINET . ZLT
RIS r—ThISYENMIKEYFEN ILBRNEILSEIHE. HEITHERIL
EvFOERFICITEN LGB ENRTINET, OIS MIILOLOFFIE. B

EBFIVLUREO/MIOMOE Y FICHRYBRRELSERTIEIRICEVT. BED
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EMERILEEEHBET,
WAEIZKDBNILDETRE: TIHILLDRMEL AT LTHS 12-EDO LIS} TEEEE
THHEE. NILDOFRIL, TSN -FFNODLEFTRDRTYTHEN B DK
THETEET . 24-EDO THNIX, BEIEEREZTOHE Aovy— . YMT7—4
E) THEBTEFITMN, A ATLDORENEMN N EIYKREVGEDO, 2FRBD
BRATYTRIORE N T Y —THII5EE. HEBEICKIRRIEIFFEUTHY . F
BIEIA V=T ORETRRITIBHELHYET,

FIIWDER: FEF T3> DIEHE (Ornaments) IOR—U (T HREER OB
REIBDOSA)L (Label for start of system) DA T arNgrf=IZEMESNELT =,
NIFHEERRTYZFECRIIILONRZHIEHL., (4 IEEFZREEERYRTT 5D,
B DOETRRT DD, FIEERTRICTIMBIRTEET

RIILDBRRBBIBED 4 15885, TO/SToDTRYIL (Trills) 10T IL—TF (23 LL
BimEh-TkJILT—H%RT (Show trill mark) IO FTANF4EAVIZLT., Fx
VIRV IREA TITT HEFERTRICTEET

RJILDEE: Dorico [FRJILZEBEIMIZERLTBELET . BETIESIETY
TGSz ILVEFERL, 25 THRMEEFERD/— 2R T—LTRIILD
DRal—2a EFEVWET, NILOBEICET AT avIiE. BEA T avic
FLGBMESNT=TR)IL (Tril) I DR—S THETEET,

Dorico &, VST THRTLyiar Iy ISEERENAEEZSNTLSIGAE. F
AT97 (BB) LU 1 RT7v7 (£8) oY T TSntzt)IILEBEHMIC
BATESDESIZHYZELT=-, ThiblE HALion Symphonic Orchestra M Z# MDA
DARGIILAVMIHHABRE CERINTEY., BUICHEEINSLIITLESTUVET,
YOURSATS)—TH T T ENT=R) LIRS TUORWNMEE S, 1 AT
YT EYKREWNEFRRDOMILIZDWTIZL, Dorico [FRJILDIIaL— 30 %7
FY . BTV T ENTMILETTIRRZ GO L OBV EB RN TES >TE
BEnBmE. Yo TSNz M IILOFERZEFEILEL, 2al—arvahizhY
LWEEARTEATIIINFELVEEELHYFET . COHEE. TFNIILOBE R
(Playback approach for trills)1ZTE£BEhf=FJILDH (Generated trills
only)JIZERELF Y,

B4 IZ NotePerformer AL TSI ELEBKIC.TFIILOBE AR E
(Playback approach for trills)1ZT &£ ENT=F)ILDH (Generated trills
onY)IICERTETHEEHFTITHLET , CNIZEKY Dorico (FFEICIELLN/—MF
|{arbO—S5—IFEXIETE. NotePerformer (FER KBV TZILICM)IILEBAE
TEEY,

HBoT)oGENER) LIRS SNIIL—TUREINE=Y U TILT—2THbB=0 . &
HAHRISDRJILAS, FIILDNZI—U | ZE B FORIEEFEMZASEE, M) IILDE
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ZDN)I—2aVEBERTLEHODNIA—E—FBERAEShTOWEE A, #I(C
BEAERENIMIILIE, AP LESTEEADYICHEVRRMEEZFLET (ML
(Trills) IDR—LDEYDF T ar TR, BBERSh-MIILOEREFIEHTEE
ERS

Dorico [FEBEREINTN)IILEERTHEE. NILDERISLUVR) LD T L
BICEMENEY—LLRICHARAAET . NILOBBEEDERIC 1 DOX
ST ABLOEMBTENMTEE . CNIETRISvhy—584->T 1 FHOLD
ENRDIZGEYET, — A RO EFITEROEHEFL/HUGE . ChEMIL
DINF—VIZTHARAENT T, F2EZFF—PZT DD LD IE/RF—2 15 E
FILDTSHEDEFITAKEMERTL. FILD/IRF—UICHARAFENET,

(BB RE—F (Start speed) &M T RAE—F (End speed)l®70/8T74ThJJL
DRIIZEENEZONTEE. MIILOBENBEIERK THNIE Dorico [EZh
ZRIRCTEFT, CORRE. ML DRSZELSELHBERET HIZIE. HELML
AE—F (Slow trill speed)]. IE&EMJIXE—F (Normal trill speed)lHB LV
MELRYJLRE—F (Fast trill speed) | QENFERAINET, CNOHDEX, O/
TAINRILDIRYIL (Trills) DT IV —T TRIET DT A/INT4ZFA 2T BHET,
RIS EICEEZTEFT MIILDERLDERSELEZL DD REDEILEN)
ILBORRICKRBREELWGEES . HLGEMES T EE O H#E % 1§l
(Suppress drawing speed changes)IDTANTAZRBICAUICTHIET. &
EOR BB RTINET,

HRADEETITAE. NILOERERESN-EFAMREBLET . — A,/ \AY
IBFVHHEIREFKDOBTEICEITHBEE TIEEE. MILDERIZLED (MIILTD
kD) EFHNSBIBLET . COEMER. TERMSh-MIILORKREYF (Starting
pitch for generated trills)JZl EDEFHHF (Upper note)IMT FTOEFHRF (Lower
note) I E T HIETHITTEET . b, TANTA/ARILDIR) L (Trills)]
DT IN—TTIEDOBHHI SR (Start on upper note) IDTA/NTF4%EAUIZT
HET ML EIZEEETEET,

£5 1 D.HICATVIROET7 /EBIZEWT—RMGETELELT. $RTORIIL
ZPoKYNSIFLHTREITRS, MEBESETERTHRIMULBHYET, Thr
BRIBHICIX.TEMER-NILDOT IV EOEBE (Default playback of
generated trills)JZMEEMSENRE—FIZHMZE (Accelerating from normal
to fast speed)JIZRELFET , COFRETIE. TANTATHERORSEZ LEES
NTOEVLRILIETRT, EEMIILRE—F (Normal trill speed)ll= 1 #T&
DEFOHTIRESNIRSNSBELRFAIBESN., EVOMIILRE—FR (Fast trill
speed)JITIEESNFZRIFETIEL TR DHOYFET, Dorico [FEITHELNGHDE R
NEREINDALIICT. BRICTHANLRENHIGEEDAH N IILDRSEEILSEF
ED
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AV ARYILAVRD T V=T e EimET 5:

Dorico Tlk. KIFMEFIFIMDTH A PLNEDF T areébIz . LATIMH
DAVARG LA RERIFIREDEINTY L—TLTEIESEFLRTTO—F AR 1H
SNTVWET, INLDA T avIEBEEF T av DI KIER (T34 vk gl
(FLA4R) (Brackets and Braces)|DR—IIZHY, (FEAEDREHIZENTIZL,
TIHIWEDT =TT TO—F D56\ FT A EFERAITNIK. AZEICHK ST
BEORENBONET TNTEEE. MERICAVRMIILAU DK T IL—T1E
NHERIZE . Dorico 2.2 [ZIECNERLICHRITAXTHFENAAESL T
F9,

RATLAT INMIBERTHY . AV ARYIAVRDER, TAIAPDEBR, AR
GILAV A DFERDEMEHIBR, ZRDERDIERTEEITH->T, HEIZHITS
REROKRNEFERTINMNYBDLIGENHYET . TDH. REDHERERFRDIC
(. RIBMEFFEMDARITAXEFIRT HRNCRAIT DEREEEETRNTEE
B I RTODTL—N—EAV R ILAVNERELTHLZEEHSTTHLET,

F. RBIMEFFEMDARITAXETESZITTIA—D—B R TITHEIZLE
HITTOLET, COEE. DT LAT IR TV DIERDAR—I YT (Staff
spacing)IOR—I CIEZRDFEREIBT (Hide empty staves) 1z &EITERR
(Never)JISL T, R DMBEICT R TOERNPIRTIINSGLIILET . B HA.
AVRRGIARD T =T EEOHIZRELzH L. ZEHD/NEEIERRIC
LTHBUVLERA, AHKRIZ. 70—DEADIEITIVRMIILAVCDT V—TEER
TRIMLELRHDEE. 70—D—BRUMSEROYIZANSH THEEEZITEOTE
S KFEMEFIFEIRICH T EHLVERIEENSH LT IIL—TICEINTITHD
NBzH. 70—DEHYNSIELHICAMN > TEARMEICEEEZTHEISLIEST
THTEEE A,
FEIMDEY 3y FEE—RFTIIT10IDHmEY—ILHIER
SNFREBOEBRO/AR)LIZIE, THEI (Bracketing) 1D &4 { q [[[
TavhFzicBmEh, SSIZEXA VRS AV RO YT L—TF :
EHRERTESRIVAHYET  LTORZUHAHY ., Eh
LEAN, LOFTMETDITALLATHET, i
» [KIEMZEMEA (Insert Bracket)l: ¥ IL—TIEDE 1 LA
IV (—FBRE) T, KIETHEM M. BEIIRICTI7IV—IZET 51 ARy A
UrEERELET, KIEMEXRFBILRRLTEGYESILIETET . F-hiEilLiH
BO/INERICHEELTEREESNET A CNELERYEIIEETERERE AL
n TEIFIIEIEA (Insert Sub-bracket)l: FIL—TIEDE 2 LANJLTT, #HLy
WRTHEIMN. BEIEI7IV—ADORLISTDA VRS ILAUS (TIL—F 2 K
HE) EEFELET . BIIENIL. ThEEHHSKIENMDOMUITHIETILETE
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FEA BIIENORRICHIENNMEREINEGZELHYFET A ChIETHEALDR
A7 TIE—EMTIEHYFEER A,

s [/PEIFEINZEIEA (Insert Sub-sub-bracket)l: ZIL—EDE 3 LANJLT
T, BIEMENRITFE-1-KRILT. BERFRLCEILIVIZET 51 ARy )L A
Vb (FzERE . NAFVoIa0 DRI IV —F—RYOEZITED/ vt
—DIZBITBT4 T4 DR 2 D) EEHELES . /NEIENIX. ThEEDHD
BIEIDONEICIE T ILFTEE A BIFENORRICHFENZERT 55
EITE->TWWAIEE . MEIEIRERTSNFEE A

s [hiFlEHA (Insert Brace)l: Ch3FE 1 JIL—TITERINET IR T
N, BEIRERDAVARIAVL (ET/ON—TRE) #8FELET,
PIENEPIENRI L TH. KIFMELELGYEIZ LI TEFE A PIENEER
LTE 1 JIL—TELTEKBINIERICIE, BIEENFE(S/DEFENIERTRT
EFEEA

= UMD EZEEE (Change barline joins)l: #IHAEXE T, /METEROHE
BIEE 1 JIL—TIZH#5, 2FY—FRAIOKFNMFE I ENTEREEINT
EREICIE/NEFRNEIESINET S RFICETIERICEVTX. I IL—T
EISBARAGNEIRDIE S (XBRRINE T, ST/ ETHR & HRER L D E 2R % [E 8
T 5T,

PRI IN—T T 5 KEM. hiEEEBIENEFIRIER T HICIE. T
—TDRDIERDTATLEBIRLTH Y L—TDOREDERDTAT LEE
RU, BEET—FOERD/RILOTFEIN (Bracketing) IQEVarho@EdlihR
AEI)IILET KR, REIEEEEHEROSEHEELLOMERSNE
T BRFmDAALYILAVCDT V=T IEFHRITIL—TI2EHE T BEIZIELT
HEISNET,

BEOTI—TE2HETSH: HFET—FTKEN., PHEIN. T E/DETREERYT
BEFDLETITNIRILDRITENET , 74T LOFRLI-KRinIE, [Alt] 2L
BHALETORNF—TLTICBETEET, KIBFBMIEEGYEALEV SO, KIF
MO LinE EICBENTEE. ZOLICH - KIBMFEIEHFIMIELLRYET, —
EEGo L. BELEEIETOMEIZRLTEH, TORSICEIRYEE
Ao

REE, FEIL BHENE(S/DEHEIIX. EOLETEYIVRATRIYI $4HIET
LERITOERELEETEEY LELDMERORSE, F—FR—FPa—rhvtz
FERALBEHNEEETEEE A,

HAR: FRITIL—ThEShbE. MERDORRAEICI KIFHME/NTROESR
(Bracket and Barline Change) DA A FNRREINET , HAFHHEERDBAIBAL
BIZRRSNDIGEE. JIL—TOERTREDHBEINSHEEZFLETH., HED
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BHICRRSNDEE . EERIROMBNSHRERLES,

INGHRDIES: INEROBEEOFRERICIE. KEBIMEIEHEIMOFRIERE
BCIEEZTEVET IR OTIL—TDRYVDERDT AT LEERLTHD
ITIN—TDOREDERODTATLEEZRL, FEE—FOER D/ ARIILOTIER
(Bracketing) 1DV avICHBH/NMEBROEEERIVEDIVILET,

BEFED/NEHRD T IV —TERBMRLT, FERICEFNO/NERERF-EDITIE.
HFET—FT/MEREEIRLT [Delete] ¥—Z#LEY, (FREE—FT/MEIRZAI
BRI HE MAIDNEEZY—DLT 1 DORUVVNZER T HIREICEST-0. E
LOWE—FRDBIREN TSI EEREREL TIZELY, )

RIFMENEHIRE 2T B DREAIAXINFZAVRRGILAV DT V=T E2—
ECEIRT 356, TKIEME/NSERDERE (bracket and barline change) DA
ARZHIBRLET

HRBARARXENTF2A VARSI AR D T V=T H#FERLIz\vE—CDHET, BE
FTL VIR EEIN =T IHILEDA VRS ILAV DT V—TICRTIGE. T4
WD IW—TIZRI L EZRIRL T, [§E (Engrave)] » TKiEIE/NHRDY
tyhZE{ER (Reset Bracketing) JZZEIRLET . CNICKYBIRLILEIZA AR
MERSNET A, Vb DRIEROMEDRIBEENIZHEYET,

EIlEDERRONT O —AZERNZ) 2T HIELTEET , CNEITHIES.
AAREZBRLTTONTANRILEREET FHLGEMSN T KB E/NETHRD

Z®E (Bracket and Barline Changes) DY )IL—7 T, TK{FlZ#ZEE (Change

bracketing)1ZI B8 (Auto)lIZERTET HL. DRATA RSN KB IFIL%E

HIBgRCEET . ["NII#REZLRE (Change barlines)JIZEI#DREETHESIE. HR

AIA RSN T/INETHRDIES ZHIBRTEE T,

BRESIT15—

FLGEMESNT[H#E (Engrave)] » TEE
JTIE. DFA4705 (a—KFES. BRiES.
WIRTODEEDNEERETEET,

B (Music Symbols) D& 470
EERGE, 5 TlIIXRE&ETELR
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Ecit Music Symbot

o — 8 3 il L

xofset: (000 |5 xseale: [100.00 [ Zode: gy T

Yofiset: [000  [5] Yscale: [20000 15
Add Glyph
cancal m

RBERATI—ITHESN. CREAATOIDELBOELYS—TRIRTEE
T BEDBIRFEESSICHRYRADES X, hTIT)—tELIE—DFTETOT(—IL
FIZBREXFEINEAHNLET , (BRIGENAELTIX, ThTFTY— (Category) |t
Loa—%[FRTHOHFTY— (All Categories)lIZZET dE. TRTHEE Y
OSBRI —ILE DX FFIERRTEET )

COSEATRY THEDELTEEEMHLI-EE . hiE Dorico TEIERERAT
EEHA ABKENSSH. ABNE. THES. HFNS. ERLEERTTS
=OICERESNEZDIE, TIAHILFTHB SN TWSERESEITTY,
NEDSRILESELEELT, UBRERT TR TOHRTOS I/ TRES N5
BEFERATHESCTHICF. BEERELTIFIFILNELTRE (Save as
Default) 1z ')y ILEY,
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FRIFRC S

FREFELSZET Y1095 hRAZLDBRESET VA0 T5LE. E<LDBFRITE
HOT)IDEAMEMEDRENVEELGYET . BREFEESITHLLI Y TZEEM
LI-EE ENENDT Y IRR—RFA VG HELLTEIESNSLIITRYELT,
CNICKY,. TOAZEELTDIYIL D ELGHEDEEZRRTEFT

F—T4Fal—3ay

ERANDEEZHAISNEED ., RAFVNATAVVEDT —T4F2L—230®
RERERCHTHMEAHESNEL,

MBS

DE—k: NABFBITVE—rERBRLT, /NIAERINST LI/ AT MEE
MEEBOENZESICHYFELE. CRIF.EFEF T avnTNHEE (Bar
Numberts) IO R—2 [2HLGEMSnzTUE—F O3> D /INHES (Bar
numbering for repeated sections)IDA T arTHlEIEH, TP IRDTAR
TOLATZIRETRTOTA—ITHEASINET  FIEAZETIEMVE—rEAI UL
ZiLy (Do not count repeats)]IZERESh . COBEVE—MI/NEBSIEEL
BExFEEBA TYE—FEHD R (Count repeats)lIZERETHE, VE—IA RIS
NBRIITBEYET,

JE—FERBISE-IMHFESOLATINEDORTAEF LATINE T3>
DOUNEES (Bar Numbers) IOR—UIZHLGEMEN =4 T3> TIRETEE
9, TE—FEHDk (Count repeats)1ZIFRTHOYE—F (All repeats)IZE%
ETHE ERZINSBRIO/NHBESNHEATRIRIINET  F2EZIEL FLHD 8
INETAY 2 [EHRYIRSNAIHZED 2 INEIOIZIE, IHARETIEI2 (9)1&FR RSN
T [RBETHRE (Prefix)IETRKETHFRE (Suffix)IZEET HE, NEIESD
RUVAEEETEET (FEAETEBETERRL (Prefix) 1%l IICLT. TRKETF
Ak (Suffix)1ZHELIES . /RRIEM2,9112YET),

AOUNIVE—rERBLTEMSE DD, RRTH/IHESE 1 DFEFIZT 55
BIE. TEADOVE—rDH (First repeat only)JIZRELET , COATLavEE
AL E. EXIEEXLHD 8 INEIDTL—X%E 2 EEELI=HEDRD /M
DESIL. T9ITEELTI7HZBYET

EINAICRA TR REDNHESEZRRIEIEE . [REDIVE—FDH
(Last repeat only)JICERELET . cDA T avEFALIGE. 2EZIEIELSH
D 8 INHIDIL—X% 2 EERTHEEDRAD/NEDESIE, N1ITEALT9]
[Z7EYET,

INFBBDERT: TEa— (View)l » /NEIES (Bar Numbers)IDOA 7T 3o
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HESNPDEBESEHBRO—BLOERDO LT TG TARTOERD LIS
RIRTSDEIIGYFELL =,

B THEIINI/NET LAT O TLarDlIMNGES (Bar Numbers) JDOR
—VICTHBZF-VTHE SN OEBRORABEEIC/NHESEZERT
(Show bar number at start of system for bar split over break) | QA 73> h
FLGEBMEINEL . CNIFFEARETAUICH>TOWET . COX T3z
(29 %&. Dorico [FHEBERUIVEF-LTHEISNIZ/NE DO DAFFEMDOED /]
HBESZRRLGGYET . ChITEHERFORBMTEFNGIEENAHYET,

LAT A Toay: LAT7 AT arnlNNGES (Bar Numbers) | OR—
DEmEASN. 7T ar DT I —THEOBEGRESA LAY PTGEYELT, 2ER I,
FTARTDATLavh . EFKR (Show.. ) IZERATILSM—sh. . Z2IEERTF
(Hide..) 1ZEHAL T 3 DDA T aviERFMODRBRICEBESINLELT,

EHT

EHDA: BEATLaoDOEH (Beams) | DR—COIEBEAME (Vertical
Position) IO a3V (TR EIOFRDRIENELSEHDE 2 E*ﬁb)b—j’w
fiii (Position for secondary beam groups in beams with opposing outer
stems)IDNFA T avhAFLEBMENE LIz, CHIZKY ., TRTOE 2 EHIIIL
—J%%E 1 ENORBIOAITRRLT VRALOYT IL—TEhHhY03<T50H
YIZE 1 EHORANGENDANRETELLEZHBTTHIMN.F 2 EHZEE 1
EHORMNESRICEELT, EMOADRLEZHLTEINMDYICUXLDOTIL
— IO IKLLEBEEDRHDHLEHTTHN. WITAERBIRTEET,

FTEEENORS: FEF T3> DMEH Beams)IORXR—C DTM4 8
(Appearance) 1DtV avIC [RELEMDES (Partial beam length)ID#
TiavhEmlGEmEhEL,

m
=

=1

FTAI4BLVEBMDERDELHLES: TAI4PDERODEHES. BLL1Y
ARYILAURD T IAILEDERD ENTIZEMEN-EXRDEZEHEEESDRESIN
FEIN HABEPOEREFREDHAXATITEL REGHAXTRTRIND LS
[ZHYZFELT=,

TAT14Y
RSN LATOMNToarnl#R MR (Staves and Systems) JDR—D
[ZH ERINIMADTAI4ODEILIAVEBDRRICETHATIavh,
[RDMBERIZEIL 3 BERT (Show section names on first system)l&
TRUBDOMBRIZEISavEFRKRTR (Show section names on subsequent
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systems)I®D 2 DDA T avIcHBldnFEL Iz, AT av i pElashizCLIck
Y. TAaT4PDERDNEBRDOFRRUEIZHAIBEIX. T4 T42oD/\vE—C DK
MDEBEDHZT A T4 DEILIVRERTT D ETEIRTESLIITHYEL
=5

EROMRRHIZ: LATIME T a>DIBROAR—IDY (Staff spacing)1d
R=IIIF4 I DRI ERTSM/ME (Gap to use for divisi staves)|DZA
avhAFHLGEIEN, TRERDSHERET (Staff to staff) IORERESER FiiR
ERTOCIODTIHILE) TH0 . [HEERNMOESHR (Braced staff to
braced staff)JETOEMREZFERA (Dorico 2.1.10 LIEITDTIAILL) T 5MEE
RTEBESITHEYFELT=,

TAT4ORROBRRAE. ThDNMERTIEREICRNET, EARERIES
sE3® (Braced staff to braced staff) IAMEIRSNTLVSIGE . ESEREILICIX
FRRIA (L BERASNGELD LRk, T4 T4 VERETICULERRBZ SERSNEE
Ao TEERMSEERET (Staff to staff) INBIRSNTVBIFZEE ., T4 HERR
TICEFERERIA S BREINET,

ISR E

B EEES TS Dorico IERILT IV—TIZBT 5B SEERICHLEE
BIICEIILET  WIHIERE TIE., BT HRBESEIBHMICT IL—TEEIhFET,
— AT, BELGVEHESOEINDELGBESIHYFET, £, EEIFTTILZRD
TEAVRRGIAVMA—FTREFERENEGDH-H. BIIOF-HIZERBREES
V=TT B BIGEAHLAT IR TIIRIDOERARETIG->TLESISZELHY
EFT,CDEADRMELT, AT RTERE (Edit)] » T385BE S (Dynamics)l
» MERFBELZ &% (Align Dynamics)IAFTLGEMEN, T IL—TELGECTHIE
BOEFH CHBIT S HEICEITESLLSITHYELS:,
COIATURIEHEEE—RTLAMERATELGW O, FTIXEEE—FICOYBR . B
IS BHEBREEERLET ., CNICIE FHLGEMSh O RTHRE (Edit)]
» TEHITEIR (Select More)IZFEATHEEFTY (IR (Selections) DA
ESR). [BBILSEEI (Align DynamicsIERRT H& BIRLIIBERMNS
—BHN-BBERESICEHLETC. IR TORBEESNEEMENRIAONET,
BIILI=HEBITRTORBES TBIRRKBOFETHA-O. BEESY [Alt]
ERLENOETORMNF—ZFALT. IRXTRKICETOMNERSZITEZAE
ED

BEEBOEINEF) VN TCRDOMEBICRTIHE (X, BBREFRIRLTIES
(Edit)] » TARSS a3 %)Yk (Reset Position) & #IRLET

BHROERICHEBESEERT D BHOERICHT HEBELESDEME 1 [
DIFEFETILRZADLICLRYFELE BBRESERRSEIEREZERLTHMD
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[Shift]+[D] Z#L TRBESDORYTH—/N\—2FHE ANEHEET HEERL
= RTORERICHESFLESIMMERSNETS,

245V

Ry TH—IN—ZFFIEDHD: [Shift]+[F] DT HI T DRYTFH—i"—% &
El¥—. [Space]. 8L [Tab] #FEALTEICEDENEKSITHYFELIz, T1¥
HIVTEBMTELDILERTOEFOATH DO RyTA—N—%F(2H#
$H5HE. Dorico [FREDERICET BV LERFEIENETLEHMIERLE
T, BRAESMDEREEMFIZTHIVTEEBMTHI5A. THIEEFTD
BRFELEMEIC—EICTOAI T EEBMT HHE . [Shift]+[F] Z#9 AT
FHTEFEEANETZERI ILENHYET . EAEDKHF—(EL. REDFH
BT HRIFEIEROBEFFEIFHEITBELET  [Space] & REDFEIZE
FTEORDEFELIEMBICBELET (FzZL.T1, 2, 5IOKSITHhUTERR—X
TREU =740 AT HRBERICAATELLSIC. Ry TH—/I"—IZAALTLS
REDXFNHUT () THIAGEEIEBINELGYET), [Tab] (F. BREDOERICE
FTRRDIMETDORYIDEFEIXFE. [Shift]+[Tab] [(FREDFLRIZET S
DINFDRVDEFEIEFBFICHELET,

G549 DB=HL

1200dpi MEEFHL: 1200dpi DEBRED TIFF Ff=I& PNG BREVbIvTY
Zo49PEETHLTEHLIITHYELT -,

AV ARHILAU R

FLLWTZOH LT BREE—FTEHOFLLT IAIL DT UoHUTILHFIAT
EBESITHYFELz, SNIZEITYRIYNIDAT . Ry Th—2 X EVI 13V RR
— D RBEITMA ., SESFRYR LI avBNEENFET,
AVARYIAVDER: HEFRIL—V D EFTELEEBREREXHICHELE
Z55E  EERERHIOEEEERICHLBE X BMEIC. Dorico [FHF R
BITMATEMNGRBLRRT DL YELT,

LA47k

LATIES: —EBOHRATIE, SEHRMICTFU NI TE2FERALET . HED
EREFENT2=OIChA0T BESFIFERBESEFEAL. TOHRMICEET
BT (KYELDIFE) /A—HIE, HERTBESLHETEN—IEEDES
EFHEALET EZIE. 2 RAT7ICIEHAOTESDI235121%F AL, /3—kC
(&123512-011. 123512-02]. LELVSBKXDBEBEFERT HHETT,

CNEBBICEBTESLELSC, BLATIMIZEFNIZEEM TN TS, LT
IRDEAATIZEEDEESEE5ZAONDESITHYELE: (ZILRAT ., /I8—k, XV
HARABLRATZ(FTRTEMZF NI TENFET) LATINDLATINEEE
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RAE-EEETHICIE. BEE—FOILATIR (Layouts) /SR TH—RER
BT 5L, O TREMTRAET

LA7DFBEBRICLATONESZHR I HICIE. TFAMIL—LALT
{@layoutNumber@} Dr—9 ZFERALET , CNIERTOBEICLATIRESIC
BE|AONFET,

FrLAT7ILESIL. NRIE—R TS 74v0FETHTEE FIEMT7M41L
(File)] » TE®Z=HL (Export)] » 70— (Flows)IMoT7AILEESHTEEIC
Dorico BMERKT 277 ML B DEEICHLEMENET,

R=ULERDYARADERTR: HEE—RTLATIMIRILOLATIMI—FEE
FI 5L RERETHEELLEEDEMTR—ULERDOF A INRTEIN. AN
—TSHENT)EVRDR—SH AL XDONTIANTERTHERFER—C Tk
BADRRSNDEIIGYELS =,

&

MEADNATY: BFEFTavDOTR|EA (Lyrics) IOR—=SDTNAT Y
(Hyphens) 10 o2 av I TREAIDONATVIZERTHXF (Lyric hyphen
characten) DA 7 ar i #FHLGEMSN ., BEA DD NATUIFERSINDT 74
IWNDINATOXFa EEETEDLRIITRYELT,

X—h—

I—HA—DEA La—F: HFEF T3 DIIT—hH— (Markers)IOR—2(ZIT—5
—®D A4 La—F (Timecode in markers)IOA 7T avhFHLEBMEN, ¥—hH—
DEA LI—FDRT/IFERREFERTEDHEIITHYFEL=,

MIDI OEZHL

FE: BERAMLGAEEZTEORAES (/K 7 2OIv¥—TEITTVMILDED) M
MIDI Z7AILIZEEHINDLSITHEYFELT =,

HFREE: EFHINSTO—IZVE—INEENDIGEE. HFEENIE—IER
MLTELLETHINDLIITHYZFELT =,

MIDI D§fA+IAH

¥—7h—: Dorico [ MIDI 7ML —h—%HmAAL KIITEYELT-, MIDI
T7AILIZ SMPTE A7ty MEMNERESNTLVSIGE . Dorico [EThEERARAH.
JO0—DORBMEBEDZA LI—R RO aVDEREICFERALET , ¥—hH—IEX MIDI
EETHLFICEETHINA LSV ELS,

TURER: ROA7NEHDANO/—LI—ITHANNZ B EEHCTE=DH,

Dorico [ETURDINSHBEBRIIHARELTHREARAA, 10bpm LI EDEELSZTY

REBEOHAA/—LI—IELTRERTDLIICHYELT,
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TIHILER—TDERFE: Dorico (&, bSO D Z LN MIDI 774V EHFKMAAD TR
[SIE. REBTIAINIR=D LRI A ADEREEAHDEIICHYFEL,

RAZFRBDORI: MIDI 774IILD&HEHFAHE-IE MIDI FEDRIZ. RE2RED
FELWREZERTAHTZILDVALNERE SN, iHAABROANRICFEITE
ELRBTENKIBIZHYEL=,

REJLER: MIDI 7ML DERAAFHEIXITILEA L MIDI FREFDORRIZ. MIDI
AVRA—5— 64 DT —REHAMBEIZEY . Y RTFAURTILIREFHHAD &
SITYFELT=,

TL—¥—2)L—7T: MIDI 274 I)LEFHRMAHAATELE SR AOA —7 AL —23
DD-HDV—RETDHEE . RAHRAAERMDT oYU TILDTL—Y—EFRAA
EFNd MIDI Z7/ILDOBERESN=TL—NY—%RFTESELKRITIDHENHY
F9, IMIDI 274 DEAAH (Import MIDI File)JIOFA7ATIZHLGEMS
NIETFHBIL—V—ITFL——5 IL—F %4 (Create player group for new
players)1&#4 129 5& MIDI 774DV RIZERSNE=-TRTOTL—F
—NRBEDTIIL—TITEBIMENET, ZOV IL—TIEBEIZELTHENSHIFRT
=FET,

IN—KL ATk EHRIZ. MIDI J7M L EZEAATREITEMSNEZWNVThDOTL—
Y—[SHEN—FLATIORPNERESNEBEVNESINKNGELHYVET . CDIHE.
TMIDI 27AILDFEHAAH (Import MIDI File)IDFE A7 OS2 LGEMS T
THB|IL—V—IC/A— LA 7O LEER (Create part layouts for new
players)IDA TS av& 4 JICLET,

S4Y—

READHAZFERTICTS: TREND VST AVRRYILAVMEIESETFGH
NOBREFLFETN. TV AVDBBRRETIE, S Y—ICRRSNHHID—
BNARFEADEELLY ., CNICE>TEXH—DRBELULITIRONISKEDZED
HYFET, EIOEXE (Endpoint Setup)IDF A F7RJICHLGEMSNFISFH
—IZR/RT B2 —T1AHAHDE (Number of audio outputs to show in Mixer)]
DFTLarTlE SR Y —ICRTINDE N OHEFHIRTEES,

R®RFHF

EARFZzRE: RNFZRED/NHRTHET 2T/ FHLEMSNELS =,
hiE 1 DDEDELTRRSNSGRAKFE 2 DULDARFICHETILELSD
BGBITERTEE T ChITEY ., R FRBDTIL—XEREHAMYAOTLL:
Y. UN—H)Lotyiarixai—2EETAHLLIICLEYTEET,

FETFTRUFZDETHHLED/PMEREERL T, [$E (Engrave)] »
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FRKBZESE (Split Multi-bar Rest)I1ZZIRLET . [958 (SPLIT)IEVSTH
AREEHDHARNRFTEIN, TRTDAVRARYILAVRDN—FTEFDINEREE
CRARBENDEIEINE T, R EIFIMYETICIX. HAREZERLTHIBRLET,

E e

THXRANIAUNELEETS: [%E (Engrave)] » TE&E I+ b+ (Music Fonts)]

DFATATIIIBEIA N EERTHEZETF AN IA UM EEH (Update text
fonts when changing music fonts)1DZ 7L avAFHLGEMEN, FE I+
FERLEEICTIRNIA VMG E TEEET HAMEETESLIITHYFELI,

COATLaVFMBBETEAVICHS>TVET . ChITkY . BEET+UME

[PetalumallZtIY &R 5E. TI4HILEDTHFARA T+ MEIPetaluma Scriptl |
ESN. [BravuralIZBIVEZ 5&. T4 LD TFRAMAET 4+ MMET Academico
[SERESNFT,

MusicXML DEEHAH

TIHIRR—DDERTE: TARAL MusicXML F7AILIZRF AV RDR—DH A
RXEZAMEESNTLSIBES. Dorico [FTDIEIZHEL. IFEMBNILER YA X
HFRARAL KSZHEYFEL = MusicXML F7AILIZR—=DH A R EERY 1 XD
ESNTLEWMES. Dorico (X7 H U TILDAV ARG AVIRIZEDINTT D
AINDEYUER—DH A RERER YA RERELET,

EHOAR

RyTZd—iN—: BBEE—KFT [Return] 2T Hh 1 DDTATLEZTILI)YY
5L BULRYTAH—IN—N, ZOTATLORELN T TITRBASHZIKETH
CESITHYEL Iz, SRIZIBN—2ar TIEFFALI—FREEICHEH o T SHEET
Lz, Ry TH—N\—%FERT I3 T DT AT LT RTIZHRERSNELz, CDA
ATDTATLIZITTUR, BHBRE. TMELS. A3 THR. A5, aFiEs. &
ERE.EREBESERLEES . REUVEVXIVIT4—Ib, Fa— TILRIFE
BTV UR EME. ZLTHNILAHYET,

NIEDFEY., ChETILEIRLT [Return] 29 EICE-T, FDMEICF YL
YRDRRRENFZTATLDZLTIE, HhDOYITRYTAE—N—MRREINE LI
212EWVSTETY , FrLybaRREEDITIE. BFF. T KRR BRI IL/DE
BEERLTHS [Return] I H, [Shift]+[N] ZHITBELHYET,

2 DDEROABTEANEZD: v RTRE (Edit)] » TEFKRREY &
(Paste Special)l » TANEZ (Swap)IhFHLGEMSN., RAD T OALU by
IWAVEDEBDANBEZZESICHBICHKEILIITHRYEL, BAMICIE. TT
HYZ7BA—F (Explode)lIC&>TERK SNz RAS VT ICEBEZMAFLNMES.

BEnfz\vtE—20FME 2 DOERODBEFETERLTIALER (Swap)lz
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BIRT e, BHARALV T EREGRAEET,
Fal—avEiil BEOESHERGISTIL—a DREIEREEITHE
BIRTERESITHYEL . ChIZIEA—Say TIE S E (R HEA AT 28
ETLOBRETELENBD T, Tal—oaE Il TA hEN =S E A
HEBRTBE. Y— LRI ZROR G T BRIV AT HE512HYE L, Ta
L—2as QBRHERBRT BT, Y—ILRY I RDRILERT A, F—HR—Fa
—khk [O] EERALET, #IC, BHEBRLT, X ESHOREOHEE
WL EE RS EETES LTl —oa el T s T, BEOSHE-
[FRB DT 1L —ar BT BIZlE. ThEBRLTY—ILRYIRORAVES
Yy g B [O] EHLET, FTal—ar ORENEEIN-BENEHE 2
S A4/ TEEET BI5E . Dorico (44 DOENYDBEDEDT1L—a
DHEMIFLESELET,

O OINT-RS—LRBILE: REZEDEFDOAANLEE (Note Input and
Editing) IOR—C DIREE (Editing) 1D aV (ZTREYAHTREIATBEES XS
—ZZBEDT AT LIZ) U EES (Link dynamics and slurs to existing items
when pasting) DA T avNFHLGEMENELz, SITMEARE TAH U ICHS
TWET . BBLEBEDVIL—TFRFRT—ZELGLIERDIVALEDRELCEEIC
FECTalb—2arTlYMRITTH, TNODRBESORT—ITUUIEER LGN
[ESMFELLMEE L. COAToavaATITLET,

BOZOMD/NEFUNDTAL—aVEHAT S [Shift]+[B] DRyTA—/\—
ZEALT, MHEMORSFEITIIE BFEORSORAR—REBATESLSIC
HYELTz AT EIRSIE. TTEAEAICHT2EREHFTTHEEL. RICHEEZD
D%, TaL—1avITHIETBHF (FEAI1E 4 DEFIZIEN6]. 8 HERFICIE
[5].2 RERICFN714E) FREAXF (&2 4 FBFICEMqL. 8 #EF
[SIETel. 2 DEMIZIZTh], 16 DEFIZIEMxIEE) #ERALTHEELET . 158
[Er.1 (EVAFR) 2ERALTANTEET BHEELOVTNICHLHFEERTS
BEIE. 2 DDEERAR—RFLIINATUTRYZVBENHYTTH. EICXFEE
FRTLEAIERUDIDBEIEHYFERA HIELTIE. T491. TIwl, T4-61. T2 71(%
TRT 4 HDERF 4 DOPDORSE/ALET,

ZDOHDhYIZ, [Shift]+[M] DRy TAH—/N—THFILEEZRHLIDIZFERAINDE
DERBDOXFEINEANTEES AL T441EANTBE 4 DEF 4 20
DERIDEAINET,

HAFEEDEEDRI/NEZIEAT S: Dorico DIEN—23> TlE, AFERE%E
RLTHS [Shift]+[B] DRy TA—/N—%FEURHELT/MEZBINT HE, A E
MENZDEEICHFREOHETLz, CNIT/DEIDORBEEICHLIEFFEIE
AKPFEBIRLTNEHZBATHEELRBDEETT , Dorico 2.2 TIE.1 DRID
HBFEE. FEZORATENTHAIAFESTEZEALTMIZIBEATES LS
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[ZHYFELE, AFREBZDILDEERLT [Shift]+[B] 28I &, HFIEEFEN
FVERIDTRTORNEE—HEITHICHBEILET,

F—R—Ka—rhvk: THRE (Edi)1AZa—hm5, SEIFEFHATURITHLF—
R—F a—bhyb BV ETOENBLIICHYELIz, SNIZET—FRADRI Iy
[CKBERDITAIE) T FRICKDERDITIILEZ) T BIRLE-EFOFEED
DEBLENEFENFET,

DALT)yE: VALT)YFDBREEEZZRESELHRFDa—rvNMIMA T,
DAXLT)IREREDERDTAL—avIZRET 5HODF—HR—Ka—kh
YhEEY B TONDLIITHRYEL=,

BRORSEZEETD BERNORIEHFEDTAL—aV TERTHITURAH
LGBMEN, CRIZFF—R—F a—thyvhdBY LB THIENTEE T, ThiFFHE
FORSERAEDIVALT)YRTERT ABRFDOITUREMHTELET . Chona
YURIE REREDIF—R—F3—rhyk (Key Commands)]DR—T T,
[FalL—2avZE#E (Shorten duration by) B LU Falb—YavEERER
(Lengthen duration by) | CRETEET,

BV ITRICBIFOESEER: E—OFHMNSHEIBREEZMYMFITEHEE,
Dorico [FEICHRDEEREIER T HD TIEEL, BRYMITED AU XY LAV
BED. BEZKELBLOHFENDAAAIE—TERLERE. FOFEFEATHL
SITiEYEL=,

FF

AZVUDM AR MIATEIEHOLI=VUICE A ADNRICET AT ay
DEBISHBINELZ, BEA T aVDIEH (Notes) IOR—TC DI+ &R
(Rhythm Dots)1D oL avIc#HLGEMEINZIFMILTHIFEEBTOI=YVIZEIT
Aft/A (Rhythm dots on unisons in opposing voices)IDFA 73> Tl B4
CEICERDMREEICRTT S BICRRLAGWLD, A=V DOFFINERBRLIC
HEIEEDHERTTD (COBEERNRAITIEFOLTOMICHKRICERESNET)
DVWFThIMERETEET,

BE

JYn—)LOBE: a0 1 DUEoTa—A 1 NEBE® 1 HE KYHE
DEMBEFIDIFELEE . BEA T avDIE43045 (Timing)IODR—CTH
THERIDTYO—IILEIEEL T, Dorico A 1 /B ®D 1 #HBLYDLETAS
BEZRBTHESICTEET, [7A—DRIOF)A—)L (Pre-roll before flow)]
FEUGMEICRELET EMEFMF 1 DITHLTIX.0.25 HEEEDETHLTHT
ED

TILFR—k VST 7545 14>: HALion 6 ¥ Vienna Ensemble Pro #&—&iMD
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VST AVARHILAVRE 16 D MIDI FroRILNDIEDN I EERIEZETTH,
Dorico [EZDEBMNUIERETEDLIIHRYEL I, bV IAYT—IZFOYTH
DUoAZa—MNEBMEIN, TZTAUDLRBINDIR—IEBIRTEET 1 2HD
NOYIFR—TAIZFERL. 2 DOIFHR—KFBI. 3 DBHIFR—FCI. ELVSEE
[ZRYFET, [RIFDERTE (Endpoint Setup)IPF A F7OT LIRS, 2 /A28
LBEDEFYoRILIC VST THVRTLyavIvIB&UN—hyiareyTzx
IBETEDSSITHYFELT,

Rl

SVG J574v%: Dorico &, BIERR. 7 774v7EZTHLEIUVHRIEFIZ SVG
T349I DIREIZARETEIARERD . TV T4 HEEGSZFERALTE
BLOZ )T EATIES&KSITHYELT, ThITKYT7AIL YA XDME/INL . PDF
EFHLBLVHRIFFOELIARLLTVET,

MFERL: T A—DHEARIZE-TIX. MFOMEENRIZFEHTITLRSLEE
(REZHRBIL-HLAMERBRLTE@EARIOOICT) O 2—IHELEE T L
) REIOR—C OERIIEAEZE->TWSIGELAHYET, FIRIE—FDHEID /S
FIVCHFHLGRESN-THRAIR—DOMRIIEZDIZT S (Reverse order of
outward pages )IDFA T av(Fx. R—I0 1 4 (RE) OHDIEFFHICLE
T, NE—BBDT) U A—ICHEBEGIRETHY . BEERIDT-OITHEELES T HI
[CFEETCR—CFFBICEARLEETHENGRYET,

FHREEEIR: $XTOOIT2AT T MFEHRIZMATFHEEENRIZIEE T
SRR YFEL =,

R—UgEE DRI FRIOR—CEHEEERICIEE TEALIITHYEL -, [B/N—
a3 TR (From)1&M&T (To)IORE A kO—ILTHL=EDIET Tk
OVrO—JLICEEHAON . BBOR—CHBEZBERICAANTESLIITHSTLY
FT. TNTNOR—CHETHOITRYON, EfiTHIR—CHEDIEECIE
NV EFERLET, 12EAET1,3,5-71EANTHE. EIRISNER—I1E 1, 3.5,
6.7 IZHRYET, EREDHEL Y R—tIh, BRSNIGEEIER—FFNEIZE
RILETS,

YZX2Y9T4—)L

AHEIZRBEIESNHDAD4UT: 4 DEFHLDEISNT 8 49-16 7-16 4
15154 . Dorico [ZCDE—FERI4V T TEEL, (FLHD 8 HEFERL &
AMD 16 DBERH 2 DFEBFOENIALIZINFERLSICELLTEETT HKL5124HY
FL71-,

ER
IHITER: O URTEE (Edit)] » TEHITEIR (Select More) 1A #FFLGEMSE
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NFELIz, TIAHILEDF—HR—FI3—brhykE [Ctri]+[Shift]+[A] (Windows) F
fzI& [Shift]+[Command]+[A] (Mac) TY ., CDARUVFEETTHE. BREDE
RAZRDSEDAANUNIATERIRFRET HRED, FEDRAM)—LIZER R
KERDIODHMETEVNET , —EITHSIA RV M TOE LD ERIZFHIR A
W= BIREEIXERDOERICENDEELHY . FERICHBETIHITY
IOMDAGELT RGBT 54TV RELET,

E5IZ®IR (Select More)llE, #EYIRLEITTHETEIRGEER L ELITON
FT.FT . REQ/NMEFDEHRDERICENYET, RIZ.R—CE2—ThHHH5A
FREDHEDEHFDERICENYET (FrlL—Ea—ICTMHEN 1 DLHE
W=BI EBYET), REIZ. 70— EKIZENYET,

BREFDILKIIEICKFEABMERYET . RIDBRARICEFENTULRNRL
=L DT7ATLITERESNEREA. EXE 1 DOBRTHENLALAZDFEH
[CRIAEFERRLTUSHISRRIZRTLEGE. ALEROHFENTEED
FEBIEERSN T FMOEROFEN LAZOFHLERSNFE A,

HEDSHEATIEITATLESSICERLEISELTHREIRFEOERWVEES (fz&X
X 414 DIMNEGFTTEBFFERIRLTISSITER (Select More) 1ZE1T9 5&. &R
LB/ T CIT/NMEIZEF-LTLEO TS, IMNINTIN U LD EFEZER
TEFEHEA)., Dorico [TBIRFEOEZHECHETEHEFNICERZ R (ER. X,
J0—DIE) ISEDHFET (F=FZL BRTEDIHELUDTATLNINUEFELGEN
HEFEEAAILKTEEEA).

TAT LD HZ/NEFE-IFHEENSIBFYRD/PDEFE-IFHETROLES.
(& Dorico A ZD/NEIEIFHMBEDHRRAETHBAZIEALI-LEEITRINShFET
(FzEZF HBERYYEZFECATEV (. RUOHBOEBRESEERLTLV
[FERENDLSIZHYET),

FESIZER (Select More) Il REEE—FEREE—FDELLTLHEATEET,
SO, 1ERET N—T LS -BBREEERL T LETICHBEREETEIG
B REE—RICUYEZ TEFEE—FITRET LS EBEZESTREBUTHRAET,
1 DOTATLOFHERUKETIEISITERIZETLEEES N A3 B
DHIDEHET —AEUTIZETET,

» WE: MEAEERTIHE. TDIAVB S WME. BLUSIU2MTHREFEIN.
FE5ISER (Select More) 2 R1TTHEGEIRSN TV =TFALSAIUES. fiL
BEBLUTIVAMTH—BT 2MADHIEIRSNET,

" RS WBRELERLTIEHISEIR (Select More) 1ZETLIIGA.
Dorico [FZDFEXRDRILYT IL—TIZET HiDEBRETE—EITT X TEIRL
FT (R—CEa—TEH. ZhoARILHEEIZHIBEEDH), [EHITER
(Select More)1&x&LIZETY dE. AREBEICHAHMD T IL—TIZET HithD
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RIS TERLES,

n EERGE 1 DOERBEGEEEIRLI-GE . TE5I2RR (Select More) 1%
TTHLEICHTI—DBEEEEDHBINSNET , SOITHBHGET—RELT,
EFBETIFBEOVTIADERREERIRLIZBE. [SHITEIR (Select
More) 1% R1TF 2EMREERRNTRTOLITBELIETIFBDEREEMN R
RENFTH, thOFEDOBERBCETBIRSNEL A,

BRUZZATLORTRTIFERREYYEZS: ORI FPATLERT/IERT
(Hide/Show Item)IMFHLGEMENE LTz, SOATURIEAZA—IZIERRINF
HAD. REEREDOIF—FR—Fa—rhvk (Key Commands)|DR—I TH—
R—F2a—thvbEEVETHIENTEET, COIATURIE, FERRIZT B0
DOEAOTONT4%EHD. I—FES. ERBE. BHFELESD 3 20T DT7A
TLIZKHLEELE T, AU EAEITEN DL, Dorico [FERMRESHTLT, E
RRICSTEDTATLEHRILET  BIRLF7 AT LITERRERTEA DIKED
HEEE . HEIDETTIETRTDTATLMNIERTRIZEY . ROEFTTIETART
DTFATLOBBRREINET,

HBFEBTEERTICTIEEIL. TNARIRINDITATOLAT7 IR TIERRIC
HBHIEITERLTZEWN, HICO—FERBLERREE, AT FEETLEZLAT
DEDHITEWNTIERTRICEYET,

25—

WETEIDART—: WEEDRAT—DALA—IH CINETIERT—DAEIZEHL
FTRICEETHOLDON, AZ—DAEICHLEAICRRIEINSLIITHYELT,

FTFATINEDWT B BEFTLI>DIRAS— (Slurs)IDR— DT EZR0M [E §
(Avoiding Collisions)1Dtoa Il RS—OMBRTFaSILOEITEVIES
(When slur curvature passes close to the stem of a natural) JOA T3>
FLGEMEN, R5—DFFaJILESDRDEENT HEHLEFHRT . £
(FHEMZEZEIETENRBIRTEDLSICHRYELS =,

HET7ATL

TV TICR T BALE: Dorico 2.0 THYL TRERERNEASNTLUE, TR, Un
— IR EDHETATLITEICALODERDIC L, DEYASVERD
FOA Y THERICHLTIETICLARETEEFEATLIZ LAT IR T ar®
M= 40 (Staves and Systems)DR—IIZIFERD EDA YO TIZxd 54
BAIPzUPDAIE (Position of system objects relative to ossia above
staff) JOFA T av LB mEn=C&lzkY . REICHCTHRET A TLELY
DTVRERDEICRETESRIICHYELT,
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TUR

FURDZE: [Shift]+[T] DRYTA—/N—, Tr=IFTRRE—RDT LR/ SR
HiLGEMEhE=ITFUORDE X (Tempo Equation)1DtoS 3% FEALT, »« =
) OBRICEBI VT NETUROEXIER TESLSITHYELE, SXOTEA
[CERASNIEMEIRET HITIE. U TOXFEFEALET,

= 25w

= 2 2ERh

= 4 HEFq
= 8 nEFFe

" 16 HEF: s

EX OB OFMICIIN.] (EVAF) ZEALTRKR 2 DOMFRLEMTEFET,

TURDEXLRE /NN OMREF OO, TURDERZ/NETDBAIA R
BIS/ERLT=1B4. Dorico [FEBMICChENENRND/INERO EIChRFIZ
LET HFREENEEZEDLTTURDEGRNEEREIND. BLUEENFKET
HINEIRDREE DR HOYIZEDEVSENLGRRICENTIE. EXDOKERLEZ S
EXT—FCHRELLETNIELESBVEELHYET,
TURDERFBAEIZRBEINET,

By TTCTURERET S LHEE—FODTURNSRRIVIZTZYTTFUORASD (Tap
Tempo)IDEVavhAFHLGEMSN, RELTAYT (Tap)IRFVEHE V) vY
THCECHBTUREREERTEDRSICHYELIZ, TNEVIVITEHE Iy
I DBERERMNSEHESN-TURNTOREVRYIRICRREINET , TURIC
FERTEEMEEIRLTCIERR (Create)1&x0) v o 5L EIRLEBIZTURY—Y
MMEREN DD, YORKRAUA—IZTURMNE—RFEN, 7B8—D V) v LI=EIC
TURERETEET,

TXA+

BEDINSTSITRAANEFERLTCTXFRAMERT 5 sERFITHERICHLT
FREDAAZ BEEDINSTSTREAIILTHIET 5F—HR—FLa—thvbEEY
BToNDEICHRYFELEZ. BEZREDIF—FR—Fa—rhvb (Key
Commands)|DR—I T, [FFXMEVERK (Create Text)IF=(EMHBTFXME
{ERE (Create System Text)IOATI—MoERTE/NFTITRIAIIVEFLE
ED

E5(2, TREl (Write)JA=a—ITHLGBMENITHXMEMERL (Create Text)l
LTHEET X AMEYERL (Create System Text) /DY TA=—a—(lE. WENTOD
IVRTCHEASNDZTRTDINSTSTREAINYRRR RSN, YORATRIRT S
CETHEDRIANEFALTTF RN T AT LERRTESESITHYELS,
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INSTZTREAANDE 470 THE (Engrave)] » TIRSTSTX24M)L
(Paragraph Styles) IZFF UM 3 BRICEERF - (THBRITHAKTFRANT 4T LAEIR
ENTWBIBE . TXFRANTATLDRIDINGT FTDINGT FTTREAILHERE
NTRETEIRETHAT7ATPHAZTET . TFRNTATLNBRSN TV
HBETH MDOYICRRICIRELIZNSTITREMILAERSN-KETH 47O
THRKIz . BFED/INST S TR VIR B RABERYRTIELREIZEFRT
ED

T+ bRAA)L: T%F (Engrave)] » [Tx2UbRAA)L (Font Styles)IDF AT
AJICEVNT. REDHEE Y avICHIBIOBIRMSMRIFINSLSITHYELZ, C
NIERL IR ZLIVIZHEIDREEZEMZADILENHLHHZELEIZERNTYT,

B¥iEs
BFESZHIRT 5. HFRBZHIRLGEE. TOHEDRFIRETDIALLED
HERBHLEEA, ED=O. BIRLEHFRESDHOMENLRDIHFERE
DEBFETDIVALEDAR—ZMN, ZOHIZHHEHERFESO/NEFORED
BHICESHLLGWGEES . ROB\FEEDHIE /NN ELHEENHYES .
nzEEET BHICIE, HFESZHIRT HETICEAE—F (F—HR—F>a—thub
[1) ZZ72ISLFES . BFESOEAIZETHHBOEIELL T, Dorico [FZAI/M
HOREZRBRETLH-OIC. BEIZKLTROBFEEZRHSIEET,

DFENBOMER: —HOMEREAILIZENTIX, HFREDHFELBORIC

DIDLBERENELDIEELNHYET . FEAF T aoDMBFEE (Time

Signatures) IOR—L DIEERR (Gaps) DI avIz BEHAXADPFEE.

REGHFES. ERONUDAFESENTND R FEIPBOREREE A<

ETESFTavhRBESINEL .

M~
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@ steinberg

ID # Component Issue
STEAM-8802 Accidentals A problem Wherepy setting a microtonal acudgntal with a very large pitch delta can
cause the note to jump up an octave has been fixed.
L Arpeggio signs are spaced correctly relative to notes on cross-staff chords where extra
STEAM-8722 Arpeggio signs staves have been added below the top staff of a piano.
STEAM-8445 Bar numbers Changing the size of the chosen paragraph style f_or bar_ numbers now correctly
updates all bar numbers throughout the current layout immediately.
STEAM-8505 Bar numbers If bar numbers are shown every bar, when a p'Iayer.changes instruments with dnfferent
numbers of staves, bar numbers no longer collide with the staff at the change point.
STEAM-8651 Bar numbers  Bar numbers no longer sometimes disappear when making an edit to another staff.
STEAM-8603 Bar repeats Using Alt+up/down to nudge the bar count for bar repeat regions in Engrave mode now
works correctly.
STEAM-8642 Bar repeats Nudging or dragging bar counts for bar repeat regions in Engrave mode now works
correctly.
Key signatures at ends of systems no longer collide with the double barline shown for a
STEAM-8456 Barlines start repeat at the start of the new system if single barlines normally shown for key
changes.
STEAM-8510 Barlines Start repeat barlines no longer collide with large time signatures shown in the staff.
STEAM-8527 Barlines Wh(_en a sys_tem begins with a grace note,' D(_)rlco would sometimes incorrectly use the
barline sections from the previous system; this has now been resolved.
STEAM-8520 Beams Un_der some circumstances, crossing beamed notes between staves cqul_d cause items
to incorrectly avoid the beam once it was no longer between staves; this is now fixed.
) Beams crossing barlines no longer incorrectly attempt to avoid time signatures if they
STEAM-8595 Beams are drawn above the staff rather than within the staff.
Brackets and The position of wings on brackets now correctly takes the value of Additional vertical
STEAM-8403 : :
braces protrusion beyond top or bottom of staff into account.
STEAM-8399 Chord symbols Hidden chord symbols no longer cause multi-bar rests_t_o be split if they are shown
above the top staff of the system rather than above specific players.
STEAM-8644 Chord symbols Setting or unsetting a prope.rty ona chord symbol with the chord symbol popover open
could cause Dorico to crash; this is now resolved.
STEAM-8406 Clefs Moving a clef before a dashed barline in an aggregate time signature now works
correctly.
STEAM-8426 Cues When showing the dIVIS_I §e_ct|on_name or number in a cue label, the player number is
now shown before the divisi section name or number, rather than after.
STEAM-8431 Cues Rests in rhythmic cues are no longer forced an unnecessarily long distance away from
the staff.
STEAM-8607 Cues Under rare circumstances, changing the clef of an instrument that is cued in another

instrument did not update the clef in the cue; this problem is now resolved.
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ID # Component Issue

STEAM-8264 Divisi Restorative clefs no longer incorrectly appear on the wrong divisi staff.

STEAM-8444 Divisi If verse numbers are shown for lyrics in a passage of divisi music, the lyric verse
numbers now appear only on the correct divisi staves.

STEAM-8743 Divisi Cue labels and clefs no longer incorrectly appear in divisi staves.

STEAM-8714 Dynamics Creating multiple Qynamlcs with a run of grace notes selected now handles groups of
up to three dynamics correctly.

STEAM-8696 Engrave mode When edltlng‘ the text in a frame on a master page or flow heading, the text editor no
longer sometimes appears in the wrong place.

STEAM-7603 Fingering L_Jnder some circumstances, setting and unsetting flngerlng on one note could cause
fingering on another note to move up or down unexpectedly; this is now resolved.

STEAM-8420 Flows When exporting .ﬂows, Dorico now ensures that each exported flow is attached to at
least one layout in the resulting project file.

STEAM-8408 Graphics files It is now pos_5|blg to set the anchor position for a graphic in a fr.ame tq a negative value,
S0 it is possible (in a roundabout way) to show any part of the image in the frame.

Graphics Importing a graphic file from a path including accented or other special characters now
STEAM-8792 . ;
import works correctly (Windows only).

STEAM-8479 Key signatures Creating a key signature that references a custom tonality system now always works
correctly.
When selecting items in a flow using multiple tonality systems, the panel now

STEAM-8529 Key signatures' immediately updates to show the correct tonality system and custom key signatures
and accidentals.

STEAM-8585 Key signatdres In some projects, creating a key signature in the 24-EDO tonality system would cause a
crash; this is now resolved.

STEAM-8634 Logaieoien The key (_:ommand for startl_ng tuplet |n_pu.t wz;s_mcorrectly disabled outside note input in
non-English-language versions of Dorico; this is now resolved.

STEAM-8609 Lyrics When typing lyrics very quickly, it was possble for the_ last character of one lyric or the
first character of the next to be dropped; this problem is now resolved.

STEAM-7408 MIDI import If a note cannot be quantlzt_ad into a tuplet correctly, it no longer causes subsequent
notes in that voice not to be imported.

STEAM-8186 MIDI import Step-wise MIDI con_troller data (e.g. controller 64 for sustain pedal) now imports
correctly from MIDI files.

STEAM-8428 MIDI import Qua_ntlzatlon for notes in tuplets now removes overlaps in the same manner as notes
outside tuplets.

STEAM-8518 MIDI import Under some circumstances, the option for vyhe(e the split pomt between the staves of a
grand staff instrument should occur was being ignored; this has now been resolved.

STEAM-8665 MIDI import MIDI controller data is now correctly imported when importing a MIDI file into an

existing project.
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ID # Component Issue
STEAM-8551 Multi-bar rests  Mid-bar changes of key signature now correctly cause multi-bar rests to be spilit.
: The size of chord symbol accidentals and the vertical position of notes for metronome
Music fonts ) ) ;
marks and tempo equations in Petaluma have been improved,
MusicXML Lyric extender lines on the first line of lyrics in MusicXML files exported from Finale no
STEAM-8576 .
import longer end one note too early.
MusicXML When importing transposing instruments from MusicXML files, Dorico is now much
STEAM-8681 X . o
import more likely to choose the correct transposition.
STEAM-7949 Note input Pasting lyrics fronj.notels W!th!n a tuplet |ntp another §|.mllar tuplet now pastes the lyrics
to the correct positions in similar tuplets without requiring chord mode to be enabled.
STEAM-8336 Note input Chan_glng the duration _of_a tied note split by Force Duration no longer causes the
duration to be changed in irregular, non-notatable ways.
STEAM-8421 Note input When copying and pasting notes spanning tuplet boundaries, Force Duration splits are
no longer lost.

) . Typing R when note input is active now correctly repeats the note or chord immediately
STEAM-8434 Note input to the left of the caret, instead of the note at the caret position.

STEAM-8461 Note input It is now possible to use R to repeat an implicit rest to the left of the caret.

STEAM-8468 Note input It is now possible to delete tuplets with a 1:1 ratio that have lyrics on the notes within
the tuplet.

STEAM-8477 Note input Rests, like notes, are now selected after they have been created during note input.

STEAM-8582 Note input Selgctln_g mul_tlple notes of the same pitch on instruments held by dlfferent players and
adding ties with T now works correctly, even for notes of the same pitch.
) : Pasting music from a multi-staff instrument where some notes have been crossed to
STEAM-8621 POt L another staff to a single-staff instrument now resets back to the original staff.
STEAM-8750 Note input When the caret is positioned between grid positions, moving it left no longer incorrectly
moves the caret to the start of the bar.

STEAM-8808 Note input Moving the caret up or down _betwee_n_ staves belonging to different instruments held by
the same player could sometimes fail; this has now been resolved.

STEAM-8860 Note input Cop_ylng and pasting a local time or key signature to another staff at the same rhythmic
position no longer incorrectly links them together.

STEAM-8861 Note input Using Force Duration to set the duration of implicit rests on multiple staves now works
correctly.

STEAM-8425 Noteheads thkmg Revert to Factory in the notehead set editor for a notehead set no longer
incorrectly also reverts changes made to the notehead types referenced by the set.
Under some circumstances, dotted chords in opposing voices would be positioned

STEAM-6650 Notes further apart than necessary when accidentals are present; this has now been

resolved.
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ID # Component Issue

STEAM-8469 Octave lines  The illustrations and labels for octave line continuation options on the Octave Lines
page of Engraving Options have been clarified.

STEAM-8454 Page layout Closely-posmoned text events in galley view no longer sometimes cause items like
dynamics to move further away from the staff.

STEAM-8462 Page layout Adding a key signhature in a fI(_)w containing explicit system breaks now correctly causes
all systems to be cast off again.

STEAM-8504 Page layout Under some circumstances, moving unrelateq |t¢ms (e.g. arpeggio signs) could cause
dynamics to move further away from the staff; this has now been resolved.
_ Under some circumstances involving instrument changes, allowing empty staves to be
SEA RIS Page layout hidden could cause all staves in a system to be hidden; this has now been resolved.
STEAM-8539 Page layout Changing the staff size at a system break at the start of the flow now correctly causes
all systems to be cast off again.

STEAM-8683 Page layout Staves. containing bar repeat or slash regions, or.comple.t.ely empty staves with bar
rests hidden, are now adjusted correctly during vertical justification.

STEAM-8686 Page layout _It iS no longer incorrectly possible to remove all of the staves belonging to an
instrument.
When two projects are open with multiple windows open for each, opening the master

STEAM-8749 Page layout page editor in Engrave mode no longer sometimes opens it in the wrong project
window.

STEAM-8571 T, Slash mstruments in percussion kits now correctly use slash noteheads after importing
them from a library file.

STEAM-8777 Percussion The plgyback playing technique for_ th_e choser! perCL_lssion playing te_chnique is no
longer incorrectly removed from the list in the Edit Playing Technique dialog.

STEAM-8560 Performande The speed of editing in galley view for large projects with many cues has been
improved.

STEAM-8851 Performance  The performance of Duplicate Flow has been improved.

STEAM-8872 Perrmance The p_erformance of inputting music in a part that is used as a cue earlier in the flow has
been improved.

STEAM-8873 Performance The perform_a_nqe of inputting music in scores with divisi where a fermata is used
following a divisi change has been improved.

STEAM-8457 Piano pedaling P'edal _Ilnes no longer t_)ecome misaligned after an ossia or extra staff is added to the
piano instrument to which they are attached.

STEAM-8435 Play mode The e button that shows whether a VST plug-in window is open is now correctly
updated when changing playback template.

STEAM-8629 Play mode A tempq marklngs now correctly ignore any tempo changes added in the Timing
automation lane in Play mode.

STEAM-8633 Play mode Tempo changes that reset to an earlier tempo now appear correctly in the Timing

automation lane in Play mode.
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ID # Component Issue
STEAM-8701 Play mode A prqblem whereby changmg .the audio device in Edit » Device Setup could
intermittently cause no audio device to be mapped has been resolved (Mac only).
STEAM-8724 Play mode Changing the VST |nstrument, MIQI device or MIDI channel of an mstrument in Play
mode no longer causes the view to jump back to the top of the track list.
STEAM-8850 Playback A hairpin on a grace note will no longer result in the following note becoming silent.
Playing Creating a new glyph-based playing technique with differing above/below appearances
STEAM-8494 . 2 .
techniques based on an existing one now correctly makes the below appearances independent.
STEAM-8599 Print mode Instead of printing in solid black, when printing or exporting graphics in monochrome,
watermarks are now excluded.
STEAM-8458 Project files Opening project files that contain a lot of MIDI controller and other automation data is
now considerably faster.
STEAM-8396 Properties Edit » Propagate Properties now propagates the placement properties for dynamics.
Rhythm Under some circumstances, shortening a rhythm slash region might leave it in a state
STEAM-8611 . B, - . : L
slashes in which its length will become incorrect after further edits; this is now resolved.
Rhythm Moving or changing the duration of a slash region with an overridden staff position
STEAM-8648 i I
slashes could cause the slashes to change position unexpectedly; this is now resolved.
STEAM-5759 Selections Extending a_selectlon with Shift+click no longer sometimes moves the view to the start
of the selection.
Selecting the contents of a bar including a system-attached item such as a tempo or
STEAM-8430 Selections chord symbol and then using Shift+click to extend the selection now works as
expected.
STEAM-8464 Selections U;lng S_hlft)_rc_llck to extend the selection now works as expected if the selection begins
with an implicit rest.
STEAM-8531 Setup mode Dorico no longer c_rashes _when you detqch and then attempt to re-attach a player to a
layout whose music contains a slash region.
STEAM-8532 Slurs In the unlikely event tha§ a project contains slur_s wnh negative durgtlons, thesz_a are now
leaned up when the project is loaded, and Dorico will not hang trying to open it.
STEAM-5548 Tempo When a gr'_oldual tempo item crosses a system break and the top visible _staff in the
system is different following the break, the tempo now appears correctly as it should.
Under some circumstances, a gradual tempo item would not appear if it ended at the
STEAM-6547 Tempo same rhythmic position as another system item, like a chord symbol; this is now
resolved.
STEAM-8498 Tempo Under some circumstances, changing the Ilne_style of a gradual tempo marking could
cause it to move further away from the staff; this has now been resolved.
STEAM-8653 Tempo Under some cwcymstancgs, a tempo marking |mmed|atgly' preceding a rehearsal mark
could cause vertical spacing to change unexpectedly; this is now resolved.
STEAM-8387 Text Italic fonts are no longer clipped at the left-hand edge of a text frame, and optical

overshoots are no longer clipped at the top edge of a text frame.
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ID # Component Issue
STEAM-8395 Text Baseline shift now scales correctly as the font size of a paragraph style is changed.
STEAM-8480 Text Changing the V\{eight or italic/Roman style of a font used by a paragraph style now
correctly immediately updates the score.
Time The positioning of time signatures shown outside the staff at system object positions
STEAM-8565 . . : . -
signatures relative to different types of barline has been improved.
Time Adjusting staff spacing now correctly adjusts the vertical position of large time
STEAM-8698 . . ?
signatures signatures centered on instrument brackets.
STEAM-8414 User interface Creating a new window from a project window that has the tab bar hidden now works
correctly.
STEAM-8493 User interface Window » Counterpart Layout. has been |mprovgd SO thqt it can be used from
Engrave mode, though the selection cannot necessarily be retained.
STEAM-8534 User interface Opening a new prolgct cpuld undgr some circumstances switch the layout shown in an
already-open project's window; this has now been resolved.
STEAM-8567 User interface Opgning the same file repeatedly from a network Iocatipn will no longer cause other
projects to be removed from the list of recent projects (Windows only).
STEAM-8593 User interface Switching between Write gnd E_ngrave modes with multiple tabs open now correctly
sets all tabs to the appropriate view type for the current mode.
STEAM-8601 User interface The appearance and position of the Cancel button in progress dialogs has been
improved.
STEAM-8615 User interface The list of open prOJec_:t windows at the bottom of the Window menu now always lists
the correct number of items.
When switching between page and galley view, Dorico now uses the bar in the middle
STEAM-8755 User interface  of the view to set the position in the new view, rather than returning to the start of the
layout.
STEAM-8868 User interface New project windows created by right-clicking a tab and choosing Move Tab to New

Window are now created at the correct default size.
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ID # Component Issue

AD-355 Audio engine A pr_obl_em whereby the length of the first note in the flow could be truncated in exported
audio files has been resolved.

AD-356 Audio engine Un_der some circumstances, Dorico could crash when waking the computer from sleep.
This problem has now been resolved (Mac only).
Exporting audio would hang or export an empty file if the name of the flow to be

STEAM-8538 Audio export  exported ended in a trailing space or multiple full stops; this has now been fixed
(Windows only).

STEAM-8454 Dynamics Edlt_lng unrelated items no longer sometimes causes dynamics to move incorrectly
vertically in galley view.

STEAM-8223 Key signatures Key signatures for transposing instruments in divisi staves now appear correctly.

STEAM-8479 Key signatures Key signatures created using a custom tonality system no longer sometimes reference
the wrong system of accidentals and set of octave divisions.

STEAM-8502 LoraTatioy When running Dorico ina language where comma is used as the decimal separator,
spin boxes that use decimal values now work correctly.

STEAM-8455 Mixer Outputs f_or plu.g-lps a_dded in the VST Instruments panel in Play mode now appear
correctly in Dorico’s Mixer once more.

STEAM-8516 Percussion _Percussion playing _techniques now play back _correctly in the event tha_t one or more
instruments in the kit cannot be mapped to entries in the chosen percussion map.

STEAM-8398 - fDailteetrmg notes at the end of a flow that has explicit bar rests near the start is now much

STEAM:8417 ST Inputting notes in scores with Ia_lrge num_bers of players is now much faster, at the
expense of reducing the automatic balancing of bars per system at the end of the flow.

STEAM-8447 Performance Shoyv_mg the system track in galley view no longer causes editing and redraw to be
significantly slower.

STEAM-8458 Performance gg;aerllng project files with many MIDI controller automation events is now significantly

STEAM-8418 Play mode Dorico no longer crashes if you do Play » Reset Playback Overrides with items other
than notes selected.

STEAM-8435 Play mode The e button that shows whether a VST plug-in window is open now always correctly
reflects the current state.

STEAM-8432 Play mode Exporting a PDF of a 2-up document using a non-European page size now produces a

PDF of the correct dimensions.
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ID # Component Issue

Under rare circumstances in projects with divisi and local time signatures, Dorico could

STEAM-8429 Project files hang when attempting to re-open an existing project; this has now been resolved.

Under rare circumstances, Dorico could crash when attempting to save a project. This

STEAM-8475 Project files
problem has now been resolved.

Dorico no longer crashes if you type a character not included in any of the rhythmic feel

STEAM-8419 Rhythmic feel names into the filter control in the Edit Rhythmic Feel dialog.

Under some circumstances, moving a text item on one staff could cause a text item on

STEAM-8423 Text another staff to move unexpectedly. This problem has now been resolved.
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(TiIMING)IR—=2%ERLET [T I74ILEDY X2YHT4—)L (Default rhythmic

feel ) IAZ2a—DSEBDR V12T INF—VFERLET,

m 211 R (—5E) (2:1 swing (fixed)) - 3 BRI ELEEN . 8 &
FRORTD 1 DHOERFE 2 DODBEHDEORSICEIEFEIEL., BEL
21 DLERD 3 EHERBLET ., COLRFTFURIZERAShTHIFINE
¥

» 31 X425 (—5E) (3:1 swing (fixed)) - 8 HBEFDRTD 1 DHDEHF
2 DHDEFRD 3 BEORSICTFIFEEL. TR 8 A FRE 16 #EHD
HEERBLET, COLRFTURICERASNTHIFINES,

» FVRY12J (Heavy swing) - TURIZHWR DT DLLEMN BT
RT 351 M5 EWVTURT 1.5:1 FTOEHEEATEEHLET .

m BUL\RDs25 (Light swing) = TURIZHWR D42 DR, EVNTUR
T 1.51 H5EWNTFURT 1.1 (RL—F) ETOEBRTEHLET,

n SFUTLRD4VYT (Medium swing) - TURIZHWNRDA T DELEN, E
WTURT 2.5:1 A EVWTURT 1:11 (RhL—k) FTOEEATEEHLET .

» ZhL—bk (R4 L) (Straight (no swing)) - IRTHTURTEER 1:1
DA—TU1; 8 R ERERBELET,
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TJA—DEHR TRV EEET S AP IFDFEDTH R TR I42T 1358—
VEEBRT DI RIAVTNE—VERRT HMEDERF . KAFEZZDHD
TATLEERLTMS, [Shift]+H[T] ZHLTTURDRYTA—N—ZREET,
FRTBRI4T = DRFDRINDIXFEANLET  F=EZETmedIEA
NTBESTATLRAIAVTHPREVAMIRTENE T, FRAIF—%2EFEALT
BIRL. [Return] ZIHLTHEELE T AERORKEBRDERICHAFARTSN. Y
RIVYT4—ILDRATERTRENFET

FoHUITILED 1 To—NV—FEHERT IRV T IR8—2FER T HICIE.
FIXRMRELGDIERDENF. KFFXEXZOMDTATLEZERTS5H. FvL vk
ZEEL. [Shift]+[T] ORYTA—NR—%BANTFRINF—TRYI(0T 18— %
BIRLET, ZRZIC, [Alt]+[Return] #MLTRYTA—N\—FHESE DL, EIR
LIz RICHAENRTEIN, URXIVIT4—ILDEBRTERTSNET,

YRSV I4—ILDEB(F/NEIORRIBMENSLONREFRIELLZ V=0, /MNETD
BHRTYRIVII(—ILEEBLI-GE. TOHEISBENDLD (RO /N DERIREL
ENLIZEYET,

RV G ING—UDEBFHIBRT BITIE, BICERETHHREEIRLT [Delete]
EHLETNAZIVI T4 —ILDAHARERTELIFERTTHICIE. TEa—
(View)] » THAFK (Signposts)] » T)XIv9I4—)L (Rhythmic Feel)] TiEiR
TEEY,

RILVGINE—ERmET B TIAIWMDRADAL T INA—V % RET S, T[T
FUSFIDR Y4 T IRB— B R ETBHICIE. TBE (Play)l » TB&EAFTay
(Playback Options)] TI2432% (Timing) IR—CZRE. TV XIvHI70—)L
(Rhythmic Feel) |2 3> DIRE (Edit)IRE22%E9)v oL TTYXIVI74—)L
Z#mE (Edit Rhythmic Feel)I¥ 4 7OJ #MAEFEY,

@

Name: | Medium swing

2:1 swing (fixed)

3:1 swing (fixed) Depends on tempo
Heavysuing Lowtempo [100 [ o 251, T1%
Light swing =
PR Hightempo (200 [ m 1.0:1, 50%
Straight (no swing)
’ New l | New from Selection ]
’ Save as Default ]
o]
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TACIIMIBESIN TS Y RIY I T —LIFERD)RNMIRRENET, T
AILEDYXEV Y T4—IVEFHRICERT BIZIE. THR (New)1ZEVUvILET,
BEBERLTVDIRXZIVIT4—)LOIAE—ZEER T BIZ(E. IRIRB A O SHHRE
X (New from Selection)1&#2) vy LET , RIEERSN TSI XZvIT4—)L
EA1—H—F1T3)—ICRELT. ChUBITERT AT RTOFHRITADIILT
FATESLSICTBICIE. [FIHIVRELTEREF (Save as Default) 129 voLE
ED

FAT7ATDEBICIE. RI4TNI—2FFET HI-HOBEZIFO—)LA

WO BYFET,

» [FURIZEKTEE (Depends on tempo)lld, R4 T IRE8—0NFRTOHTUR
TEICRCLEERZFRATEINEINEZRELET . AT7DELEL. BLVTUR
(Low tempo)l&lELVTFUAR (High tempo)i®arkO—)LANESHELY R
AT DEEQRSAFT—D 1 REFRRSNET,

= ELVFUR (Low tempo)ll (1 #AREICESRIND 4 REFOET) TUR
ZHRETDE. TNUTOTURTEABRDRSAE—TEET DRV12T DL
ENMERASNET,

n [EULFUR (High tempo)lISTUREEE T HE. TNULEDTURTIEGE
DAFAF—THEET DRAV4V T DELENMERINET,

" AOAVTDLHEORASAE—(F, 1:1 (RFL—F) M5 5:1 (1 2HD 8 HEH
N 6 EFD 5 DRNODRIELD.2 2HD 8 NEMIEY 1 DHDORIL
B3) ECHEMATHRETE, LFRE AV(V T DIN—E UM KBEEDTEA
ZRRLET,

[F2RIZETE (Depends on tempo) 1A DEEE. TBLVTUR (Low
tempo) [T ESNBDTURUTIZEVWTIXZIITIEESN DRI/ T DLLEMN
FHENET ., ZohDTURAEMT HE, IFE VTR (High tempo)JIZHEES
NBTURICETDET. ZIUIHEESNDI RV T DELERIZE A>T Dorico HY
R4 T EDHEETEWET [TURIZETF (Depends on tempo)IAATD
EEE. L ADRSAZ—THRESNDR VAT DEENTRTOTURTHERAS
nFEd,

HEHRELT19—

4% (Engrave)] » I'FFEEEXE (Notehead Sets)IZ A 70T A #FHT=ITEBMEN,
NEBDORESEEICEEZMATAH) D FILOEEEERTEDLIICHYELT,
FEEREIL. BELHSIHEE 1 DITFEH-LDTT , RILFFEIEELRDFEER
ECHATESH.1 DOFBERECHELRELEE. TOFEEFERATS
TARTOFMEREICHLEENBEHINSZLITTEFELTZELY,

53 R—T Steinberg Media Technologies GmbH



Dorico 2 /N\—2av R

@ steinberg

BEOHBERTICITREDLED 4 DOFEARTEINTVET 4 HEHL
TOTFAL—2avDEHFIERTIRENDHE.2 S EHFIFERATIAEDNHE.
BERIFERTIELEVAEOEN. ELEFICERT L. @MAIC 1 A» 2 K
DEVHEHRENA TV IBEVAEDOFE. FEOAVBREOFEIHYET,
Dorico MY R—FFBFEREFINLUSNC 2 BHYFET, BROFTEIZH-T
BRLEZBFVELRTEEVFILE. BEOHBICHTIERFOBTEICR>TER
LI-BRAEILLT A BEEITT . EVFOMBERE TR —MBULELDIE. TEYTF
2 FF8E (Pitch name noteheads)I|DFFEEFZET. CNIEBEBEFD/—FEETIL
T7RYLT (BHRESHHAGEERZALEDT) EROBKOFICRIFTEHLD
TY, BEDHBERTEICIE. E—2UIRN—TRIBO (T /— RIBIZERSH
BlAikin 7 DMK (Aikin 7-shape)1EERHYET,
BEDEEOMERE (BE. . EvF.FEEE) ICE. RALEEOFELIE
ATEE A, EAL EVFORBEREDRITIEEDFBILHERATELL O,
RO MEREF IR FOMEOEREITEATIERTETEE A,

[%%& (Engrave)] » TFFEERTE (Notehead Sets)I|¥ 4704 3 DDOIYTIC
FFBERTLNET,

L] Edit Notehead Sets

Notehead Set Category:
Notehead Set

Common v
Name: Larger Noteheads

Circled Noteheads Category: | Common v | Type Defaultnotehead: | notaheadslackOversized v }
Default Noteheads
Large Circled Noteheads
Larger Noteheads

Slashed Neteheads (Bottom Left to Top Right)
Slashed Neteheads (Top Left to Bottem Right)

& c}ﬁ H}E—

Notehead

Name: | noteheadBlackOversized

Duration: | 1/ nate v

| New | | Mew from Selection I Use for durations shorter than and equal
- e [Z] Use for durations longer than and equal | Double Whole Note
Save as Default ‘

New Natahead | New from Soloction | Edit Note|

,‘7 Cancel n

EAITIE. BEZTEOATI)—EEIRLET , CCOATIV—IEEE (Edit)1>
[%8E (Notehead) | HTA=—a—DABIZHIELET . TNENDH T A2 —IZE
DFEFREEZRTTINEEETBHICIE. ZRAIDURIDSFEEREEZZRLTH
5. BALDOIFEERE (Notehead Set)ltvav(tdHbIATI)— (Category)l
FOyITZOUYRNCATI—%EELET,

ERIDYACDTICIE, FFEEEEDIERRIY LHIBRRIVU A HYET,

» TEFR (New)lIE. T—#& (Common)ATI)—ICHEEIA(TDEB D FFEER

EEERLET,
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n DRSS HDOPHIBIERR (New from Selection) (., IRAEEIRLTLNSFFEEER
ELRILAATTRILATIV—IZBT 2aE—4 R LET . FILLEREICEEN
SR ZTDHELLGS-BRELRLTHAZEICTEEIZEN, FIRBEIZE
FNOFMBLITICEREMALEEE. BFOREICEEFNIFMEELEICLT
M- ICREREER T H&IITLTEELY,

» [FIH4ILFELTRTE (Save as Default)lld. BIRLE-HFEREEL—HF—54
T5)—IZREL. CNLURBEICERT 5T R TOFRIADIMTHEATES LS
[TLFET,

o THEEOBTEICRET (Revert to Factory)lld. REDFEREICHLTOH
BRELGYET . NBORBEREICASMIDERLMA T ZHE. ThiTkY
TIHILEDIRENETENET,

n THIR (Delete)lld. RETOS /DB HICFERSATIVAIMEAIZRY.
ARELOFEBREZHIBRTEET . NBDFEREIFBIBRTEEE A

A LEDOIFEEERTE (Notehead Set)1toiavI(l(F. MEDEYMIRESNA TS
HELIRFINFET A E0)vIL T REO YN BREDOFELEMLET . B
EDEIYLERLFATDTRTORFED) AP AZ 2 —[CRREINFET . BED L
Y BFRFEEZEHIBRT A1, OV ILEY . CNIETORENTODIMH
THEASNTVVEWMES DAFMILBYET . COFRBERENRIRINDIGHTI—
HIEET BICIE, [HhTT)— (Category) VR SEEDNIERF#ERLET [T
74 )LED %8R (Default notehead)lld. ERFDERICERT HFELEVIRAIC
FELGVWSS . EOMBELZERIINERELET (AR 2BRLYRVE
FISHLBY G TAL—2ar OFESEYRRICERINTLEWMES . T4/
DFELIDYICERAINET),

FERTEDIF34T (Type)llFEBTEFE R A EVFEIIBTEICKIHERTES
BT 556 BEOFERENCEEDFIITDLDEERLTHLHRIRE S
MOFRVER (New from Selection) 1ZERAL T, ERICEIHAFERTEEE
BLEY,

ETOIFHEE (Notehead)l v avidk,. G LDOTFFEERTE (Notehead Set)lts

2ar@OJ)yRarvkrO— )L CGERDPOFEDOTONT1ERRLET, ThETND

FEIZHL, LTOTONTAERETEET,

» AR (Name): EEDTUyRabOA—ILOTHaAVIN—DAZ21—IZRTSN
HFEDABRITY

m Fal—>3ay (Duration): TDMEEHEATHT1L—a0 T, FEDH
BOXBRIBEWNT. 4 PBFEETNUTOT2L—23V OB FICIERCATEE
NMERINTET, COBZEEIOMEEITIE. T1/4 BHF (1/4 note) IZFIRLTH B,
TOIZNETDTaL—avIZER (Use for durations shorter than and

equal) JZERELFY
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[ChEUTFTOTFaL—>avIZfifA (Use for durations shorter than and
equal)1ZF4I2d 5L, LDOIFaL—3> (Duration)l THEELfzTaL—Y
AVEFTIEAEL TREYEVNEFICHLTECOFENMERASINET,

rChl EOTFaL—2avIZERA (Use for durations longer than and
equal)|ZAIZT 5L LDIFaL—3a> (Duration) I THRELz=TaL—33
VEFTREL ERIYRVDEFISHLTECORENMERSNET,
TFFEDAR (Stem direction)I Tl FEA LMZEDEFEIETRAEZOE
FICHLTOAZDOFENERAINDISBETEET, (AL (T /—k
DEZRDGE . FEN LRAZFETREDEFICTENT, FEO=ARIIHF
BLFFHEDARIZAEFET,)

&2 & (Double whole note)JTl&. CDFFEEA BB LMK (Round) FE /-
EIEA (Square)INDELELTHIMNEFIBETEET , CnIckY. IIFELF T3
> (Engraving Options)IOTEH (Notes) IR—CDIMELEFRF (TL—) @
FEED S8 (Appearance of double whole note (breve) notehead)l(Z. [,
(Round) JE71=I1XTHEA (Square) IR ELLMNBEINTLEIMZHELTRERS
NAFRBENREINET,

rTEvyF (Pitch)l] ((EvFI2(TOREDH) X, COFELZHERTEIEFD/
—h B LGRS ZHEELE Y .

[FREE (Degree)]l ((BEIZATOFEDH) L. COFRELXFEATLIEHNDOE
E @1 »b 7 OBH) #HRELET.

[#FERE (Notehead)l /S av D TEDT I3V N—IZIELUT ORIV HY F
ER

FFFHADFFEE (New Notehead)lld. TIAI LD EEDFEEICEIMZE
(Normal) 134 T DFRFBEEERLET .

BIREBOMOHMER (New from Selection) 1F. EDTHFERTE
(Notehead Set)|to>ar DS ) yRavbO— )L TEIRLE-FEELERLAITE
NEDOFFERZFRIERLET,

[FFEEZ#EEE (Edit Notehead)ll&. FFEEZDELDDNEREE R CEHMBEI T«
B—ZFEELT LTESBLTZEL,

[FO4ILELTERAE (Save as Default)lld. BIRLF-FEEL—HF—54T5
J—IZRFEL. SNURBRICERT 2T R TOFR IO/ THERATESLSIC
LFET,

MBEEOREICEYT (Revert to Factory)lld. REBDFHFEIZHLTOAER
ERYVET ABDFEIAIGMDEEREEMA T HEIE, ChIZKYTIHIL
FOKRENETSNET,
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[FFEEZ#RE (Edit Notehead) &9 v I3 BEMBEITA2—MBEEET,

% Ecit Notebwad

m Text  Graphic  Composite

OOl
» "]
J : D =
|*J : ["‘7
K g / L LS ) = o o L
1% e
O—=C0—— | ! | | !
¢ ” = >
x ® 4 < ©
Joom: Select | Previouy Next Delete Selecied $
+ e L] [ E]
Compoment m )
- <l © © < )
A o) S
€ w A a A
ASS Ghyph
[ e | IS

EEARIT. SETFELIMTOEROHANSFHED T FAUITEMT 51D %EEIR
LFET.

12 (Glyph) I TlE. AVE1—F—ICAVAR—ILENTWDTRTHD I+
MoXFEEMTEET, SMUFL #EHT+k (Bravura &) #EIRLTLND
H&1E. T&FE (Range)l') AMZ SMUFL XFDHEEMNITRTRRTINDIDT,
XFEMNRDITPFLLE>TVET,

[T%ZF (Text)ITI&. % (Engrave)] » 74+ FRX4A)L (Font Styles)]
[CERSNTWSITAVIRASIVEFERLT. 1 DU EDOXFEZEMTEET,
NERBIHERTIILEHmTT L, BRELLTARAESNTLET,
[4524v% (Graphic)lTl&. PNG.JPG Ff=IE SVG BKXDTS571vo%E
MTEFET AVI—BATHY. EOV A XA TLERBETERTIND SVG D
FERZEHSTIOLET,

[#i#&hHHE (Composite)JTIX, FTACIHMIT TIZEEZESNTWS DS
ZEALTEMTEE T L BBRR TR I I714ALGETUEa—NEESh
TLWVEL =8, BB DAFEIEELTVARENHYET,

EBMTIEREZERLT. BED/N\RILTEICHSMEM (Add)IREZED)vIT
BE.TARTUAIZERDNEBMENET,

FEOTHAVIX KEAADER (CHIEFRENTRAZOEROFEDMEIC
H=UET) ERITLLAODHD T VIFRICERAES|Sh, EEA RO R
(CNIFERREDFEICH T IERBOMEIZH=YET) 2RI DLRODHE
DT IVYRRICHRRNEFI SIS TRELES .
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HEALAZOEFOHEOLRA. BLIUBRENTREZOETFOFEOEAIC.
MEMNETDEMLGNEZIEETEET, £ FEEZHEILIAILI—F1=VY
[CRHENMEAINDIIGEE. EFICHNDICETIHEDODEMDTAYF AR
AP ETEET . HFEDTRVFAVMRA U BINFESHIRT BI2IE., 728
DAV TARATLADTIZHDTHRE (Stem) IR EI)ILET , HEDTAY
FAUMIET HEEMIE. LLTDYUI&Y SMUFL OE#kEHREZ SELZSL,

https://w3c.qgithub.io/smufl/gitbook/specification/glyphswithanchors.html
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F—FarWEHL

B20O70—DHRDA—TAAT7AIN~DEEHEL. BLVEL2DTL—Y—0
AMRDA—TAFITFANANDEZTHLETLERDLIITHYFEL, £, &T70—
DA—TAXIT7ANENRZDIAINT—IZEEHTENTEET, ChIZKY., S5
BABIXTIUTOIRR) T HTHES1=61Z, Cubase HZFDMD DAW [ZKSy
J7oRRAY T4 5DICHELIZ-IFTEIOIVRR— N RREHREICITHRAFET,

FREFECS

EREFEE DAV T DO DOUYIRE: TERFEEEZHE (Edit Accidental)1¥
A7OJT.RBED 4 BENZTNDOUYIRENMRETELLIITHYELT, ThIC
KUY . BEETIIDEFEEEDIVX T ON— T EEDKSITHEIME
Dorico [#ERTEFET,

< Lot acocorts

A Doy 1
o | IER

RS OYYIRESRET B2, 4705 THOTHIYIRE (Cut-outs) 147
9L T ARELDEDADTER (Create) IRFLESYvILTHS, RO
BENTERORBIDBDNIFILEIYYILT, YIREDY A XEEELET . 4]
UIREEBIRT BIE, HRELHEDAOTHEIER (Delete) I RELEHYvoLE
7.

GIYRE BT ARMIE. LIFOULOEY SMUFL OHHHEERESECTESD,

https://w3c.github.io/smufl/gitbook/specification/bbox-cut-outs.html
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ERRFEC S &R MBROERIZERIFREEANFIEGE . MBROERIZFEILELEKSIC
BETEDLIICHYFELZ. COBEEEMICTRICIE. TREFTay
(Engraving Options) IOTERH (Notes)IR—I T, IR ENMHEFO MR
(Ledger lines on notes with accidentals)Z#T M ZFELLLY (Do not
adjust ledger lines)JITERELFET , kY. [ERBEESFFEOERA NS
(ZAHSMEEDE (Ledger lines protrude left of notehead with accidental)]
[CHEESNEONDYIC TFEISIEAHLIMBEDOE (Ledger lines protrude
beyond noteheads) | DEM. RO T IAHILDORSELTHERINET . &REE
[CHIBBERELETIHILEOMRED T I COMERIE. B T3>
(Engraving Options) |DTEEEFEES (Accidentals) IXR—YICHRShf-TEES
NTLWEVWNBROERIZHSHEE. REEDEHEESOEALEDORME (Gap to
right of rightmost accidental, if to left of unshortened ledger line)J4A 73>

[SEYRESNFET,

HEEDE FICHAEEREEDIYT Y &L T3> (Engraving Options)]
DOIEERFEEE (Accidentals)IR—U DT (Gaps)ltoiav(c [HREOEHF
DERICHIBZE. RIVEDERESOABEDOMEME (Gap to right of
rightmost accidental, if to left of back note)JA 7L arh izl BMESNELT=,
BE HEREOERNHLEETL BRHIES EBEEORBDIEBETHEANTESN
FIM. COETHEEL-R/ERETIXEFINET,

FURSHER

% &4 73> (Engraving Options)IDI7ILRIAESE (Arpeggio Signs)]
R—UZ RS9I aEEHDTILRIAEESE (Arpeggio signs on slash voices)]
T hF-ISEBMENEL, CETIE RSV aREBRICTILROARES
ERIRG DNESIHEHBELET . TIHILLTIE RSV FEFHITRTIND
TIRCFRBEIFFEREICENTTN., REILFEET—FTHETEET,

INERR

& ZE[E 8 Dorico X, ERLDT7ATLOMEZRET SFR. EROD L TICEEH
FINEIR (FERITITEBFAURARYILAVMAD 1 REBICEITL/MER) PRE
EEDPR (RTRSNDIEE) £HICEFETHLIICEYFLE,
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# - HDRE/NEER: Dorico 2.0 KYBASNIZFEERRIMILADYR—KIfE
Ly, I 8A T3> (Engraving Options)IDI/ME#E (Barlines) IR—C DI RE
(Repeats) o avIz, HEARBIIRGIE O R ERIIRER (Start repeat at start of
system)1A T Lav i FfzICBmMEShELz, COF T avickY. MERRMLE
D REFBZT, ERLNFREVE—LDEDOEAERTT 0. JE—FD R
DHERTTDINERIRTEET,

ZER: FERMTCENT 1 MIEYRSHBIE L DBEMERY 10 HEAS
NB=F&% . [Shift]+[B] ORvTA+—/\—ITtriplelEANT BTETHRTES
F3IHYELT,

5

[##E&4Fa> (Engraving Options)1DIa—REES (Chord Symbols) JIR—2
DIFILEL— 3> (Alterations) 129 avIz, TFAIILAL—av2xt 3 BEREFED
SOHIE (Position of accidental relative to alteration) 473> h =128
mEhFELIz, ChiZkY. Russell Garcia DEEIZKSS!)—XTThe Professional
Arranger Composer |[ZH#RIN D RECEICHSFLEEFITHAET . Garcia Kl
—RFREEHOERELSLUVTILAEAL—aVICENT K EARDAR—ZANEHHTE
HILEEAIC, BRIFEREDIDOYICTAFTRETSRETEFERATHIILEHELT
WET Lo DESZERYT 4I5S E. SEICHLERE LIEEDIEE TRR
35, DFEYIN-9ITIHLGKI9-JERTTHIENEETY . VAT RESTFFTSR
EEEEEDHICEET L. TL—V—DI/FTREFEEFALMHBLIZY. TSR
RBBET —F1AUMFATREBLIZY T DLGE . HOFEWSEELTLENET . £
DEHFLWA T avIckyY  BEICKELTHFREEEEDOHEITKRTT HLD
IBETEDLIITHYEL-,

Fa—

DALIZ&BFa—: VALIZKDFa1—ZERTHEE . A V54— THARSFIZF
—Z TG AETHOTH. TIAHLNT FV4—T DBAEF 1 —FRILIZR RS
NENESITHELOTVET,

SR L 0

HMEBEDPDTAIT4PDIN)L: TLLPORAT a3y (Layout Options)  DIEERE
#E% (Staves and Systems)IR—T RO LIZT AT DERIRIVERT
(Show divisi change labels above staves) 147 arh#FHfzIBMENELT=,
COFATLAvEFUITTHE BTAT4PDVIRMNEF IV avRICERSH
FRERINUD, ENENDTATAOERDTAIV4ORBMED EIZRREN,
NITHIET BRIV TADINILY ENENDTATAVERDTA T4 T AL
BDLEICRERENFET,

[ &4 a> (Engraving Options)IDIF4 42 (Divisi)IR—T D HLLA
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ToavIZkY  MEF DT T4 ERDSINILIZTL., EERNSDT IAILEDEE
BERETEET, FINIIE B EE—FCERICHBEZRELIZYNFSYS L
YUTEET, Tz, TOANRTANRILDIT4T42 (Divisi)IF IL—TI2FH kS Tz
[ARBLTHRAE (Custom text)]ITANTFAIZ&Y, FEE—FTHELDT1I42
ERDIRNILDORNEE LEETEET,

FrLIPDRUBICTATAVFERT S BERADDENEFICTAIADEES
ERTEDLIITHRYEL . CDEETA T4 DERIE. FBIRDBBAGLE TIE%L
FrLybrDAEBIZERENET,

by TADHAR: Ta4T4DBBERT SEL2HIZTh Y T4IZERS (Restore
Tutt) 1ZEHATREEITRTINDZHARE,. TAI4PBEDORAR G E &K BIAD
CESIZTTutti]ESNILAMFLESITHYELT=,

T4ILE—
RSy aAftEFEIZ I L E—EMTS: TiRE (Edit)) » TI4L8— (Filter)] »
[FE# (Voices)l » TFRTDRSYL afFEFEE (All Slash Voices)1Z:&RT 3
N YITAZa—DUAMSHEEDOFEN LAZE. FENATRE, FLIEFELHL
DAY AFEFHERBIRT HILICKY RV aFEFICT ILE—ENTE
hFEJ,

Jo—
Ja—%kY L: [Shift]+[B] ORyTA—/"—IZTtrimjEANTBHET, R
(Write)] » T7Oo—%KJL (Trim Flow) ZETTEEY,

LAT7 2k
TIHILDIN— L AT o TASIIRDIN— L AT b ERS>THIBRLTLES
=B EICHEZ. TRE (Setup)l » TTFIHILEDIR— L AT IME4ER (Create
Default Part Layouts) | A< RAFizIZBMENELz, 7B—EDTL—Y—
ENENIC 1 DDN—ATINERETEDDT, /A= AT IEDTIAHILE
DR BBERTEET,

RIKFF
BEEEDAtyk/\—: THEFTL 3> (Engraving Options) IOTAFF (Rests)]
R—UDOIEEKFHF (Multi-bar Rests)1to2avIz, T3y b/A—DIE (H-bar
width) 147 L ar b #hfzIzBmanEL -, TEEE (Fixed width)IZEREINT
WBEE. dtyhA—F. RAFOBAO/NEREIIEAT LD TIEEL M9ty
F/X— D EEW (Fixed H-bar width) IO EZFERALTR RSN ET,

62 R—T Steinberg Media Technologies GmbH



Dorico 2 /N\—2av R

@ steinberg

REREZAVDIERO/NEH: HRSNTOWSEETIIEE . ET7/RERERE
AV EBICEITA2ERBFONESHIE 2 DOERDOBICKRTINSEIFTTT A,
N)OYRDFEE Y aAVITERIND/R— I ETIE. BADERD LIC/IE#E
RRTEON—MMTT . [FEA T3> (Engraving Options) I DMK FF
(Rests)IR—U DI EAKF (Multi-bar Rests) 1ty avIicFiksni-I KiExR%RA
WSEEFD/NEE (Bar count on grand staff instruments) A7 aviz&ky., =
no 2 DOXRERAZENDToNEELIITHRYFL,

ltacet al fineJMLELVE: THFEA T3> (Engraving Options) 1 DMK FF
(Rests)IR—T [, T7O0—M#bHYIZltacet al fine]Z#RTTIEED/NMIKOER
/ME (Minimum number of bars’ rest at end of flow to show tacet al fine)]
FToarv b FtITEmMENEL =, TIAIMEIR, FHRTODILDIFZRIT 4 /b
ffi. Dorico 2.1 &YBWWN—CavTERSN-TOZS VDG E L. S ERERTF
FHLOHIZ 1 IMEINRESNET ., ChIzkY,. 70—DOEHLYICEH TEULVRIAK
FELAVELME S TH, Ntacet al fineJZRTT HELIIHEETEET
FRRDTUVRTATL: 2EAEBEE—FDTURMNSYITHERINZLDRE,
HHEE—RTRRINGEVTURTATLIZDOWTIE., RAFENEITHEAERY
SNELAEYFELT =,

MusicXML DFEHAH

TXRNTZATL: TIRIFETE (Preferences) 1D MusicXML @ 5 & 3A &
(MusicXML Import) JIR—2IZ, TFFXRMF AT L (Text items) AT ar b -
[CIEMENFELZ, CNETIAIRTEAIICHE>TOEST . AT B L,
MusicXML 77 ILIZEEND TR TDTFART AT LD [Shift]+[X] DTFRE
TATLELTHEARENET . CNODTHFAMN AT LI, TURPEBILEELLE
ELTCHEARENT-MDTATLEERTHAREENEEICSLBYET,

ATV afFEE: Dorico &, FEREEREETEERDELLICIDONNTH,
MusicXML 74 ILIMBRZYY AFEETEER DY A FEFEEE UG AA D
BEIITHYFELT=,

INERYE—R4EIE: Dorico [ MusicXML Z7AI)LhS 1.2 XU 4 INETD/INER
JE—FBEZESRARADDEIIZHYELT =,

TED#EE: T1REATS 3> (Engraving Options)IDTERF (Notes)IR—T D
M4+ & (Rhythm Dots) 19> avIichH I A DHE (Rhythm dot
consolidation)1A 7L av B BEIN ., BIEN LMY OTGRY ., Tz, HLTEF
BTOAZJUICB TR ROBNEIRET 54T avhBmEnELr -,
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TROHEE. BEYESESITLOEENNEVMTRBRN—RKICERESN. A
DEBIATLOEAIZZENZEADFRE 1 FITKRTESKRIZ DT, Dorico
NINFEDLSITHINETRLET . CNICKYKEARDAR—RFEREHEL
TEFEIN REMIEEERAFENOIREELDIHFENHYFET, Dorico 121
TEOEESICEALTUT® 3 DOZRENAEINTLET,

n [EE&LALY (Do not consolidate)lld, TR IXEIZENNET 2 EFEIEH
BDFTCHAIZRTINDIELFEKRLET

» [RICLREOEFHF (Notes of the same duration)ITlE, RILKSEHFEDIHEIC
RY (Fz&AIXELLBMAR 4 RERDBZE, —AMNTR 8 #EBERTEI—A
MR 4 REROBEEHTEFYFELA). BET LIS LOETFOMNAE
MELET,

s [EEDRSOEFR (Notes of any duration) | Tlx, FEEDH P A EDH
B (FzEAXLRZDEEHN 4 PERFRTTRZOEEHL 2 2EF) THEZE
METEFT . RULAV/N\IMIERENRBELET M. RAFENVDEETNLAE
CLEd,

CHNICMA . THITEIEBTOMFRLI=Y> (Rhythm dots on unisons in
opposing voices)lA 7 avhBmMEnEL Iz, CHITKY, ML THEERIZEHT
57Talb—2aveEVFARL 2 DOFEFITOVT. [HRE 1 DRTRITHMN. B
BMC&IT 1 DY ORTFTINEIRETEET,

FRDKFLAE: TONTANRILDOTEFEAF (Notes and Rests)17)L—T
[ZMF /| X (Rhythm dot X)17A/NTAAFH-IZEBMESN, FEE—RTHADK
FRBEAETELLIIHYEL BHOEFIPELHEICHFETHES. O
TANTAIEA BT I —TEEKITEASN S EITEFREL T L3N, FIL—TI2
[F 2 DU LOEEHNLDBRNEFENIIGEELHYET .

MEFEFERRIZT S TO/RTARILDIEFEARF (Notes and Rests) 147 )L—
TIZIngZEFERT (Hide stem) | FO/STaMEFf=IZBIMENEL=, 2COTO/NT
1EHFEE—FTOHARTIN, FUICTEEEFITHESITATOMBMNIERTRICE
YES,
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R—=SLAT7Ik

[N—FERXBREEZIE—T % (Propagate Part Formatting) 13 47045 h3#f=IZ
BMENFELZ, ChITKY  R—PHBABRESLULAT I TavEaE—xL
AT 1 DULEDEEDLATIMIOE—TEET , CDFA(7RT Y
HIICIE EEE—FDLATIMNRILHNDLATObEED )T 5 (ERLT
LAT IR IE—TL AT IRELTEIRSN KB THAT7OITHBEHEET) b,
BEAZA—DLBRLET , ROLSLEAAT7RTDRRINET

L] Propegete Fat Formeting

(o] IE2

7£1ﬂ|]$|!!!!l535—i|/'f7'7 FEZRL. BRIOVARDG 1 DU EDREED
LATORERRLET VRAMDTD 2 DDFVIRIIRIE. FATAITEHTE
LILEDRMEERELET .

n [LAFPIRATarEESHS (Include layout options) I, R—CH A XER
B, T4 EDIRE—R=DD v, EDES, ERODAR—V T EF
DAR—=2 2T REHRTE.. RKFOEE, ERIRNILDA T avigl T ELG
LAT7 A T3 EaE—TLAT IO EEDLATIMNIOE—T M ES
NEEELFET,

n [HHEROEAREEZZHS (Include system formatting)Jl&, FEDLATD
FOEBMERICKR TS H/MERE LUV EIL—LICK TS S EHE. aE—xL
AT INMIEDEDINEINERRELET . ChEERITTHE BEICKELT. Th
TNOEEOLATIIDZHBEORIBMEIC, HERYIVELUTIL—LRKY]
YBMERENET . EEDLA TV EDOBFDOHEERTYEIVIL—LRYIY(E
FTARTHIBREINET , SHIT. BRODAR=S VT OEENIE—TLAT I
BFRTOLAFYMIAE—EhET (QE—%(LATIFDEEDZTHFDRR
— VT DERITTRTHIBRENET),
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AE—TLAT7 I rDHBEORRABRENRIZRFEE. FETLLFIMEToay
(Layout Options)IDIBZEERTE (Casting Off) JIZIKFELTLBIEEIEX. TLLF7D
rFarE&H5 (Include layout options)JZFEAI L, SHERICHERREY
YOTL—LRUYEERLGECTH, ALFELFKIZERCLAT IO ELNDT2H.
MO KXEREEZEHSD (Include system formatting)JA T a2 ERAT 2
EEHYFEE A

BROEHRILV—LF—UEEATIEMB/ LTI, [I—MERERE
#1E—9 % (Propagate Part Formatting)l# 47045 ®aE—xL A7 & T
FEEDOLATIRELTELTWER A, Dorico (&, ATREGEBE T, aE—xL A
TIRBEVEEDLATINDEAIZHEITHEMIL—LDOTSAI)F—2DHE
EREEITEVETN, AIE—RLATIMEEDLATIMDERENKECELD
Ba. PFERLGAIBRELGDIGENHYET . FIC. FEET—FTITEbON=R—
UBREDQ LEEFFOE—ShFH A,

LOLZLD Y —ATIE, 773 —FIEEI230D 1 DHDAURARYILAU LD
LA7ObZFzyvoLThio, TI—FEKXEREEZIE—T S (Propagate Part
Formatting) I1Z AL TRYDLAT7OMIEEZHREGERTAHET. AV ALY
WADPRNR—FOBRABEEOTOCLRICET M E RIGICHIBTEET,

BE

INVDTSOURTDYIVRDEHEAIAH: Dorico (&, A—HF—AU8—T1—R% =
IESEBIELL, /399559 RT HALion Sonic SE [ZH U RERAADDES
[ZEYELTz, ChIZKY ., BLDBEEZRONITHEAET, LA E FHRTODT
JbERIEL CIL—V—%BMT HGE. FIRIL—V—EhTNITRELY Y
Rl A9 559 R THEAAEN, O—FNET TEHETHEOI LA TL—
—ZBMNTES0., BEICHHDBRAKBICERINET, T BEOTOD
IVMERKGEE. TR TDYIURDRARENDIDEHFDOILLEL ANVHEEE
BBFICITRAET, TADIIMEYYBZBI5EE YO VRNV I TSI R T
HBRAENDEZH. FHFLVWITODPIILTOANPHREZBHICTEZAET,

INFYE—FESDBE: ME—FESABBHICHBESNSRIICHRYELT,
INETJE—MEOERIZHS 1 /& (1 PMEDVE—FEEDIHE) F-IFEHK
INER (2 NEREFIE 4 NEIDVE—ESDIHS) AL /NEUE—MEEDT L
—2avIlEHETHEINE T, Dorico [F. LED /NN DETFERF(FRY RS
3. NEE—MREICREESN HRBRESICHLET .
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ERBEDRAML AT LDOEAE: Dorico 2.1 (£, Dorico 2.0 KUEEBRSINE=HIETD
RS DEEMEEFREIE. 12-EDO 4 24-EDO [TEFELHELHLW LM
DRATLIZE TR BOBREETLEICYR—ILET, Dorico &, HALion 773
J—DIN—F ¥ LAV ARy LAV (A2 FILER HALion Sonic SE 3 &) (2(X
VST3 /—hrIHRTLyiavsE, DDAV ARy)LAV L (NotePerformer &
) [2I1& VST2x TAF1—UR_SA—4—%FERALT. BEHNERHIT S & TR
EINTLANEINTEDHLT . TR TOEFICENGEYFTILAEELELET,
hnizhmz. TBEAT>3> (Playback Options)JIZ#&RENfIFa—=24
(Tuning)IR—=JIZEWNT. BERFOREEYF (TI4/LME 440Hz) ZHEETSE
BEITYFELT =,

JL—XELTOEFERT®E5EES: Dorico (&, iEiEd 5B D EH RO &S H5E
PFELESEIL—XELTHRBIES LML, il TRECEZNELTIKD T
(37K, BRBERIRSEEE S EN TN DRI E T, BRHRBLANILIZUEIYNET,

ATLAHADREIR: THRE (Edit)] » TT/NLRERE (Device Setup)lF /470
FJIZTRFLZAH A (Stereo Output)jarkO—/LAEFT=IZEMEH, Dorico NNE
HICERAT A —TAHAVE—TI—RADRTEEIRTEDLSIHYELT,

App Nap: App Nap [& macOS DEIEREET. /Ny T IIURIZBITLIET T
r—arO7FoteyyEARREEBBMNICHIHLTEAFEREZEIBLET , i
KUY BERICZ Dorico /NI SO URICREITLIZEEIC. BENRUINIY., 5T
2ITFELELTLESYTHIENBHYELT=, Dorico [£45 % macOS [IxiL. B4
FIE App Nap ZEAIELENESIZEFTEEY. Dorico /NP5 5O URIZHIT
LTEBAEZHIFONGEONLSICLET,

BEE—F

REDERT: FSYIDERKE.L—DEEY (X, §F—rA—avL—VIC

BESNA TS MIDI A hA—5—GEDFEBRNT A TRES LVETEINDG LS

[CEYFELTz, SHICEY . BEE—RAOLHIDOE—FICUVEZ . BUBEE—FIC

ROoTH, INLDEENTATHRESINET,

BikbSv: TBE (Play)l » ThS9Y (Tracks)| YT AZa—m#iskeh. BE
E—RORIDTIL—NV—rIVIDLIZKRTEIES 4 BEOFKNVIEERT
E5EL3(12YFELz. 204 L (Time)l, Fla—F (Chords)]. TET# (Video)l.

[T—h— (Markers) D4k VI DR RIFERTEETNZTNER THRETEET,
JO2zohOT7a—ICETAMRMEIN S L, TVideol&MMarkers IO RSy HE

BICRIRINET,
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A—bA=2a  OBEEHE: BEETE—FDOTURERIE MIDI DA —kA—=320L
— VU TIRAVNERSY ST T BHEEIC [Al] F—ZFHFTET. RAVMEDLT DBE
TEHDT., JYBRBLGRABEZITHERAFET,

FSVIDYARXEERTTSH: BEE—RT. BRLIEZNSVIDESEFLERTT STV
EO#fzIZBINESNEL =, TIAIED T a—RAvbE [Shift]+[G] & [Shift]+[H]
T9,

EEDBATVTL—bk: Dorico ABREDTODIIRTHIURE—YHMAFATER
WESIZF2i581%. THE (Play)l » TBEETYTIL—b (Playback Template)l
N FE=BBAETUTIL—MESE (Silence)lZ#RIRLET, TOCIHTH I
FEBAETAICE. COFAMT7RTEL5—ERVT. ChUSNOBETUTL—hE
BRALET .

MIDI thru TERT Y IUFEER: BEE—RTrIVINYE—E9)vIT B,
BRAADNEHDEEIC MIDI F—R—KFhSERINIz/—bDII—/\VYIfF
RAIBI VR RAVNERETEET T, EE—FTHRERINTHILTHY
VUREEETEET,

WEBE

RARAENTY ST1v0EFERT HBERRERT EBRFICAL O BOBRART
S ERIREIHERL LI <BYELE.

JaozH8I7A(IL

Dorico MIBN—2 3> TREICRFEIN-TAD UL FHRAYE—DRY
JAPRRSN, OV RFENTz Dorico D/A—avh@HSh (3FE
TESHHE). FLLUWN—23 0 THRKET R VM BEIMICEFH SN S LN EE
SNFET . TAD VNIV = )i REE TR NE T, 2FY, BW/A\—ParTti0
PxOMERVWTY CICHALES S IRFERLEE A ThIE. SO EZITITEDA
EEHIEITAT, HETIDTAD NN UBDN—Da0 TEERWV-HED
BHRICITEDONENETT . COAVE—CERRIELVGEE., NREEE
(Preferences) DI £#& (General) IR—C DI 774 )L (Files)lt9> 3> T, 8]
N=2av KYHWFEEEFLOA—2avTRESN TS I MR EEEE
&9 % (Warn when opening projects last saved in an earlier or later
version)1#4 7129 5L TERYICTEET,

Dorico M BN—2 3> TREORELEZTODIIMNERNA—2a TRV =HET
RO TLEEZLTLELLBNKSICTT BT, TBREFERTE (Preferences)lDRICIGFT
[2HBMBRN—Dav kYT WEEEFHFLLIA—DavhsBLN=7adc I g, #Hl
LMERFICERFETH2EERT (Prompt to save projects from an earlier or later
version to a new location) 124 ICLET . ZOATLav st UIZioTNSEE
(. T274I)L (File)l » THRTE (Save)lZEIR, E£i=(X [Ctrl]+[S] (Windows) *+°
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[Command]+[S] (Mac) Z AALT-#{ZETH, Dorico IFBELEZZITHVEYE
Ao DOYIZ ZEDT7AILBIRFTATATHRTSIN, TASTIEOF LB
LRTFBFOBIRNMESNET . COLE. RFEOTAD I IFAIVELEETS
CELERTEET,

TONT«

[#&5E (Edit)] » [FR/8F4%&aE— (Propagate Properties)]a<> KA Ef=IZ
BMEINFELZ, CNICKY, BIRENTWBSTATLDTONTAZREDLAT L
Mo, ZOTATLBRIRIINDMD T RTOLAT7OMNIOE—TEFT, iBEE—
FTETLIZEE. BEE—FOTO/NRTA/IARILICRREINDTO/NTADAHD
LATIMIOE—anFz T, FEE—FTETLEBE. BEE—FEEEE—FD
WA DTANTANRRIVIZRERENDTANTAAAE—ENFET,

BILT. SBFEE—FTHRIRSINDTO/RTo (TRTOLATIMIBERASND D, L
AT IR LICEG DB ALHINRMIL—LDFI—VIEDEERFELRL)
[E. AT LOEKRNGHEEZHOERNHY . FEE—FICLhRRESNENTA
INTA (BE. LATIORIELT TR BHTOL—LDFI—UIEITHLERNAE
LB) [ RBEBLGT 749N BOMEICEDLAEREHFLET,

1EARR L RT—DMBEET A (ER. WRGL) (FREE—FITRREINLTO
INTATHY, BLEE—FHSITO/F1%ZaE— (Propagate Properties)]ZE{T
LI-GRISEAINET I A5—RIFOHERA OB EGHEIXFEE—RIC
LORRSNEBNTOAONTATHY ., FEE—FhITANRTFoZaE— (Propagate
Properties) 1= R{TLIIGEDHBRAINET , ChI&Y., I RTOTO/NRT1%
AE—F 0. ELATVLORABREDFHMICBAHLLTEBRATES LD FIE—
JONTERTEFT,

ATy 18R

AUV ARBOERDEMEERTICT S RSV aBETE. Z0HERNIZH
BDEHOEFET I+ TERTICLTVET  ChIZkY. EXIEBER
[CYADEZRRNBZEREL DD RAAT7ELV/N—HMIERIY 2 DAHERTT HE
WSTENTEE T AV A BEICHDEREZRRIEIVLELHDHIHEIE. 7O
INTANRRILDTRASYS 1888, (Slash Region)17 IL—F Tl EEZE R T
(Show other voices)1 7R/ T4%&FIZLET,

RSy B ONE#: THEEAT 3> (Engraving Options) IO E
(Notes)IR—IIZHzkSn=T/MNEE (Count) 1o av(Z, RSy 5B O /INES
HERTT DA TavhFHzITBmMIShEL,

" [RSYDaEEBO/NE#HE n MFTLIZTRTF (Show slash region bar
count every n bars)ITl&. /MET$ERTT IRHBEIEELET . ChEl1lc
RETDE T ATOMHITNEHRD RTINS IIITHEYET,
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s [R5y EEO/NIBDIE (Appearance of slash region bar count)JT
F.DEIBHELEDLSICERTTEINEHEELET, MERWDE  (With
parentheses) ], NEilZ& L (Without parentheses)l.JEZRR (Do not
show) I OWFIHEERLET,

n [RSYLaBEO/NMIBOEIE (Placement of slash region bar count)T
(X, NEHEERO LFLIETOELSICRTRTINERELET,

n [ERHASOIMIHKDIEEE (Bar count distance outside staff) 1 Tl&, ERD
LiRFELIE TR/ BOBFETCOEREZIEELE T,

HFEETFTE BREIGLTMNIROBFOMBELRELLVNS Y LIZYTESE

ED

FERINIL
ERSARNIVICHERITBZIIFTFRAMN AR AVEZHE (Edit
Instrument Names)1Z A4 7072, EERINILD LY EHLERXEREETES0H
DIAVRA—/LAEBMEINELT=. FTEDA VALY IILAV D RBEE D IZR RTINS
ERINIVERETHICIE. BEEE—RDTL—V—IRILTEDAVARY LAV
MNEYHETENTNESTL—VY—DHh—FERRALET . 1V RS ILAVRRIZTIR
A—INZEVTIEINI> 1 ZRREE. [>120)vILFE T, AV THXAMZ2—
Mol ARIZERE (Edit Names)IZBIRLET . ROFSLBFATATNRRSINE

-é_ ° @ Ednt Instrument Names
Editing instrument fdating Plaral names
Full name
qlsutines o] AflDNose +Fl w0t “" ﬁ |8 M;::-:;' [ uoist M
[e——— v ) [rabc B3 coose 2] 372 oooe |2 ;7;;:.‘.-7 NI
Piano
(for rehearsal
only)
Short name
T A - [) Al [ e [2] @568 il
X : oeox [2] 22focex 7] [EZIHE) (YA) w8
Pno
Show transpo RIS _
ve a3 Ml !
Cancel m
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COEATOTICANENF-TFRAME, EREFDRBICRRENDERINIVE

(FTTHLEBRLEEBBDAVRARIIILAVEDEESINIILICHFERSNET A COHA.
BATRERZEE TR THIBREN T, SRNILA 1 FICFEHONFET . ol #4470

JOEEICEATHIEEFEBRINES . hMDOYIZ NSTITRESILDEREIEIC

FERINFET . ChIZKY RO ENSTET, ERINILOEED—EMHZFHER

TEEY,

ARG ILAVRDSRIVET IHILMNET T BITIE. TFIHILRZYEYE
(Reset to Default) &9y LET,

RO IL—TSN)L: Ti§EEF T3> (Engraving Options) IDI#EERIRIL
(Staff Labels)IR—JICIEETHIRICLYAEFZDOERS NIV (Staff labels for
identical adjacent solo instruments) A7 a3V EFt=ICBmMEhEL-, TFER
B®D4 IL—F4E (Group between staves)JIZERET SE. BILAVARyILAUKC
BLEBEET HERTRTITHL. L DDAV RMYILAVCE NP RFIZ TRES
NET 2EZE 2 DOTIL—FA—FDIHE . TFlute IZNILA 2 DDFERMIC
FRHFZTERESN., EOERICETL, TOBRICIEI2IOIRNILAFEET,

TGIW—=TIR)IE, BCAVRARYILAVMZBT HEREMEICHLF R TERES
NETEROUIFTHDIBE. TIL—TSRILIFEATDERDE 3 &I 18
HDBEFEATD 2 DOERBDAR—RIZ, hRFZ TRESNET,
AVRRYIWAUNBEEB LUV T AT EIIaVITEFHLLNVNSTSTRELILTH
BRIV () (Staff labels (inner)) IAMEREN, T IL—TLELD AV Ry
AR TIN—T DN BEUETAT4ODTIWN—TFEIETL—VY—DIR)L
[ZIX, RERDIEERSAIL (Staff labels) JDRAAILHIMERSINET , RO, &
DEEDSNIVLDEDINST S TR EFRTENERLET,
ERINL
HRSNIL(A)
1

Flute

Bassoon

Solo
Violin

gli altri
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HE D5 E

O steinberg

HEBEONFRENBSLIUNADOERINILEDERE. IFEF Ty
(Engraving Options) DIEERSAJL (Staff Labels)IR—L DI DRAIALIE
(Start of System) AT avEFERALTRESINET,

JO0—DRBEBEDINIL: TU—V—ITBEDAUXRYILAVIDEIY B THNT
WBHEE. TL—V— L BEEDHBEFICEDA VAR LAV NG BR T RENE
PIELTHEIENEETY, ZILARIATLATILTIE, BERVOHEEDERIZFE
RURUBRIRIENFET N, A= AT ILTEHBERTEINEEA [LLFOR
A7 ar (Layout Options)IDIFL—+— (Players)IR—C DMLV Rk LA
YrDOZER (Instrument Changes) 7 avIz, [7O0—ORABEEIZA ARy
IWAVRDEESRILERER (Show instrument change label at start of flow)]
ATaVhFzICBMEINELIZ, COFA T avE FHRIOD /D /A—k A
T ILTIETIHILETHUICHESTULVET A, Dorico 2.0 LARTD/N—23 0 THERRE
NzTR I HRTIE NBERFTHLOICHTITHE>TOVET  AVICTHE &
DD NEDBIB LB AV ARSI AV D ERINLARIREN, TL—V—(FE
DAVRARG LAV NG ERT RENDIHAYOTLLEYET,

TAD4PDT IWN—TSR)L: T4 4P%4ER (Change Divisi)IZ 475 OIS
L—Y—&F (IS5 IL—T8%ERT (Show player or group name) 147 avid,
[LATPIRAT 3> (Layout Options) | DIFER LR (Staves and Systems)]
R=IDATLav FYBEINDLIITLGYEL e TAT4ODTIL—TEIE T4
TAVISTIN—TEDNEBRINTOENEE L, FEISh-HEONEIDERLA
JVIZRIRSND T IA DAV R ILAVRRIZEY ET, FRESNTLDIEE .
TATATDT V=T EDBRFTINET,

5

HMEBEDHENTEE (FO—IT—FEHLULOERAEENDIEETIELEL) EROK
NELGLIHERLTOMIZOARTTDILIIEETEET . ChiEN\UD VDL
— T4 Tty a3 D=OIER SN/ — ETHEASN AR EHREITY , CODE)
EEBHNZTBIZIE. TLLAFT 24T 3> (Layout Options) DTSR AR
(Staves and Systems)IR—IDMHABDHEIFEES (System Dividers) 933
LT MHABRDHEIZREERT (Show system dividers) |ZER DO MM R Z15
& (When number of staves differs)JIZERELET . [TLAY—DR/NMNEHTE
9 5BE (When minimum number of players present)Z:&RT D&, HEE
DT IHIVEDEMEELYFET
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BF¥

EF

O steinberg
s
REFIHFLE: BESEITERPIUCRBEROIIL—TIC 1 DOBEFEEEER
REBAToavhRESIN, EEERLLEZOMOHOHET773I—ICET S
FTRTDAVRRYILAVRET IL—TELT. 1 DORELIRFREERTTEDE
SITHYELIZ, COEFRICEY A TLavDRENTEERBRELUZEBRORED
AV RRYILAVE (Instruments between brass and strings)J. R A & 31
TS (Treat separately) I ETBE—DKIEIMEL TS (Treat as single bracket)
[CEESIhEL,

ZAEOA: [Shift]+[M] DRy TAH—/\—[ZlopenléANTBE, EEBERRLEN
EHDHEEERTEEY,

EROBFOI+NER: THHEA T3> (Engraving Options) | DT EHF
(Tuplet) yR—C DIEFDOBMFEDRAA)L (Tuplet digit style)lAFavIz [T
L—2x2k (Plain font) JO:ERBEMNFZISEMEINELIz, COA T ar % &
RIBEFEAFTDOEEIA UL (TIAIMTIE Bravura) IZKBEHMMAEKRFTE
fIEMFEOHFOINDYIZ, THE (Engrave)] » TT74+2FRE4)L (Font
Styles)IDTEHDTL—2T+2k (Tuplet plain font) ITHEESINDTF AT+
VEAERSNET .

EFOAFEIMOTYIDAE: THBAT 3> (Engraving Options) |DTEFF
(Tuplets)IR—C DI KFERE (Horizontal Position)]tZaviz, [AIEIOE
IMEIEERTHEEDA 7tk (Offsets for Start and End of Bracket)JEWWSR
HLDEE 2 DOF A ToavhEmEnELfz, CCTREROAFEINOA
BIEEBIDAR—RADTIAHIVMELZ R ETEET . [FENATRAZOEFIZH<A
MDA EDEMA Ty (Additional offset for start of bracket on
stem- down tuplets)IDfEIL. EFICAFBIILNRTIN. FENTRETHSE
BEOHERSIN. [FEN LRZOEFICH<AENORTHEDEMA IEYE
(Additional offset for end of brackets on stem-up tuplets) JDfEIL. EFFIZH
FBIILNR TSN, FEN LMETHIEZEDAERASNET . EFEOTOAD UMD
BEIE. B EL>TLESICLEMCIzO EIEL 0 [TERESATOWET . FHHRS
ACIIMDBEIE 1/4 ITHRESATOET,
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A—HPF—A2A—Tz—R

F—R—KFia—rhvb: TIRIEERTE (Preferences) DI F—HR—Fa—rhvk

(Key Commands)IR—CDI#EE (Edit)JATI)—IZ 3 DOARUEAHFH I

BMEN., LA7IMIBEET 52— RIGEREICDONT, AZa—PE 177 %K

K F—AR—Ra— by b CEERTTESLIITHYEL.

» [/NFDHEEZEE (Change Bar Consolidation)lld., /NN E—FD
KRICETS 3 DOKE WELL. RKFOH. RNFF&L/NEHVE—RES)
ZTNENICODVTHEDF—HR—FIa—rhvbEBRETEET,

» [IDNFDHAEZEYIVERZ (Toggle Bar Consolidation)JIZlE 1 2DF—HR—F
a—MOVRERETE RYBLEITTSE 3 DOKRENEFRICUIYEDYE
ER

n [LA7IMDBREVIYE X (Toggle Layout Transposition)JIZl& 1 DD+
—ih—RSa—rhAyrERETE BRYRLETTHE, THRE (Edit)] » TBIRE
wF (Transposing Pitch)1&T#R&E (Edit)] » TarH—kEYF (Concert
Pitch) IO TUIYEHYET,

FSRR—FD R Y—IN—DIZ,FURAR—MADEA LTARTLAED )Y
D9 BENEAE.TaVY . BB, 24 LO3—FDIEIZ, HBEAHLULEDORTATY
BOBIIIBYFEL Iz, A URSVRR— 4RI TR GRIDEA LTARTL
A&V 09 2L, FEBREEIM La—FNIRICTIVEDYET,

TAVEDBAXEMEDER: URIRELLTODIIMEBERKEE . REL:
VAEDDHARXEMEBEZIYVEWVEEMETERTESLIICRYEL,

e

RONSHWETHI7ZAIILDMBRER: ETAMNRMEINE-TOC IR ERKEE,
TOCTIMNIEEFEINDLEDUBICETF AN R DOMSALVE S, Dorico (&
Dorico AP IMIESITHIA —TETAI7AILERERLT. ZRLIZBEILE
BBICERMIETEVES,

Apple ProRes E77: Apple ® ProRes a—T v/ ERAY5E T4I(E. ProRes
a—F v h Dorico BIFICEAESN=CEIZkY, ERBICBASNAESICHEYEL
f= (COa—Tv7(F Windows TOHWHE, Mac TIEFMEDI—Tvoh 7% TH,
ProRes 774 ILEBETEED),
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Issues resolved

@ steinberg

ID # Component Issue

STEAM-5341 Accidentals Changlng the enharmonic spelling of a note with a microtonal accidental now works
reliably.
A number of problems relating to the choice of specific accidental in note input when

STEAM-7506 Accidentals multiple accidentals in the tonality system have the same pitch delta have been
resolved.

STEAM-8133 Accidentals It is once again possible to select the symbols in the Edit Accidental dialog with the
mouse.

STEAM-7673 Articulations Staccato articulations are now positioned correctly under slurs on beamed grace notes.

. . witching away from Dorico while it i rtin with th n io engine in

STEAM-8174  Audio engine Switching away fro orico e it is starting up th the Su.spe d audio engine
background preference enabled no longer sometimes causes it to hang (Mac only).

STEAM-8162  Audio export Attempting to switch to another open project while exporting audio from the first no
longer causes a crash.

STEAM-8227 Barlines Stgrt repeat barlines pow appear correctly at the start of the system if they coincide with
a time signature that is set to appear above the staff.

STEAM-8143 Bars When deleting bgrs at the end of the prOJe.ct, Dorico now ensures that tempos, rehearsal
marks, note spacing changes and breaks in the deleted range are correctly removed.

STEAM-5767 Beaming Furtherulmprovemen.ts have been made tg Dorico’s algorithms for avoiding “beam
corners” when beaming between notes on different staves.

STEAM-8148 B®ming Under somg circumstances, stems on notes. crossed_bt_atween.staves. cpuld appear on
the wrong side of the notehead when reopening an existing project; this is now fixed.

STEAM-5767 Beams A problem that caused beam corners (where a partial beam is positioned on the' wrong
side of a between-staves beam) to appear for some rhythmic patterns has been fixed.

STEAM-8204 Beams A problem whereby_notehea_ds could .dr_aw on Fhe wrong S|dg of notes when crossed to
other staves when first opening an existing project has been fixed.

. . . N .

STEAM-8156 Breaks Movmg a system or frame break signpost with Alt+left/right no longer causes the
signpost to be removed altogether.

STEAM-8098 Chord symbols Chord symbols no longer incorrectly appear on extra staves added to instruments.

STEAM-8213 Chord symbols Chord symbols .nOV\-/ correctly caus.e. multi-bar rests to split on grand staff instruments
where one staff is hidden because it is empty.

STEAM-8022 Clefs A problem.whereby redundant clefs appear in extra staves belonging to an instrument
has been fixed.
Dorico no longer shows restorative clefs and key signatures at the end of a tutti passage

STEAM-8069 Clefs at the end of a system belonging to the divisi staves that were present earlier in the
system.

STEAM-8023 Divisi S.ta.lvgs in galley view will no .I().nger be spaced sufficiently far apart to make room for all
divisi staves, when the last divisi change has been deleted from a section player.

STEAM-8071 Divisi Time signatures at the end of a system that coincides with the end of a tutti range

(following the end of a divisi section on that system) now appear reliably in all staves.

Dorico 2 /N\—2av R

75 R—T

Steinberg Media Technologies GmbH



@ steinberg

ID # Component Issue
STEAM-8085 Divisi Changes of kgy S|gnature in unison ranges before or after a d|y|5| change on a system
no longer collide with the double barline after reopening the project.
STEAM-8223 Divisi Key signatures on divided transposing |nstrur'n.ents in the preamble at the start of the
system now always show the correct transposition.
STEAM-8284 Divisi l)_lgapllng instrument changes for a given layout no longer causes the staff labels for
divisi staves to stop appearing correctly.
STEAM-8288 Divisi Pasting a divisi event that references a custom paragraph style into another project no
longer causes a crash.
STEAM-8322 Divisi Under some circumstances, pasting a divisi signpost could cause Dorico to crash; this is
now fixed.
STEAM-7942 Dynamics Dynamics will no.longer. sometimes be positioned incorrectly in galley view after editing
them, e.g. changing their placement.
. The cresc./dim. gradual dynamics in the Dynamics panel are no longer incorrectl
STEAM-8254 Dynamics . g. ”y . y P . 9 y
shown as hairpins in additional windows opened for a project.
STEAM-8325 Dynamics Und(_er some circumstances, ed.lt.s to.notes on ong system could cagse dynamics on the
previous system to change position incorrectly; this has now been fixed.
STEAM-8068 Flows Playback is now always initialised correctly when importing flows into an empty project.
STEAM-8095 Flows Spllnlng an existing floyv no longer caus_es notes on the left-hand staff of a piano
instrument to be moved incorrectly to the right-hand staff in the new flow.
STEAM-8103 Flows Layouts that co_ntaln only a subset of flows now play back correctly, and can be
exported as audio correctly.
STEAM-8282 Flows _ImprO\_/ements to the handling of players with multiple identical instruments when
importing flows.
STEAM-7482 Graphics Graphics files imported from OneDrive using the “on-demand files” feature now appear
import correctly (Windows only).
STEAM-8183 Holds and Caesuras that are not positioned immediately before a note, rest or barline no longer
pauses cause an unexpected spacing distortion at the following barline.
STEAM-8183 Holds and A caesura positioned at an arbitrary rhythmic position within a bar no longer causes the
pauses spacing of a time signature at the start of the following bar to be incorrect.
Key Key signatures no longer incorrectly collide with double barlines to their left when they
STEAM-8085 . . . . . L
signatures appear within a tutti range preceding or following a divisi change.
Key Under rare circumstances, defining a tonality system with specific combinations of
STEAM-8208 . L :
signatures divisions could cause a crash; this has now been resolved.
STEAM-8223 Kgy Key S|gqatures in divisi staves are now always correctly transposed if required in a
signatures transposing layout.
Reset to Factory in Layout Options now restores staff label options to the correct
STEAM-8279 Layouts values for parts in part layouts; previously it was incorrectly using the defaults for full

scores.
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ID # Component Issue
. A problem whereby shorter notes contained entirely within the duration of longer notes
STEAM-8267 MIDI import . . . . ) ;
'mp on the same instrument would be omitted when importing MIDI files has been fixed.
STEAM-8296 MIDI import The last note in a MIDI file is no longer sometimes incorrectly omitted if its duration is
shorter than a quarter note (crotchet).
STEAM-8178 Mixer For some projects, the initial dlsplgyed position qf the Video fader in the Mixer did not
match its actual output level when first opened; this problem has now been resolved.
STEAM-8083 Multi-bar Ed|t§ to grace ngtes c_lo_se to divisi change events no longer sometimes result in
rests multi-bar rests being split incorrectly.
STEAM-8121 Multi-bar Multi-bar rgsts r.10 longer disappear at transitions between instruments when the player
rests has local time signature changes.
STEAM-8144 Multi-bar Creating a sygtem break following a divisi change no longer incorrectly causes multi-bar
rests rests to be split.
Multi-bar Divisi changes belonging to players who are cued into the current layout no longer
STEAM-8164 . ; .
rests incorrectly cause multi-bar rests to be split.
STEAM-5809 MusicXML Transposing instruments created via MusicXML import are now correctly numbered,
import taking their transposition into account.
MusicXML Switching off the Beam groups option on the MusicXML Import page of Preferences
STEAM-7884. . . . .
import now correctly takes effect for all noteheads within a tie chain.
MusicXML Some specific combinations of coincident tuplets in MusicXML files exported from Finale
STEAM-8122 . - . '
import could cause Dorico to crash; this has now been fixed.
MusicXML Importing a MusicXML file into an existing empty project no longer results in some of the
STEAM-8203 . . . S .
import required default notehead types being missing from the project.
MusicXML Under some circumstances, the import of nested tuplets in MusicXML files could fail.
STEAM-8256 . . )
import This problem has now been fixed.
STEAM-5625 Note input The default enharmonic spelling chosen for grace notes now matches the spelling
chosen for normal notes.
STEAM-7113 Note input It |s. no Ion-g(.ar. possible to input noteg on a staff no? currently visible (e.g. an extra staff,
ossia, or divisi staff, or a staff belonging to another instrument held by the same player.)
STEAM-7493 ot It.|s now po§5|ble to lengthen or shorten the QUratlon of an implicit rest repeatedly
without needing to reselect the rest after each edit.
STEAM-7506 Note input The_lnput of achentals with equivalent pnltch .deltas in tonality systems that define
multiple such accidentals has been substantially improved.
STEAM-7585 Note input Multi-paste now works reliably when copying material crossed from one staff to another.
STEAM-7585 Note input Under some circumstances, cross-staff notes could be pasted onto the wrong staff; this
STEAM-8167 P problem has now been resolved.
STEAM-7852 Note input After using Edit » Paste Special » Move to Staff Above/Below, rests that were moved

as part of the selection now correctly remain selected.
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@ steinberg

ID # Component Issue

Slurs that end at tuplet positions are no longer incorrectly unscaled when using Edit »

STEAM-8021  Note input Paste Special » Reduce.

Copying and pasting material between instruments with differing numbers of staves now

STEAM-8066 Note input
works correctly.

Attempting to change existing notes into a slash voice no longer sometimes causes

STEAM-8082 Note input Dorico to crash.

Copying and pasting between instruments with different numbers of staves, or between

STEAM-8086 Note input o
divisi staves and regular staves, now works as expected.

Copying and pasting an ossia or extra staff signpost from one instrument to another now

TEAM-81 Note input . .
S 810> npu correctly creates additional staves if necessary.

STEAM-8134 Note input Grace notes are now handled correctly by Edit » Paste Special » Explode.

Edit » Paste Special » Explode now works correctly if invoked on a staff that contains

STEAM-8147 Note input .
. both notes and dynamics.

The enharmonic spellings chosen for octave-transposing instruments no longer

STEAM-8249 Note input . o
P unexpectedly differ for non-octave-transposing instruments.

It is no longer possible to use N/M to cause notes to disappear because they have been

TEAM-8262 Note input . . . . "
S 826 'npu crossed to an ossia or extra staff that is not visible at the selected rhythmic position.

Inputting notes via MIDI keyboard into a new voice now always produces the expected

STEAM-8263 Note input . .
enharmonic spelling.

The notes input on one instrument no longer incorrectly affect the enharmonic spellings

STEAM-8270 Note input . . ) . .
P chosen for notes input on another instrument during the same input session.

STEAM-8289 Note input Divisi, ossia and extra staff signposts are now excluded from block selection.

Using Alt+N/M to move items to the staff above or below no longer incorrectly attempts

STEAM-8297 Note input to move pedal lines or divisi/ossia/extra staff signposts.

Setting articulations and accidentals before specifying the pitch of the grace note to be

STEAM-8298 Note input ’
input now works correctly.

Edit » Paste Special » Move to Staff Below (Alt+M) now correctly always moves to the

STEAM-8319 Note input . . . ) .
P next staff when the selection being moved is not on the first staff of an instrument.

Starting note input via the mouse by clicking the Lock Duration button in the note input

STEAM-8329 Note input
P toolbox now works correctly.

Under some circumstances, it was possible for a note’s rhythm dot to be shown twice

STEAM-6975 Notes when the note is consolidated with a voice column to its left; this is now fixed.

Under some circumstances, single-stem tremolo slashes could collide with noteheads
STEAM-7665 Ornaments because the stem was insufficiently lengthened; this has now been fixed (Windows
only).

When an ossia is active on a grand staff instrument, only one of the main staves can be

STEAM-8206  Ossias hidden if empty, rather than allowing all regular staves of the instrument to be hidden.
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ID # Component Issue
STEAM-8063 Page layout A problem whereby editing the position of a tempo mark could cause the vertical spacing
to change unexpectedly has been resolved.
STEAM-8092 Page layout Hldlng empr staves .now.onf:e again works correctly for players holding multiple
instruments in layouts in which instrument changes are disabled.
STEAM-8165 Page layout Spurious additional clefs and key S|gnatu.res no Ionggr sometimes appear in the middle
of the system when extra staves are set via layout options to start at system breaks.
STEAM-8200 Page layout Chaﬂges made to staff spaf:mg for extra ;taves bt_elonglng to an instrument are now
persisted correctly when saving and reopening a project.
STEAM-8243 Page layout Under some circumstances, moving a rehgarsal ma.rk in Engrave mode could cause a
tempo mark on another system to move; this is now fixed.
Under some circumstances, repitching music could incorrectly cause lyrics above the
STEAM-8277 Page layout o '
gelay staff to move further away from the staff; this is now fixed.
Under some circumstances, editing or inputting notes directly before a multi-bar rest
STEAM-8278 Page layout could cause the bar count number to move incorrectly away from the staff; this is now
fixed.
STEAM-8287 Page layout It is now pos§|ble to select the staff spacing handles for multiple instruments held by the
same player independently when instrument changes are not shown for a layout.
STEAM-8312 Page layout A series of fermatas positioned OI?I adjacent. barlines no longer sometimes move
incorrectly when one of the fermatas is nudged in Engrave mode.
2 Under rare circumstances it was possible for Dorico to crash when editing the names of
STE A percussion instruments in a percussion kit from the Edit Percussion Kit dialog. This is now fixed.
STEAM-8157 Performance Thg speed of inputting n_otes in projects that include changes in the number of staves for
an instrument has been improved.
STEAM-8246 Performance Th_e speed pf inputting _and editing mu5|c_|n larger projects with percussion kits shown
using the grid presentation type has been improved.
STEAM-8268 Performance  The speed of note input in larger projects with instrument changes has been improved.
STEAM-8103 Play mode A p.roblem whereby layouts that do not have all flows attached could play back with long
periods of silence has been resolved.
A problem that could cause Dorico to hang during start-up if the Suspend audio device
STEAM-8174  Playmode P g dunng P P
in background preference was set has been fixed (Mac only).
The correct VST Expression Map is now chosen by default when creating a solo double
STEAM-8285 Play mode . i .
Y bass player when using the HALion Symphonic Orchestra playback template.
STEAM-7989 Playing Adding an ossia staff above the right-hand staff of a piano no longer incorrectly causes
techniques pedal lines to stop drawing.
STEAM-8224 Plaqug Under spme (?lrgumstan_ces, pedal lines would draw on the top staff in the system in
techniques galley view; this is now fixed.
STEAM-8327 Playing Editing the default placement of a playing technique in Engrave » Playing Techniques
techniques now correctly updates any existing playing techniques in the score right away.
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ID # Component Issue
STEAM-8136 Print mode Lyrlcs colgred by .VIeV\.I » Notes and Rests » Voice Colors are no longer incorrectly
displayed in color in Print mode.
STEAM-8198 Print mode Cqmmands from the Edit menu that can edit the score are now correctly disabled in
Print mode.
STEAM-7482 Project files Importing a graphlp located in OneDrive when using the files on-demand setting now
works correctly (Windows only).
STEAM-8195 Project files Improvements haye been_ made to the way tha.t Dorico determines the filename to be
used when exporting multiple flows to a hew project.
STEAM:-2812 Setup mode Under certain circumstances, draggin.g gn instryment from one player to another in the
Players panel could cause a crash; this is now fixed.
STEAM-8269 Setup mode Changing the mstrumgnt h.eld by .a player fr9m ong kllnd to another. no longer incorrectly
changes any slash voices in that instrument’s music into regular voices.
STEAM-7501 Slurs Creating a slur yvnh a smgle npte selected npw always correctly advances thg §I1_Jr tp the
next note of a different pitch, instead of ending at the end of the current note if it is tied.
STEAM-7674 Slurs The positioning of slurs on grace notes in multiple voice contexts has been improved.
STEAM-8241 Slurs Attempting to crleate and extend a slur with the mouse when more than one window is
open on the project no longer causes an error message to appear.
STEAM-8155 System track  The appearance of the system track in music in open meter has been improved.
STEAM-8190 System track  The system track now draws correctly for bars that span more than one system break.
STEAM-8271 Text The valut_es for the default distance of text items from the staff were incorrect by half a
space; this has now been corrected.
STEAM-8320 Text Clicking Revert to Factory for one of defaglt paragrgph styles in Engrave » Paragraph
Styles, no longer causes problems displaying items in the score or even a crash.
Time Time signatures local to a single staff now draw correctly when global time signatures
STEAM-8033 . .
signatures are set to draw outside the staff.
Time Start repeat barlines now appear correctly at the start of the system when they coincide
STEAM-8227 . . . . . . . .
signatures with a time signature change, and the time signature is shown outside the staff.
STEAM-8110 User interface It is once again posglble to define s.hortc_uts for commangs nested two levels deep in the
Key Commands editor, e.g. for articulations, note durations, and so on.
STEAM-8129 User interface The state of the varlo_us buttons in the user interface concerning the Video window now
always correctly stay in sync.
. Navigating through the entries in the drum map with the arrow keys now correctly
- f S . .
STEAM-8185 User interface updates the selection in the panel at the bottom of the Percussion Maps dialog.
STEAM-8219 User interface Some list controls in Dorico incorrectly caused the Input Method Editor for CJK text input

to become activated; this has now been fixed (Windows only).
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ID # Component Issue

Under some circumstances, the instrument labels in expanded player cards in the

STEAM-8260 User interface Players panel in Setup mode would stop drawing; this is now fixed.

The Stereo output and Sample rate controls in Edit » Device Setup no longer flicker

STEAM-8332 User interface .
when changing values.

STEAM-8090 Video There is no longer a limit on the length of the path of an attached video file.

Changing the project frame rate via the Video Properties dialog now always correctly

STEAM-8093 Video ;
sets timecode offsets for the current flow.

Advancing the playhead position frame by frame now always displays the correct

STEAM-8132 Video . X .
timecode in a newly-created project.

The position of the video fader in the Mixer is now always correct when opening an

STEAM-8178 Video . .
existing project.

STEAM-8235 Video Dorico now always correctly detects the framerate of a video at 23.976fps.

The presence of a timecode staff no longer causes staves to become misaligned in

STEAM-8101 Views e . . L .
galley view in projects in which instruments have a variable number of staves.

Staff labels shown in the margin in galley view no longer disappear for a moment at

STEASEES Views certain points when scrolling music left and right.

When multiple windows are open on the same project, only the window in focus will

STEAM-8176 Views .
follow changes of selection.
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https://helpcenter.steinberg.de/hc/en-us/articles/115000808250-Video-support-in

-Cubase-and-Nuendo
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BALA—FDEFEELET . EXE. TaLL 1 BTEOMBMEICE 1
FERTY DI LI—FIMFTEENLHEBEIHYET . 2FY. 1 BHILEE
F01:00:00:00 M5B8 L (F10:00:00:001MSEIRT 5156815 D). 2 HHIF
r02:00:00:00) (F7=1&£l11:00:00:001) N SEAET S, ELV--BEETT,

TRTCOTOANTADFREERZT5. TOKIZIJvILET,

BEE—RFTETAZERMLIGE . TETHDOTR/T1 (Video Properties) |¥ 4

FRINEBRICRKCLEHYFER A EEE—FTTIA—DA—FEEV)YILT,

AUFERRAZA—DSTEFA (Video)I»TFO/8F4 (Properties)1ZZiRT 3

N RBEE—FTI—HD—NRILDOLEBIZHITETADTO/NRT+ (Video

Properties)IiR2> &0 ) w03 5E FATRTHHEET,

ETAZRGTHE REE—FDTO—NRILIZHZT7A—
DA—RDETFRBIZTINL)—LTAAVE TETFDTO
/374 (Video Properties)|#A7AJ THRELIZETA D NS
1 IL—LDHDEA LaA—RHRRREINET,
ETANRASINEGERBFICETA D4R DEREET, VAR VRIELHESR
HRRELLDIGEELHYFETHN. BENBFYREETAARIINET,
BRHETAI7AILDEE: HFLIZETATI7AILIE Dorico 7R HMAIZE
ORAFENDIDTTIEHYER A, TOD I NEE=ZFITEIETHIH5E. #IELTE
TANDT I CANBEGEZF ETAIT7AINERERICEETIVNENHYE

ETAMRMAINTODIMNERAWTEE TAHZERE TE
BWMEEIE, 70— RO 70—DH—FIZ, Tq4ILLY—
LZ7AAVDIDYICZEAROEET(AVNRRINE
ER

TOCHIMIETAEERIESRIZIE. BHVVYYLTIETA (Video) I>T & T
(Attach)1Z#ZE RL. RCETAI7MILERMLEBLET . ETADBEFOTON
TAITHHFSINET,
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ETAERMETIEERT D v—h—  FMLO—F  TURKRHLGE BIRIZED
HCEMZEMT 576D Dorico DWEEFXTRT. ETAMRFESA TGN
BTHERATEET . ETAERMLTWECTE, IL—LL—r S A LO—FFtA
DfEIE. TETADFTO/37« (Video Properties) #4704 #EHALTIEETE
FT. 4475 ERKICIE, 7B—Dh—FEE Y)Y LTIETA (Video)I»TF0O
INT41 (Properties)JZ:&RLET,

ETAD12RY: T942F (Window) »TET# (Video)1%&:&IRT 5H . F—=R
—RSa—kAvk [F4] (T4 ZERTEE. ETAVAURVDRTIFERTE
PYBZONET , VAVRIDHARXEME X, TAD IS ETIFGL 7TV r—
DAV DBRBREICBVWTRESNET,

JL—LL—kEAALTO—R: Dorico I, 24fps M5 60fps ET. FAYTIL—L
DEA La—FHEH T, REPTLED IOyl aFLEHERSTHEAINS
IL—LL—tERBILESYR—MFT . RESLUDFTTORETHERAEINS
NTSC AK(FTL—LL—FH 29.97fps THA=®H. FOVTIL—LDEA LD
—REFEATIVELHYET . /VFAYTIL—LDEA LO—RDIHFE . ETL—
LIFBEHISRIOTIL— LM BIERICESHITINETHA. FAVTIL—LDE( L
JI—k®MZEE. 29.97fps & 30fps DREIZHDHERE 0.03fps ZEHEHED®H
(2. FEIRICZ A LO—FBBORXTvTNTHEONET . B 10 KERV=ES.
B4 LOA—RBEEM 2 DIL—LAYURNSLEANET, 59.94fps & 60fps D]
[Z#H5 0.06fps DEEIZTDOWNTH, FHKOERENAERAINET,

Dorico Tl&, /> FOvTIL—LDEA La—RIEKECTfps AftE, FOvT oL
— LD La—RIEEKEICdfpsIHBFEET,

A4 La—FRIEThh:mm:ss:ff IO R TRRSNET . ThEh 2 Hr TR, 2. B,
IL—LERDOLET . FOYTIL—LDEA LO—FIF, HETL—LORIZRYIY
XFELTAOUTRASEITIAVEFEALEY, 2FY. /oFAYyTIL—LDEA
La—FI&T00:00:01:05 1 &EXRFREN ., FAYTIL—LDEA La—FIE
r00:00:01;05 1R RENET,

FSURR—bDAURD (F—R—Ka—thybk [F2)) (21X, BE ORRBEMEIZH
o TRAMLO—FERTTDHIIELTEET . CNEBNTDICIE. BEA T3>
DT84 La—F (Timecode)IR—I T, 3L LT4RTLA (Time display)1%&l4
A L3a—F (Timecode)JIZBRELET,

ETADEBERMNYY: RHETADEENYIIE. RA7OBELRELTHAES
NETETADERNSYIDHEMNGEELRET I HICE. S FH—ZHNT
(F—R—Ka—rhyk [F3). Y—ILA—DTETH (Video) T4 L a—RA%
DUV ILTETAH Iz —4—%KRRLET [ETH (video)]7z—5—(F, 7z—4
—DHVDHEA, IReverb jZ7z—4 —&lOutput J7z—4F —DERIIZRRSNFET,

EF47z—4—%31—rF 5L ETFOERISYIEI1—FTEET,
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RNICB->TETHEHRET D ETAVAURVICE BICTBEANVFOBRAENE
[ZXET 5T —LDEBZGNRREINET, Dorico NBEZFFLELTSEEICE
EANYEDMEZERTEDSAUHNRREINGEVGEE(E, NRIZERE (Preferences)l
DIEf (Genera) IR—CDIBEBE (Play) o avIiZh b {BIEEICHBEAYR
#%&K (Show playhead when stopped)IF Ty IRy IREFUICLET,

BEAYRIE FIURR—bIUR DD REY (fast-forward) / HERL (rewind)
REVED)IFT DM F—R—FIZTFUoX—2HIHEE. [+] & [] F—%EEH
LTENT ENTEET, F—R—FITTUF—HIEMEEE. [F7] TEHZREL.
[F9) TRZEVYZEZEITTEET . Windows DIHB A X [Ctr]]. Mac DIFE X
[Command] ZEBFICIHI LT, L BTIEHEC 1 IL—LBETBETEES,
Mac TlE. 77202 3>0F —DFETIHIET. Ra—L BIEDRESLE, AT+
THREGEDHEDI=OIZL AT LAIMERT 510, [Fn] F—31HE TRFIZIHRS
BENIEESENGENHYET .

N—h—: I—h—LIE . ETHTDHEEDIALI—RIZRIFTENIRNILT, £<
DHEERFEENICEL-BIRETEELRMBZEZRLES . v—H—(F., TEEHE
(Write) I>fR—Ah—%4Em (Create Marker) Z&&RT B, F—HR—Ka—rhy
b [Shift]+[Alt]+[M] (T4 /LE) ZERTEHLT. BEANYFOBREMEITEMT
EFET XD [FRAT7 OIS T DEABIZR TSN, T—H—DIR)L (TIAHILE
TIEIITI—HA— (Marker) JERFTEND) (. TANRFARRILDIT—H—
(Markers) 17 IV —T12&HBTI—h—TF Ak (Marker text) 7R/ Tah, Fi=(&
HEE—FOY—H— I RILOVThHhEFERLTRETEET,

R=A—/\R): T—h—IL BB E—FDT—H—/ %L
T.REDTO—DI—H—ZFJALRTTHRDTEIZH I
BI+1RAE D) T HIET INRIVICEEEMNT S s
EITEFT . MK EAETTITT—I—DRAAHE |y
ERAEFHT. TATAOR—H—HEDSILT—F7 [
OO TWBIGEREITERNTT  RY—H—DFA( La—
FETXRMIEELE, I—H—RILDORADRET S
T4—ILFEZT LI ILTEEAVIIVTRETEE
ER

I—A—I\RIILDERD 3 FIHIZENmp.j&ELSIN)IL
MV TWWET, ThiklNmportant] (EE) OEET
ER

BEELGI—h—LiF. BEMERBISIBRZATIEEILNBOTEETHDH L
ZR$Y—H—THY. Dorico DTUREHEBEEICEVWTEELGRBZRLET,
I—h—%EERI—H—ELTERETBIZIE BIZTImp 1B DOF IRy I REF
VIZLEY,

Markers

10:01:11:03 Scream
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R—N—DTHAV: I—A—DTHAUICETBAToavIE BEF T avIH
LLTEIT—h— (Markers)IR—T(ZHY . CCTIEEAALTI—FESRILDEDL
& LICERETAIMNERELZY. MOKSERBERHHLIZYTEET, 74007
S)—, DA PFEREFRAVMIEB YA XEEETHIZE, [%EF (Engrave)»[2
FVbRXAL)L (Font Styles)IDIT—h—TFRXRATAUL (Marker text font)J
FIEMI—h—D 24 La—FRA74+>k (Marker timecode font) JZ#R&ELET S

Y—A—DRRIEZRIR: TIAHIITE, I—A—[FTILRIFLATIRTIE 1
BELDREROLICRREIN, N—bATORTERRTEINETA T—H—D R
MBZXZEETHICIE.EEME (Vertical position)1ZT#E D E (Above
system)IE = (ZTFHEBEDT (Below system) | OWTHMNIZERELET, £=1E. 2
A LO—READERICY—ND—ERRTHIELERTEET,

AAT 234 La—F%FRR9 %: Dorico (&, RA7IZ2A LO—FRADFHGEERE
ERLT. ZCITAM LO—RERRTEET  AMLI—RDEBRERRTHICIE. L
AT A TarDIv—h— (Markers) IR—S%EEIRLT. TEERE (Vertical
position)1ZM 24 La—F®DEE (Timecode staff)JIZERELI=5Z T, 4440
—FDERZXIEMD LICEE (Position timecode staff above bracket)]IZ.
ZDEISZALI—FDERERRESE DA VAR AV T 7R —ERELET
BRI 34 LI—FERICBITE8/LI—FDOHE (Timecode frequency on
timecode staff) %% EL T, 2/ LO—FDERTE 1 /MEIZE MHERZE, =%
FERT (BALO—FDERICY—H—EITERTT HIHEE) MoBERTEET,
HHEE—RTY—H—%2KS5Y5 T % I—h—ICEEESNI=2/4LI—FDELEM
BRESH, RSN EETHOBEDIL—LIZHEMICR D TONET, EitE
[CRRSNDZI—H—DUBELERT BIZIE, B E—FTY—h—%EF=EEIC
FS9TLET, Chick-T. 70— DB ENSY—A—HEETDIRTOT
UREREERYESN, JO—ORMBREICE, T—Ah—DMEICEES T HHRD
TURNEESINET (R—H—FAHICFSVTTHETURNLENY, EITRSVT
FTEHETURNTAYET ) COV—ILIEL T IVIGHEEL DN E-T . Lz 17—
Hh—% 1 DRSS LI=EE. FNLYRIIZHEIR—H—DEHEBIIEELL-EET. T
UIRADEEIT 1 DRI —A—LBICBFEDIEVNDILILGHEEE,. SDETHER
TETLWERA CORIITEELREEEICOVTIK. BEE-FTEALNYY
DIREETHEVES,

BAEEFRTRALINYIEZHEET S BEETEROIM LY —FEh. D0
—DTURERICHT ERBELHIHET T4 HIVICATHERDLIITHEYEL- E
TANRHEIND L, I—h—,RAENEETADEHDS VI BEE—F
DARNTARTUADRLEBICERREINET . FALISVI DR OTURER
£T5L. X—H—DRBHVTILIALIZEFHFINET , FELGRAUMITUR
EREZRATHCLET. BV N—DEELOEANEDRHENBRICTHRAE
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TURERH: Dorico DEFEEETHHITURERE (Find Tempo)l™ o1 KH%
FALT. 70—2KDBEY LT URERETEET, COVrURIIE, BBHEE—F

DI—D—N\RIIZHAITURERH (Find Tempo) IR EI) v HERME
EX R

& Find Tempo

Flow: Flow1

Bealunit:l f I : - 4 l |
o L]
Tempo increments: m Allow Increment by 0.25

Tempos found: Markers:

Tempo range: 2 8
50 bpm 200 bpm

BPM IFO  NFO  AFO Timecode Text Imp. Fr.Off  TimeDiff.  Not.Diff.

Selected tempo:@=171 | APPY

—_—
TRz (Find Tempo)lV4 o RDZEFERTBHIZIE. T—h—/ RILTHEL
&L 1 DOY—H—HEE (Imp.) ITHEESNTLEIRLELAHYET, COV4UF
DTCIE. FA—FDEELI—H—IIxL., IzEAFHAICTESEITEWMIEIZR S
KICTREEREIC BT UREBRETEET,
ERIQODO— LA SEEDHEOEMEERLTH S, GRIOTTFUREEH
(Tempo range) IRSAF—%#FRALT. REXNRETBTUROTRELREZER
LET OB ETUREREZERE I 5L, RO MREESN=TUR (Tempos
found) IOUREFINET  RESN-TURIE EBELGI—H—DFHIIL
—LA T DFEYENENDOI—A—DENSETNTL—LEDTFHITHL,
BIET)RMRRENETS,

IFO.NFO LU AFO ORREBIXIZTNETNEELY—H— (IFO). EETIIAHL
Y—Hh— (NFO), ZLTFRTHY—H— (AFO) DEHIL—LEEZEKRLET,

BRIOIv—h— (Markers)IJX+TIE. T&HEh=T/R (Tempos found)i')
ANTERL-TURD LYFHEBGERSFONET  UAMIFEI—h—H KRR
NN T BRUETUREZFERALEGSEOEMASEITNEIL—LDOE (Fr.
Off), INHEUT OB TEHLEINEIZT—H—MBELAEDEERZ (Time Diff.).,
BEUEBFEDLEEIZLDTaAL—arTRHOINEII—H—LBLHEDE
(Not. Diff.) ARIRINFET,
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RBETURMNRESL, B ESh-TUHR (Tempos found)]VREMSZDT
UREBIRLTOURNTONER (Apply)lRE2VEIUVILET, TnickYTn—
ORI MEICERLI-TURMNEBMEN., D TURERIETATIA—DNSHEE
INFET,

s

Dorico 2 Tl&. BFRBORRFICETIFHEELLC.EBEICETS 2 20O4T
2aAVETHAVICET D 3 DDA T avNFHEICEAShTOET, FiERIC 1
DEFORTITIBEDEEDIEINZ EHOERD L, DFEYTURDOUN—H)L
Y—OBEDHEBRTATLERBEDMHEIZ 1 DDEFIEEERTLEY., KEND
LIZTE AV ENERERAFEE 1 2ERRLEYTESRSICHYEL. C
NoDAToaviEneFnt, BEICHANERINSIEEICSVWTHAFRESZAIL
=E5EEAHYET .

HFEEDNEEFEINT S HFTLEDOEREICETIFA T avongFhihsE
RIBIZIE, LAT oA T avIcFhksni-MBFEE (Time Signatures)|X—
CEREET,

Time signature position and size:

A
)7 4

| =

o g

[a) E
)7 A £

ANV %

o) :

= ~ —

™ ~
Show on every staff Show once per bracket Show at system

object positions

ATV EHRET DRI LATINDOEEICH LB GEESIM TEERLET,
BE.TXKIEMIEIZ 1 DT (Show once per bracket) | THBA TS oD
fIEIZF (Show at system object positions)[ERAIATZL AT IO HIZ{FEA
LETHINELT LA—TAV T REVF THERAT O D/A—rLATIRTIE,
BELYRSTPFIESEFERTIHICTKFIIWMILIZ 1 DFF (Show once
per bracket) JZ: &R HEELHYFET,
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KEFIMTEIC 1 DRARTHIHEFES: KEMSEICRRINDIRETAFRES L.
BEOHBFILEELYKIBICKEGZIEND, KEARICHHDIAR—REKIEIC
REGYET CO=H AFREOTHAVICETEF T avDERELHE T
BOICEEBITTOLET . CNBLLAT O T avIicHBEIn-THFRES
(Time Signatures) IN—U Mo RBIRTEFEY,

Time signature design:
- § a ?'; - A?? - §
A9 o)
i o )7 4
o —
SV 7
e &

~ C ~

Normal Narrow, serif Narrow, sans serif Plain font

r+O—+U27 (Narrow, serif) 1A 73> Tk, EHRNGAFESOHFNDFO—
T+UMREERLET , SO T+ ML, Britten, Birtwistle & 20 i RED
HEICEDERDHBAMIERSIN DI NEREFLET . [Fa—Y> 1Y
7 (Narrow, sans serif) 773> Tl&. Helvetica RE DT BTFRI T+ M4
LI NBERIT AT I+ MDRFEEALET . COTAUME, BRE. T
LEBLVT —LBEDOLI—T127 AICERSN - EEICHERAINLLDIZHE
MEITLVEYT , LEDOADLYIZ, TTL—2T42k (Plain font) 4723 &R T
=F9 . nEMaFREATL—274 2k (Time signature plain font)) (M&E
(Engrave)»T 74 FRBA )L (Font Styles)I THR&EIEE) TEELI=TA MMt
ALETH, CAICEFO—FIFIAVTURRRESID I+ EEIRT HILES
TIHLET,

ToHUTIHOKREBMZEENENEFESS 1 DFDRREIN, TIHILLT
FRBEMODEEAMICHRFZ SN TOVET , BATKIELEFAOERICE
HFREELRFRINETN., TIHILTEEBEDOHFEESLVIRERYET,
FIEMTOLEANTIFERDATIERIZ. TN TN DOERITERE LY KREVEFE
ERRTEINET, KIFIIZEIZ 1 DOAFREZRTIEIERIC, BEETE
BAETETERSIURBEROKRENL 1 DORFESEHEIS 1 20
TJI—TELTIRSKIIZTBHHEF. BEF T avEMAOTIBAFRESE (Time
Signatures) IN—UICHEIL., TTTEFELUVF—R—FHADOXFIM (Brackets
for percussion and keyboards)IZE—DXKFIWEL TS (Treat as single
bracket)JIZERELET .
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BRE, TLEBIVT —LBTEDOLIA—TAV T ADAIFERIZE T, H8FEE
FEXFMOPLTEGLLEIHICHIAONSZENHYET . ChEBEIRT BICIE,
HBEATIVEROTIAFEES (Time Signatures)IN—U (2 EIL., TXKIEN
12X HEEHFFDES (Vertical alignment relative to bracket) 1zl ERiZ
(Top)JISERELFET .

HBEF T3V DOMAFEES (Time Signatures) IR—2 Tl KIFIIZEFT S
RO LI. HFERBORTEERLIEETEET . NI TIHILLDF T3y
[T RTOHERIZRSR (Show on every staff) EARABDBEDRTIEEIIHNTS
RARELLTYET ERA 1 DDBE (1 14 Fi=lE 125%)., RN 2 Oh 3
DOBE (4 F=lE 400%), BEUVERA 4 DLULDBE (10 Fi=ld 1000%)
T, TN ZTNERIBEEAFRESNTLET,

HEA T VDMEDHEFRS: 1 BELOER (BLUFTav LT
DFER) ODLED. TUROVN—PII—VBEDHETATLDEEIZRTIN
SIEFEE L. KEAR., DEYVRXLDAR—REHBELEWFRNHYETH.
FEEARDAN—ADEENKEGYFET . COEBDAFELESDEEIL Carter
1> Henze GEDEHMRICEHERDTHERY THEASINDGILITEY, 20 HicERE
LTT7—rEEOAHFTRRICERLEL,

BFREDEICRIRINDERIE. UN—HILT—Y.  TUR VE—MEIIGEN
FIZTRRSNDERERALTHY . CNFLATIMFToarDIEREMME
(Staves and Systems) IR—C DMHEEAT DIk (System Objects)1 o3>
[CHBA T araEALTHRETEET,

ERDEDVFREE. TIAHIITEIBREDHFREED 2 FEOYAXTERIRS
NETH. CNIEFEAF T3> DMEFEE (Time Signatures) IR—2I2HD
$AEBEA Tz VPDRBIZR TSN SAFEEDHEE (Scale factor for time
signatures shown at system object positions) ITER TEEY,

RO LDBFESEIVALDAR—RE HWLGEN -0 IBOXNEFESOT
PALEFERTHEFTNIEFEDLETEHYFEEA. LOLIBFESHUN—HIL
Y= TURERESDONDIGEE . TIAHITIRFESIMEDTATLEARIC
BLOYES, 20O RBOFEVNTHFIUEERITNIEZTALDOMET NE/NEK
TELH. — BT EIRMDBHYET , TURPUN—FILT—IFRFEED LI
KRRSEDGEIF. FELF TV DMEFERE (Time Signatures)IN—2I1ZHB
[FUORBXUVIN—YILIT—VI20TEHHFREDHE (Position of time
signatures relative to coincident tempo and rehearsal marks) & FIZEE
(Position below)JICEEBELET,
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RO LOPFEENNEHBEES LR ONDIGEEIE. LATINE T avDlINGHE
B (Bar Numbers)IR—Y(CHAHTHBA Tz IMIBICHFREE L HIHIEFMT
X/ iEBEIERTF (Hide bar numbers at time signatures at system object
positions)1ZA VI L T/NIBEFTEIERRFICTEET,

RO LOBEFERBIE /NHROLICHRFIZ LT DL, ERALTENERIRT
EFETHEORTHNETCHOERZ AT HiIaFRSE. HEORTHETH
WASNET ELZIICEASDERLHY . TN+ TIEEHHTLDIEEIL.
LROFBRL-BEENERAINES . BREDERET. FEF T3 DOMAFREE
(Time Signatures) IXR—T(2H D NIMNIRIZxT TS EF] (Alignment relative to
barlines) 1A 7> a> TR WLVET,

HFESOIBNEMTRREINDGEE . P BIF. FFOTTIHLGLAIZ, FEMN
ERAZEOEFEZFERALTRTINET . A BOERORREERE, BEF T3y
DOMAFEE (Time Signatures) IR—UIZHAHBEFDT1L—avELTERRS
h3928B0OfE#*E (Scale factor for denominator when shown as note
duration)J#ZHE 9§ 5 ¢ET, P FORRERLIIMBER A TE=ET,
FNENDRFELEIL. BFEEE—KRT [AN+KEF—FRIEIIRARSYS 2 EH
LT . BRISHBARE TS, TRE (Edi) 1> TRI>ZavEYEYE (Reset
Position) & A3 5. A7y rOBRYELNTEET,

SARATLNIYY

DRTLESYIIE HMEBERADTRTOERICENT /INEOEMEHIBRELUERF
DEREBRSIZTDH. A—F—A3—T1—RADHEFXRTT,

D

BNt

1)
BN
]

i of

| ———

mf

DARATLNSIYIIE, TIHILRTIEFRTOD IR TRTIN, CORT/IFERTRIE
[Ea— (View)IPTOXTFLRSYS (System Track) IZEIRLTUIYEZONET,
RERDGZE . DATLINYIIFMHED 1 FLOERD LIZR RSN, BETFE
BTEMN FIVIDLICIVARARAUA—EBBESEHERERICHYVET VAT
LESYIDRTENSDIFFEEE—FZITTT,
TIANWETOYRT LISV IDNRRSNBVEIICT IG5 E . TREHRE
(Preferences) IDT£#& (General) IR—UDIEa— (View) o2 avIzH T H
RIS HMU AT LNSYI%ERTR (Show system track in new projects) 1%
PYBZTHIIZLET,
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DARATLRNSIYIED)VIT HE VAT LMY IMNERIKEIZHEYE T, [Shift] %
LMD /N D LIZHEIL AT LNV IED DT HE, BIRGEZLITS
CENTEET  VATLINSYIDNERENDE. VAT LNYIDOHFE LU LEIZE
MORFIMNRREINET  FBREGE O QI FEIBRAR 2 GRICIE S AT LS
YO DFERGFATIHEESINDIT AR TDAU R IILAV D EFEERT HR200H
Y, Ffz. VAT LISV TERLIZN DI RED/DEEZTDRD/NERD R/
HMZEEATEIRIUNHYET,
DRTLNSYIDRTPIZ [AlY] FHRTE CRATLNSYIIZUXLT)YREDRE
BICKHLCI=TUYRSAUNRREIN, [Alt] ZHRLENSLRTLNYIEI)YIL
TRV I35 INETRND—EERBIRTEE T, BIREITHS L /NETEMDERE
FE#kIC. BIRGEOEIKICETN T NEIBREE FFEIROREIVDARITIEINET,
DRT LMY DBRT—FHGELEDTY  NEOFARL, Y RT LM YIDER
EEDEAVALYILAVED TR TOEFDREIREVLST-. 1 DOT7 I aVEELT
THE BRIIBBREINF T DRT LISV DERIE., thDBRETHE-FZYLA
TOREUIYEZ YT HEREICERINET N R—PEa—EFvL—Ea—0D
PYBZAICE D TILERKELSHIFEINET,

F—kA—3>
Dorico 2 . TURE KXY MIDI A T4=aF7RaArrO—5—DHBEEFIEEITH
St=DFLLVY— )LEEHLTOET , ChICIYBLET—FOMEENIRIRSN ., &
DEBICB TG kDERIZEFHEZRTINDELYET,

L) 2 Con moto moderato in 2018-0% #lay mode

& I 51634116 K

Dorico 2 /N\—2aVBRE 93 R—T Steinberg Media Technologies GmbH



Dorico 2 /N\—2av R

@ steinberg

B4 LISV BEE—FDAIRUTFARTLA DR ERIZR TSN DS LMY
STl TOS IO OTURERETEE T, TURDYT ST ALBRRIZENT
T BEETURERFBRIROETILELT RRICTUREERZTHIHEE 2 AME
DEOEEELTERESNET, EEDN\VRILEIYILTRSYI T 5L, ZORK
LA DTFURERECTEET , TYRKALH— DRI NSK TR DA LIE
BEREN, ZORIUDTUROBEME T —F o BONETS,

B4 LISV TIETUREREOFRERE TEET  WEY—ILTIIVIEY Y
LC. FROTUREEEEEAHET  TIORRIVEWEZ - EFRICBBSE D
EEBOTURERE—EICEEADET ., TUREENMERS AHE L. UX
LTYYRDBEIZEYRTEINET  URLTUYEDEANNSNEE ., IHRERS
VIR TS BIA R - L E RN A TR E B O A SHYETS,
EYKH O TERH BRI ELE R T BIZIE. A Y—LEERLET . &
&Rt T 2HRAULES v ILTHD, BRI T DR T HEBETESYILET,

BEE—FRICBVTREY—ILFLESAVY—ILTEASN-TUORERIE, X0
TENRIEF DN ERDNEH D EERTHI2O. T IAI L TREE—FTIEAARFELT
RTSNET, ChoDTUREZHNRICRMIEHIGE . BEE—FTRIRDS2. 7
ARTFTANRRIILDITFUR (Tempo) T IWL—TI2HATTHFAS (Text)1TO/\T4%
BELTRRSEET,

BAEE—FCTURERZHIBRT AIZE, BIBRY—ILEFALET . F1LNSVIA
DRALE 1 DFD9)vIT BT, FDTUREENEIBREINET,

MIDI A kO—5—k5v0: ENENDAVARYILAVKZ, MIDI avbA—5—
TR RET A-ODL—2ERRTTELIIIHYFELIZ, SDECARRTED
L—2lE 1 2 TR, CATHEHD MIDI avbO—5—DT—42%ER T
F9,

MIDI > hA—5—L—2%RRTDICIE A—bA—230 T —3FERTHIUR
R LAV RD RSV IANYE—IHit=ICRBINR 2L E I LET,
AVRARGILAVED TS TIT. EDAVRMYILAVKNIBT HL—UBRREINFET,
AURA—5—L—2 DIV IANYET—DAZa—mb, T—3%ERK TS MIDI OV
FO—5—%FRLET, YUAMIIE 127 D MIDI A>To4=aF7RXAVbA—5—
FTRTINEENTVWET , T—EDFT TITAASAh TSIV A—5—[E, A=a—
RIZTRAYRY () TEHLFIFENET,

MIDI AV rA—5—0DF —bA—2a30 T —EDERRIZIE ZA L IVIDTURE
BEERTEDOEELY—IILAERINET, $nEY—ILIFE L DRAUEERL
T IV N —EDEHEENSVITHIET VAL )IRDREITEIZE
BORAVEEZEADTFT . SAVY—ILIE 2 DOEDOREIZHROHSMN TERMIZ
BITTOREMERLET, HIBRY—ILIEBAFEDRA UM EI)VILTHELET .

94 R—T Steinberg Media Technologies GmbH



Dorico 2 /N\—2av R

@ steinberg

MIDI DEZHL: MIDI 7 IILEEEHT LE M/ LMYIE LY MIDI avka
—S—,SYIICEZRAENT=A — A= 3 ARVKITRTIFPAILIZEENE
ERS

TAI4Y

TAT4P L TRETHIEVSIERDAZ)TENOETEY . A — 7 AT DIRE
FROEETE—BILGEETY . NMAVUTOFERNRFIZZNTT A ERLL
IOIFTEBYER A REREILIVUNDER, FEAFERBLGETHERASA
BIEXBYET 1 DDEILAVEERD/NSBEILAVIZHTT. ENEID
AERICECET DLITRY, RUENGEELEFR ., TRIIFALERICIOREA A AL
ERYEYS,

L -

|

(.
1y

3. |
iy “

hilll

——
=i

F .3 I
e —_

f

TAITATPDINE—D DRI, HEDREEERY I DT HIBOTRBFET
BYEETLI=AY. Dorico 2 MBEDTA T4 D=HDFHMEEEIZEKY ., ThidESIN
iL/T:o

RNEBEICHRBATEE. RBIETESIAVARILAVMI T T4 0%ERL. EH
TERERDBE. TNTNDERICHETEINILEEELET . CIHBLIE,
Dorico AEE TINLDEREEELFET MR OTIL—LRYYIZEWTHRET
BT AT4To I AV DERICOVTRIEEZTEOIVEFHYER A T4 T4ON
HHEZ D& CRAIRE (IR T 535G . Dorico [FMEICIHLTETA T4 DEE
[CA=VUDBREBHNICKRRIEET, T4J102023V T LIS, byy
TANDETDIETEERLET . BU Dorico N2 B TEMERDHEIRETT
HWET,
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TATADEERT D TA4D40E. €230 TL—V—DEETHA XYL A
UMIBWTOAMERTEE T VATL—V—IF 1 ADEZEEERT S50,
CDAVARRYIAVREREIT B EIETEEFRA — A I avTL—v—IlEe
ENRILEREEETTHEMOANBEERT 50, NEITEHIENTEET FR
DTAT1PEERT BICIE. T4 74P DRABRAUNERIRL T, TEE (Edit) 1>
Mt (Staff)l» [T4JI4P%ZERE (Change Divisi)JZRIRLET, L TOEA7
O RRFRSINFET,

> Change Divisi
Divisions
4 Solo2
& Solo3
A Solo4
81
LrL 2
L ||
Staff labels
Q[ sieffLabeis  + | A (Nove) v| #Flioop [7] A[lc‘_?"’ [2] a3 Q.000t l:‘ ) oif!% ™
I:.r,:m ccccc - HE—::guar v | [ 0.00pt :| i{cmml H E.&L Ll
Solo 1
showsaconumter: | Y v T i |

| —

FAT70T LEBDIVRNIIE. §HET1T1PavhRRINET  FHRICT4 TP
EERTAHEEICIE TTuttilEWSSRILDTaI4Pavh 1 DEFTHEELET .
TAI42aAVDYRRDTIZHBT I avN—nib, YIRS EUEI 30D 2
BRATDT4T42aVEHBITERTEE T, VIRNEEMT B2 VAT 11
2av#EM (Add Solo Division)I/h2> @ ) . EVlavEEmMYsIziE&
92avDT4T142a0%EM (Add Section Division)l/h4> @8 ) #0vIL
F9 . BMLIEVIRAMNEEEI av EEREThRaTIEMSNZERICHIGL
FT, ERTEDVIRNE LV LAV DBIZHIRITHYE R A HEEE TESE
(F U T I DERERIZEDI=HIZ, Dorico [FT7A—FDTL—VY—DR#HEHZFE
A NERENENFIBEL TSI EFRHIRELTULVET,

TATADAVICRREINTVNEINILEEETHICE. FA470T LHDIYRAS
T4 423V EERL, TOIERSARIL (Staff labels) £ 3a> DT XA 4R
ELFET, U230 IRN)LIE, BHBORBME. 723V DERDOICERICE
TSN, BEIFEICESN . BEICE O TEITILIZRYNEFERLT. EOTRIFE
IETL—V—DZDEEEEEZTIONERLET,
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FA7RYT EBDT4T42a> DY A SBEET E2EHD TIP3 ERBIRLT
[T —T%EM (Add Group)lR4> @ ) #9)voTdL. 0 avEILIC
TIN—TIFEDBELTEET T IL—TIRNNIFK T IL—TleEnt=T1J14>3
VICBT AT ARTOERICHTEHRR[ZA T, AVRMYILAVREDAEIZR TS
NFETTIL—TIRNILERETBEE. TTAF3—DICLIZRRESNEREIVE
FERALT.TEXAH# (Full Name)l]&ETBEFF (Short Name)JZE R ICIRETES
ER

®EIC.[T4940%%FE (Change Divis)IZA47AT DT EIZH B TL—v—
LEIZT IL—TL%ERTE (Show player or group name)lBLUTEHLaVE
B%®R (Show section numbers) DA T3 ZEFALT. CDTAI4PTE
FZSNDINLIZHL, LATIORE T a0 nlgEREMER (Staves and Systems)]
R—UDERFEIZHKS (FFLavIZHES (Follow Options)l) h. EICTRTIES
(TRR (Show)]) FLIXEIZERTRIZTS (TERT (Hide)l) DLWFhhTHTS
LAVDEREELEETINEIRETEET,
FTRTDEENEOSEZIOKIZ V) VITHE, TAT14PDEBRNMERSN .
ARBRRSNFT  CHIFREE—FICBVWTIVRARSYTEEE [Al]+<)[-]
LR TATACDEREEZRTIDMNEZEETCEEFT . TA T4V DEETER
NI VIRRB LUV IV THRESNEBMOHERIL. MISTEINILHHED
ERIIZfFESh . DR ENSRIRINET . TAT(PDEELYHIICA=
VUDINRFE TN D—EHHDIEE . FIL{TELTRTDTA T4 DFERIC
X TAIAPDEBNBHAIMBETI=V VDERINBHFMNICRTINET . HE
EFLNT A4 DRERIC. BEDEREAFRICEREANTHETTY,

BEDTA T CDEREHRET D BEOTAJ14PDEREHRET HICIE, T
TAEDAAREZTTIVI)IILET [T J4+P%ZERE (Change Divisi)1¥ (470
IHRNTERETRASLIICBYET . T4J40 I avFZHIRT 535S, HI
BRI DHNCCDERICESN TV EFIFBIBRINT . BEBISERINLDTE
BELTESW B3V ZHIBRT BRIIZIE, HIRRRELDTA I DERINDT
RTDERFHIRTHIEESTITOLET HIZ, UETH =TIV ay
ERMOBERLIZGE. IRXNTOFRIETINET,

TAI4DAVEEET D TAI4P0DN\yE—CFSLIZHENTBIHEE. £2E T«
T4 D—EDAEERDYET HIGE . LREAKROFIET, MG HIGFAICE
BIEATATAVDEREERTEFET  MBRICRREINDERIL. TOHEE TR
DTATACDEBRTERERINZLDETHRFSNET ALHEBRTEISHET(4D
ACDEBEERTHEHE. TONRITROMBEDFRIRBENSRNET,
TATAO DI E—CFRT TS TAT4PDN v E—DFRT I HEEF A
ERETRTHMEDEMNFLITARFEZERL. R (Edit)1>TFEFE (Staff)I>Tk
vy T1%HIT (Restore Tutti)IZ&IRLET . ChITKY . FAT7RTERTT B
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L by TADEIIY L DEFISEETIHICD T4 T4 DEBEIER
ENFET COEENHEOR THELYATIICHIEE. T DEREMHEED
BRTRBEOMICHZ/NHEIE/NEFO—EIZ. BBMNICIZV U OBEFHNRRS
nFEY,

A=V E—D: TAIAPDERTIA=ZV U DBREEIRT DL A DEE
R.ESICFMD IR TOTA TP DERICHIELEFINBHREIZHYET,
COEREENHETILETET . T4 DDERITMALER T OT A
TOERDELEFICRBENET,

A=V DIy tE—DFHRILPTKTBIZIE TEa— (View) T EFERFDHS
— (Note and Rest Colors) > F442a = &M (Divisi Unison Ranges)]
TREVYBZAONET, A=V O/I\vtE—JICBT 5B R PRFEENIL—T
FRL. EEDTAIT4DITITILERFLPTLLETS,
ELY—RDEREZHEHRDEBRICRTTLIDTEHGTNETH L= Dorico A
TATAPDERIZAZ O OEFREBHRTSEDRITHRA ST TITILOELEIC
(FDLIEDNYFIRNHYET , CNIETA TP D NNy E—TU DT HHTEEHH
EBOBRGIE. FETAT4P DI\ vE—U MR T LR EGHMEEDRKR T AE.
WIFRICBWTERBRTT . T FIFoNSFIRIGIRS—ICETEILDTY . T14J
AP DN E—C R BRIRICHIZDRT—IE. T4 DERICIERTINE
HA SNITHLT BITIE, TaT14PDINvE—D DR EEZ RS —DRREE
EFTRISE. EDEFETAT4VDERICFHTIE—TFTURR—RLFT . [
BROBENTRICEEFELET . £, V93— TRIEAMVDERICLMERSL
FHAD. BEfEMREBEE (NTEVRE) [FEEBICOEINET,
TATAPDERNSA=J VDI TUTILDERICRIRAVMNIENT, A2 D
EREFELGLIEHESNEASNTLSIZE. Dorico [XEYGEERSEZTD
AERICEHEMERLEIN. ZOBE. TOERDEFLEDAR—IUTMNAETESIL
DBHYET, ATRETHNIE, AU DERERLE LS ICEITTESLIIC. T4
ADDNYE—V DR TRHBEIYATOECNICEY L EHBOEREZHRAL TS
LY,

TATADEERIRNIL: LATOMFToarplEREME (Staves and
Systems) IR—U(ZHBHIHERSRIL (Staff Labels) o2 avIZE . LATD 2 D
DFE=HEAToavNBMShTVET,

n FIL—TR%EKRE (Show group names)JIE, REDL AT ILTERSANILD
EXBHEBMOVNT AN FEIEAADNRREINSEEICHESTVDIGEEDH
BMELRVET . CNDF U DEEE AVRRSILAVREITHOOTTAT4PD
TI—TIRN)DBRFEINET

= BH3VR%EFRT (Show section names)JIE. TA T4 DT IL—TLd(>

ARYILAVRBEIMNRRENTNENEINMEADLLTRETEET . COERED
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HBRERGELTIE IS—bLATITIE T4T42 DRI IVEDERT
FHETH BEOERINIVEBELGWMVEENHYET, TIICHIERETT
RT (fz&z () Violin | ASERTZIENHALHTHY. ERINILERTRLTE
FRGEROSMAILEMINGVGEEREICCOREEFERALET,
COATL AV DHEE. [T1T4O%EEE (Change Divis)IFAF7RT DI TL—
Y —RE-IZHTIL—TL%ERT (Show player or group name)IBLUTtH 3
VE/EBERT (Show section numbers) AT avIc&ky, T4 DERTE
DHFRFEICEEEINFET,
TAT4PDBEE: RV —RATEH. TA4I4PDOITITVET AT VIRLDIT
DT ILEEDHT. 1 DOFroRILTHBESNDH. Bhd /i avBICHERSN
BEEIBRESNTILVET , Dorico DEHEDV)—ARATIK. T4T142D/\vt—
RADEV)ARELVEILaVEBRIOF v RIVIZEY S TT, T4T450/ vt
—COBEICBVWTEN - REMERETELLIITTEIFETT,
R=RWERITEFET4T42: R—ALDEI AV TL—N =TT T4 D%
A9 55 &. Dorico (T4 T4 DIy E—U W BRSNS EROMEDKR T HIE
(<. S—hREIDRENEBEBMICRTLET

A
A
s Bhe—e ot 2 [
o Y
a D(.'-O. S. a DE_'-O,
A
2
ANI V) L7/ |
Ke) 14
fac - tus

FTAT100v— OB RDOLBEORTHETIE, T4I4PDERTNTE
NIZEKEARTEN, RYED 1 DOERIZSUA—5FELET,
COHEEEERTBICIE. FEF T3> DI T4T42 Divisi)IR—DIZHDHIEEH
HERDMERRIGICH DT T4 DIET (Indicate divisi at end of system on
vocal staves) AT avEEELET,
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FviT7

TV TIERED/IvE—D DO DOYITERLTHIWVWRE /Ay &—CFRLET,
hE, EMEEERICER T HEOFENHER T OO, REGLHMBOER.,
HEIWEKVERINBEZLEN—DaVERTTDLSILGHBEEICFERINETS, Dorico
2 XAV T DN E—CFNIEBET B0 D BB HEEEEZEALTVET,

— 8 —

 EEE e——
ossia e ate o

H : A‘J'T’l"-—
e =——re
- o

TV TEEMT S AV TEEBMTBIZIE. AV T DRRER TS HEHFEE
EIRLTHSIMERESE (Edit)I>TEER (Staff) > TAYS7ELEIZERL (Create Ossia
Above) |E =& Ay P& TFIZ4ERL (Create Ossia Below) & #IRLET . ET7/
PZDOMDKEREERT DA RAYIILAVDEEEERLTNT, LTV H
DERERTIT DAV THRETHLIGE. AEFERLEFEROBADYT
FILEERLTH D, Ay 7ELEIZ{ER (Create Ossia Above)lFzf=(F Ay
F7Z TIZ{ERX (Create Ossia Below) Z:&#IRLET,

AV TEERTELDIE, VATL—N—NEETEIAIVRAMYILASDHTT 2
93V TL—N—hmEERTDAURMYIILAUKIE, T4 IO DA EEBRNTIIEE
ROEBMEIITEZFEC A RFRIC FTEFXTIRDARARYILAVMIZ AV TE
BMTEFEEA AVRRIILAVMNIFIRBEICIIGCTETOWThOBICEA Y TE
RACEFETHEROBLCAICIE—EIZ 1 DDAV TULORTTEEE Ao
AV T DINvE—C DRBME. BLUF VI TOERIMNEASR THHEIZTHA
FARTRENET ChODAARIL, RBEE—FTEIRLTRSYI LT, (&
[Alt]+[]/[-] TFHYPTEFT  HAREEBIZA VL T DRRGI B S LU TE
LBBLET,

AV T#BIRT D AV T DN E—CFEIRT BIZIE. AV T DI vE—DD
MG HDITARZHIRT 2D, FEA VT DN\vE—DAQOBEFEITKFTE
BIRLT.THRE (Edit)>THlER (Staff)-TRZHIER (Remove Staff)1ZR#IRL
F7,

AV TEHIRT DEIE. RDIA VS TROBZHEHIBRLTOELRY &, ERF(E
HIZRREINGLGDE T THEERILETAILITERL TSN, RIFERLAE
[ZAYITEBERT 5L, BERIEIBURTINET,
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BE TIFHIITR AV TOERITBEDERD 2/3 DRESTRRINE
T, CDERE, FELFTLavDIEER (Staves) IR—DIZHB AV T DEE
(Ossia scale factor) | CHREICEFE T,

FYOTHIRREINDMAEBEZRET D TIAICTIH AV TDERIETATO
LAT INIRRENET N TV TEREDRED/A—I AT INIDARTY
BHIER, AT DHZRERT HIEDIFINEY LS IHEELHYET . LAT I
TV TERTTDINEINEERTBICIE BEIZKHLT. LT IAETard
Mgtk L#HEX (Staves and Systems)IR—SDIF v 7HEIVBMDH
(Ossias and Extra Staves)ltoav(ZhbIA v PERER (Show ossias)lZ
FUERRIEATIZLET,

INETIREHE R AV T DIMNIRER ST DAV DERICEDKIITHEE T DM
DNTIE, HIREN TOSEETHERASN TV ASRERUNAVONEELET A
VOTDRBE SR TVTNE/NEHIROMEIZHHEREL T, —#DH AR
TV T DFIRNELR THEDHAZAMVDERICHEESEFIT ., thDHIR
HIFRTHEDHTRESE ., SOICHDHRIEA YT EA L DEREE ST
(EESEFEA.

FTVIT AU DERIHEESELHEE, — MO HRAMISMDERICERTLIDE
EICHEEED/NETR (BEITHR) ZEALET . O ERAL I D YIZEERD /N
B CHYTERASEET,

Dorico [&. SnoIT R TORERAIEE T E=HDA T avE, EBEF Ty
DIINEER (Barlines)IN—2(2HBIA Y7 (Ossias) 2o ar TRELTWE
ED

TILT AV ARSI AV DAV DERDEICRRENDIZE. EAEET /D
BFERDOTIZRRINETYOTREK, HFEA T a0 DNING#R (Barlines)l
R—D DA T avOFERABITHADLT | BITAMVDEREFEL/NIRTHES
EnFEY,

VST DINII: AT DERDEFIBAEossia] EVSHEEEDINILET 5
FTRIZEX LATIMETar DIEREMB (Staves and Systems) IR—T D
Ay 7HEEIVBMDER (Ossias and Extra Staves) | EoavIz&H b4y
FDRIZSR)LEFRT (Show label before ossia)lzAIZLET , HRZLFA
IWEFERTBGEE. [y PDSR)L (Ossia label)jZTHAA L (Custom) ]l
HEL. [HRBLDA YL PSR (Custom ossia label) JICEEDTFAREA
HLET,

VLT DINVIGHERINIVDINSTSTRZA V> THERESh, HEF T3
VOIEER (Staves)IR—UIZHBHIA YL T (Ossias)l i avIcERENDIE
BEICRSOTEREESINET . 1 DDA VI TERITACGNILE, RIEIITRT Lot
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AV TRERICHGRNIVIZIE. TN ENERICERMERETEET.
INF DB D CTRBERIER T I 2497 Ay T7HNEDRPTRIBE X
T3 51545, Dorico [FEESNITUTILDEGICERBEMITRELT, BHF.
RIS ES. TR TOMDTAT LT YO THEROBR T AEICEIZHEELELKS
ICLET . ERBICHITRITERBORSERAMISICIE. FEFTavnlER
(Staves)IR—T DAY F (Ossias)l o avIiH by THRBHBEDER
BOEER (Extend staff lines at start of ossia)JBE LU TA YL TPRTREBOHE
BOEER (Extend staff lines at start of ossia)J#ZELET .

HEEFCAYIT: AV T7HHLMETHIBLZDROMER TR T TH1545.
BEOEREEKRIC. AV TOEMESLASEHBEOMBLETCHEEELZZ
SNKWEEDRHYET, —AT. TDAYITHEMD ARG )L AV RTIFAEL
CEEHAICT SO MBORBUENDERRESLVAESNSHIEEINT
EREEMOENST VO THABRTIONIFELNVGEELHYET .

Dorico [EWVFNDAELAREELET  LAT VA Toav IR EMEE
(Staves and Systems) IR—C DAY T7HELIWLEMDEEFE (Ossias and Extra
Staves) |2 avICHAHTHEBEZEFCHA VI 7 (Ossias crossing a system
break)lZl X BHEHNIEEEEHS (Include in preamble) | F =Xz T E
BDEEEZRI 95 (Exclude from preamble) JIZERELFE T,
ERDAR—UT FYITERIET DAV DERED T IHILEDIERE L. LA
TorATLa DIEBRODAR—I VY (Staff spacing) IN—2IZ#RERSN=TAY
STHRRHHRFET (Ossia staff to staff) IOMEIZE>TRESNET, COIEE
(X, BEAMOMEIHRIZ DEEEZITEE A

BERIDF YL THRREINNBTIAVDEREDEHIE. BEELY. FEE—
FCRERDAR—L T Y—LEERTAHLETHRE CEE T, MR TIEERIZ/ N>
FILORRENFETH AV T TIEHE LAY THERORBAEIZ/N\VFILA
KRSNFET,

oL TEBE: AV TERRODBEFEBESNEEA,

ARG AV DHEDBEEET D

Dorico 2 Tl&. ZH—DEEDRAUETAV R LAV DREREHEITEBMNE
FIFHIBRCEET . 2EXE E7/DEET 3 DFLETILULDEREET S
FOLEHIER DL ATREICRYET,

BIMOEREERT S AVRARYILAVMIBINDEREERT HIZIE. BINDGE
KROFIAMET. ZO LA TICEMDERER RSV EROFTREIIARF
ZEIRL T, [RR (Edit)I>TE8&K (Staff)1>T EICiERZEM (Add Staff Above)]
F- XM FICHERLEN (Add Staff Below)Z:&RLET . FDOMEIZEMDEE
KOMERSH, BN (F=IXHIR) Shi-EROBETRTHAENRTINET,
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AVARSILANEYATL—N—D3LDTHITNIEGYFE R A, I3 TL—F
—WNEET DA VARIIAVIDERDOBIIERTEEF T A T, ITESEZT VLD
AVRARYILAVMNZBERITEMTEEE A

EMOERZTHIFRY 5: BMOERZAHIRT HIZIE EMDERNRTSIATNS
FIBOHARERINTEH. HIRRT HEET. HIBRLEWEROSTHE(EKTE

BIRLT.MEE (Edit) TR (Staff) |>TEERZHIBR (Remove Staff)1%ERL
FT . CNIFAVRISIILAVEDIFLODSHDER. ERAILET/OEFFIE
EFOEROHIRICEERTEET (L. AVRMIILAVNIBT 5T R TOH
REHIBRTAHILIETET . EBIZ 1 DULDERSRISINTVETNIEGYFEE
Ao

EMOEROFIRMEZEIRT S BRAMEBEORPTHRIAE IR T THLE.
CORERTZLIIETDMETRTFITERTICSELNGESL, HEE2EDORS
TRARSEEVWEEEHYET . CNE. LAT7V T Toar IR EAE
(Staves and Systems)IDT#A YL F7ELVEMDIER (Ossias and Extra
Staves) |V av(ZEMESN-IBBRFE-IIELFICTEREEEMDOHEE
=~ (Show extra staves across full system when starting or stopping)l1¥F=
YIRYPRATCERELFET

EEHDEREERTIZTS: A1VRAMYILAVMIERESN-BMODERIZ. LT
AT A DI#EBDAR—I VY (Staff spacing) IN—JIZHATEHO#E
FRHOAVARYIAVEDE R DHEREIERZRIZTS (Allow individual staves
of multi-staff instruments to be hidden) |+ 73> DOEEEZTE L A,

P S D R T

AT A FFEIE. FICEEBICIXIEESNGMINE BRI HEEEREICIERT
BEHIZERASNET , FEDMANLENRS Y aE—BIZ AEEETHINILES
BIT—ESNELBRINFET FENH VRSV alE—RBIC ERTHREY
ALIFIETRENDH, BRICOVWTIHEFIHEENGNERIRINET , BIEILRSY
Taftig. BEBFVAIVIRELTEENS5ELHYET , Dorico 2 (F,. 2D 2 D
DRAZYYAFFEIZDONT, BEGYR—FERBLTOET,

ATy afilE: ASYVAMETEMYT 5 —FHELH XL AoV 1 88%FEHA
THIETT . ATV AEEEFERT L. MTDEEEZ RSV A TEHLHIEN
TEFET . AILGHRFETICHST. ATV a2D) X LNBEEIMISRESNET,
A, 414 DIMNERTIE 4 DBEFDATYY 2 4 DHARTEN, 6/8 DIFEIE
TR 4 RERORTYyah 2 DRREINFT IBFELBEEET HLE, BER
DASYaDTaLb—a i BEIMICEFHFINET,

Aoy afalgiE, 1 DU LED/MHEEIRLTH G, TR (Write) T RSvS 248
#{ERL (Create Slash Region)1%&:#IiR3 B, [Shift]+[R] THEEEDRYTA
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—/\—%BE. Tslash]&EA AL, [Return] ZHLTHRYTA—N—ZHELET,
BIRLET21L—2av OBRICRASYY A fBEMERSNDEELIC, TITHILLT
FRTY1DE RN RBTHEBRRIN, AV AN BEO—HTHLLE R
LET (CNEEHICTBICIE. TE2— (View)] » RSV a1 @fHZEREH
(Highlight Slash Regions)1Z&#4 2IZLET ) 25w 1 4B DRI B L& T 1
BIZHDINURILEFERTSHE, BEOmMIGMNSEEEFLF-URHI-YTEET,
Fiz. [Alt]+H[«)[—] TRV 2 EEORRRGE D E). [Shift]+[Alt]+[« ][]
TRSYVABEOTaAL—2ar OEENTERAET,

RV ABEEREIT S EAILEBORD THMAEEREEETALHLE . RS
v aElEE 2 DICHETEHIENRELRIGEELHYET CNICE, FrLvbeR
RIETRIY ABEER BT AUEBICBRESE. EFY—ILRYIRDIEESHY
— Iz )T BN [U] EAALET A5V aBEAFYLYMIET 2 DIC
REISh . LR FRFOBHDOBIBMED/N\VRILERICRSYT §5HE AR—
AEHRCEEEDNBERETEET,

AU aBIEICHBITA 4R BEBRFREBIIBVTIE RSV Il RERRT
SMEIMITDODNT, SESFLGRERAMNFELET, Dorico 1&. TI+ILFTHE
EAFOTaAL—2aV DAY AITIF T RERRLET . 12FZL. COEREE. &
EATa DIER (Notes)IR—UDIRSYL A FEE (Rhythmic Slashes)]t
9 avIcH A ESRFICETHAS5YLa (Slash regions in compound time
signatures) 1A 7L 3> CEBETEET,

Ay aDHER: Dorico IZIE. ROV ARBEONRT FAUNKIBBEREINT
WET, ST, BEFTTavOIERF (Notes)IN—CDIRTYL 1 FFEE
(Rhythmic Slashes) 19> avICHATFHFRERHYDRXFvyS 1 (Slashes with
stems) |ETRBHELD RSy a (Slashes without stems)1ZFRET A &ITLY,
BEDTHADRNSREEDNBEERTEET,

Aoy aFEREE: RV aBE&SYLFERLG) X LDIEREETALE K. X
T A EEREFEALET . ATVDAEFEICLDIA N ZEDFRIZELS
ANEFSTKRILTY  F=fZL FBELI-BREIATLEEESI, TIAILLT A
ALEEFOHMEONIDYIZ 1 KORZYLANERDE 3 BRIZKTINET,
BEOFHERATY AMEFMICER., BLUVZOHBITHEAET . TOERFOM
BOEYFIIRESN, BEOFHICRLFRICIEERSINES,
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ATy AFEFREOERDOANEHRICEIET SICIE, TR (Write) IMTRTvD
a{+EFEEIER (Create Slash Voice) Z:EIRT ZH . [Shift]+[Alt]+[V] (T4
JLR) AU REAALET . COaATURIE. FRICELEDELRZEMT S
[Shift]+[V] 3 RERBLEUZGE->TNET,

[Shift]+[Alt]+[V] O FERYRLANTHE BMENDEZXTV 1 FZFEHDA
AT FEHYDRASY 2 (HRZEZLRAZ). REHYNDRSYI 1 (FERETH
). MELGLORZYVADIETUIYEDYES  BEDFMERR. FvIvbDE
BlDA o —2—ICIFINDDEBIMESNSFEHOBENRTINET,

ATV ae—BEANTHE CORFYVAMEFRIEEDAVAIILAVEDED
[CCHLHEFERTE. [V] THEEHOUYBZAZITEIRICIE, RSy aFEFERLEIR
RICEENDLSITHYET,

RSV aAEEFHDIMTEEET D AoV EFEICYXLERESIREEA
ALERIS, FEAIEFREBELORSYDAITHYE R -GS X X5y am 5B
1 DZFEERLC.TRE (Edit)I>[FE (Voices)I*TRXFvL a8 (Rhythmic
Slashes) INoFH LT EFMMIAMNTERBIRNLET , YT A2 — M TBEOEH
(Normal Notes)IZ:#IRY D&, FEBIIIFEDFRICEmEN  EFOME A NEF
DARXDEYFHETINET,

AU A BEIZEVTIK BEFONTAODRT Y aF - (EFBHREMNET
PMEVWTNAADNUERILEZRLTHS, TANRTA DI RSy 2888 (Slash
Region) 17 W—TIZH AT HREL (Stemless)|TA/NTA4EZAUIZTBHIET, R
FYVADHEHYERELLEVYEBAONET,

HEDAMZERTS: FEHYDASY AICEWTIE RSV atEFHOT
TJHILEDREDAAE LAEICT AN TRAESICT S0 BEDFEERLAET
EETEET . HRE (Edit))>TFEE (Voices) P HRET I4IITLEREIZTS
(Default Stems Up)IEf-IEIFEBETI+IFTTRAZFIZTSH (Default Stems
Down as desired) & ZERLET

AU aBEIZEV T BEFOVNTNAODRTYL 2 F - EBREENET
BT NAHADNURILEERLTHL, TANRTADIRSYL 1888, (Slash
Region) 17 L—F(2HHTEEDORZE (Voice direction)ITANT1EFIZT S
CET.REDAREIEETEET,
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ERHNODMBEEETDH: TIAIITIE RATYD 2B ERTY A FEFRIE
WIFNBERDE 3 RLEICRZY 2ZRRLTVFET  EREDFEF LT LD
BLFIETERTEET ., ThENTRSYL 14El (Slash Region)lE =X FH
ERFF (Notes and Rests) 17 IL—TI12HBI A5y aDEIE (Slash pos.)170O
INTAEFVICLT. HFETHEERELFET, 0OIDEIFFERSE 3 RISHEL. T
SADHFIELIZ. IAFTRADEFETFICAIY 2 Z2BHSEEFT,

ATV ABEATE DR Ry AN DERP THRIAEIEERTLTLS
BE. ZOMFDORYDBRERFTIEDIRENEIMNE MO BFFMNERDR
CREBICHEIMESIMNIESTEDLYET , TIHILLTIE, RV BEIEHTED
HFICEBVWTRRE LN ERFTIEO LS ELET . L. TANRTFADIRSY
2 a1 %El8 (Slash Region) 17 )L —7(&HATBIREE LYETOKRFEIERT (Hide
rests before start)IEFUTRTHELYEDKRFELIERT (Hide rests after
end) T aONTAEA T HE RFORTEMNMFITEET,

ROV atEFHERISES: RSV aFEFHMDRSYL atEFEE:
(FIBEDFEERE R LT HI5E . Dorico [, RSy affEFEHDT I+ILEDEE
FtDRBEZLEEELT.2 DOESHILEEIRFEELGNVWKSIZLET , TV aft
EFEBOA T YD AR—RIE, BBEA T aV DIFEE (Voices) IR—UDIRS
A FFBEDEE (Rhythmic Slash Voices)1Z IL—FI2&H 37 T avIZkYRE
SNFET,

Aoy a LEETRITRS TEB/TIYNTRIY AZFERATHICIE, TITEFXVE
##m% (Edit Percussion Kit)I# /707 #MAEET BREE—FDTL—V—/
RFILTHESRIL—V—DH—REREALT. AV AL AV EDIAVTHRRNAZ 2
— DB ATATEMEET )5 RELTAF—TDT I3V N—DRFYaR4E
Y2 BOSHEVWIT MO EERATAZET ITESRFVMNIRESYFLEIFELLD
RSV aFBMTEET ITEBR T UM 1 DUEDRSY 2D EYREEMLT,
RGO REDMEICERETEET .

BROAAIZEWTIE, RENF—Z#FALTEFIYNRDELGDIIUR Y ILAV NEE

BB B, FUMCBMLERSY 2 THNET S THBEICSEN, TEBF
IO EHDANEE A RBIZRTVL 1 EANTEET,

TERIIFDRASV AL 5 REDRRIMTERAKOARTEINES , TUIF
FEEEMNDADRRYILAVCDRRIATITUYEZDE ATV aldRREINE
TA,
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N E—RES

INYE—REES X, BID 1 /&R, 2 NEEIE 4 NEIICEFENSEREE 1K
FICICHRYRI CEEEREBICRLFET . COBBADORETBEREICES>TERIC
ERGEDTY  ERNHICHO O TERSNEDFFESHIN TL DL DILFHEH
Dol RYITEANMEYBRSNEERNEVNEIIDHERSBEITHEYET A,
INEVE—IEBEFERATHERAPIRY ., BYIRL TSI ENBABIZHhMNE

9,
T T 0
-

INEY E— Bl BRYRLAREGLHEFEANLIZER, ROPDEIHASIEFEY ., /INET
NJE—FEESZRTEIEIHBDERDOYFETERIRNLT (CIIFRIFEEETEEY).
(REEE (Write)>T/NEIUE—EIBZ/ERX (Create Bar Repeat Region) Z:&RL
FY . cOFIEIZEY  /NEVE—MMEEMSERESNET , 1 /NETYE—FEESHMER
HEHEELAEITRTINET, LD DYIZ, [Shift]+[R] THHEEDJE—FEED
RyTA—N—%RAE. [%IZAALTHIO 1 /M, %2 THID 2 /i M%41T
HID 4 INIDE—FEBEERLET
INETE—RRIBEER L2 ITRRYRU/NEBEZEE T HICE, MIVE—FE S
OLFTAD, FEBEHORNEERRICHIAVNFILEERLT,. TANT
1R JLDTINGY) E—ME (Bar Repeat Region)14 IL—F(2HAT/MNE% (No.
bars)I7A/NTADIEEZEELET,

INYE—REEIE, T4 TERNKBTEBARTINET . BRARTOL >/
A%V EZBIZIE. TEa— (View)>T/MEYE—MEIZEEEE (Highlight Bar
Repeat Regions)1Z:&RLET,

N E—REEBE NV T S Dorico [SEEIRIIC, /M E—MEID LI, #2Y
RLUEBI#MOAY b E—EMRTRRLET, TIHILATIE 4 NS EITADY
FARIREIN. BERODEMNLIEADUISINET  12EZIE 1 DOBERFDO/DEID
®I< 3 /NEIEI D/ E —MREAKVZISE . 3 DHDNEIUE—RESAT4)
ERIURENET , TIAIIDAVUNEREERE T HICIE. HFEAF T3>
#iJE—MREE (Bar Repeats)IR—TIZH AN E—FEEDORIBDO IO
n IMFIZEIZERTR (Show bar repeat count every n bars)1Z&RELET . hoY
FE—UIRTFSEHWNGEIL. TIMNIVE—FEEDAD UMD S8 (Appearance
of bar repeat count)1ZTJEFK TR (Do not show)JIZFRELET

. ;
N
N

COTIAIEDHRER. BL2O/NEHIE— MBS EIC EBETEEY, O/ T
OT/NEY E—HESE (Bar Repeat Region) 157 )L—T (% 5B MEE (Count

frequency)1FE=(XTH IV DS (Count appearance)|ZA U IZLET, (B
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RBARELE (Count from)1TO/AT4ZEA T HE, Dorico BNADI U ERIRT
LEHELIEETEET,

INEIE—RRBDHIUNDIAUS HAX  REAIWEEET BT, THE
(Engrave) P[4 FR2A )L (Font Styles)1 T, I MFEYE—FEBDAY U (Bar
repeat count)JD T+ AR I ETwRELET,
INFVE—FEB D LICRREINABMFOHMEGMEIL, FEETFTIYVRFELIE
[Alt]+ KEIF—TFHyP I HILETRETEET,

INFE—REBZY IL—TT 5 HAKOBEVLWIL—XBEEF OEEIZEL
TIE IMIVE—RREBET IL—TITBILICE>TEDREEEZTRT ENEFLL
HBERHYET A 4 NETRBOBEFF OEEICELTIE. Fo7=<RAL
200 4 IMITL—XERDFIITRERTEET,

J ) @

[V 4 s J ¥ 4
A0 F A y A
|
_I r
(&)
= J o g [ 4 L 4
B i e A FA

FIFRDESIZ 4 NEHERIZEST IL—TLTEEY,

J ) ) ) 2

s J o g7
Vi F/ i)
I r
4
H 1

HEY—RATEHYFELEAN. 1 2HD 4 IPETIL—XIE RDEIIT 3 /1
EHDVE—FESEERALTRTTAHIELTEET,

VNSV 3

.7 S 4
|
I— r

F /740
B 7
F/7 7

GI—TIUZEERIZTBIZE, MEIE—FEEEOWNIT b, = 3/NEYE—HE
BOmBmCHINVTNAODNUERIILEEZRL, ICOMFEHRIEIZTIL—TF
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(Group

every) I7ONTAEEFED/NHRIZHELET . 4 ML —XETRSE=LE
2 3 IMNEIDYE—FRBEZRTTBICIE. FEF T avnlINGIE—FES
(Bar Repeats)IR—TU(ZHBTTIL—TDORY 3 INF DS (Appearance for
three-bar remainder of group)l#l3 MEYE—FEEZER (Use 3-bar
repeat) IICERELFET

[Shift]+[R] THRYTA—N\—FFRWNT/NEHIE—EEZERTHBETH. JIL
—TIEEETEET LA TWL41EANTEE L MDY E—FEEZE 4
INFIZSEIZT =TI L T%2,41EA DT HE. 2 IMNIDVE—RBEZE 4 IMEID
EIZTN—TLET . JIL—TkiE 1 /IMET. 2 /IMEERIE 4 IMERICBLTOH
EECEET . ANSNIHFOMAEHENEITHSE Dorico A HIETLT=5
Bl TIAIMKEE (JIL—T kL) ITBYFET,
HVEVSEIBLIBELH L0, IMHIE—FEBEDT IL—TLITEEIZTES&S
[TEBL TS,

1 DISFEEDONT/NETE—REEICRBIN /NGBS O&EE K. LA 7 UM
Tav@UNHES (Bar Numbers) IN—CIZH AT BARFE JUHE SN/
DE—FrREESOTFIZ/NHESOHEZERT (Show ranges of bar numbers

under
multi-bar rests and consolidated bar repeats) 147 avaE4 (CFHET. 1

DIzFEEHENF-/IMFUE—FRBEDTIZRRTEEY,

wmEI A OEFY—IL

Dorico 2 [, RILFR—RI, THRTO—FE)Ta1—RA, L TERADEZDH
BB LV —LE  REPO—BWEEEET RN LZHOEREEY—IL
EHEIZEALTVET,

VILFR—Rb: AE—LEERER—XbTHLE BRGETHEELZKEARS
FUEBEAROHERMEEDDITILFARA—AEFRATESLSTHRYEL, BIRLE-
TATLDN 1 DEFTDIGE. R—AMERIERREFIKEDYFEAN EHT
AT LHMERSNTLSIHESE. Dorico 1. TATLMNBRSNTINS AV Ry )L A
UrOBET AHEETHENAMSBE LDER. 1 BELDAUVAMIIILAV S ED R
[CBRENF-TATLOMNE ., BIUVBREFERNDT RTDAURRIIILAVEDSE
RBIGERSNIZTATLOMBEEFIEL  BIRGEEICNFESISSEROIE—%5
UM TRYIRLR—XFL T COEHREEHLIELET,

AV ARHILAV I EY SRV TEIRSN TS5 E . Dorico [XBEYES1R
LAV RDEERE 1 D 1 DEENOR—RAMEEERLGELET . ChizkY. =&
ZIE 1 DDAV ARYIILAVIDGIEEEEEZFIE—L. CNEFEHD AU ARy )L A
UMIRITFAR—=RLT LR, BEDZERIZHINDODD AU ALY LAV RERRS
TEFEY,
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BRGEAIE—LE-ERLYEN -12IHFETH, Dorico [FERDIE—ETLH
ECERGLEDEAVARYILAVMIR—ILETH, BIRGENIE—LI-ER
KYRWEE. Dorico [FERDIE—ETLLEHMTTETAEFTEHRYRLT, EIR
FEHEMNSEAHEIBENKIITR—RINFET,

REZENTOERICBETS: WEF Edi)I-THRHELGKYRIT (Paste
Special) ]I A=a1—IZ 2 DOFHLLVATURABEMENEL, BilEhf-avy
RIZTEDERIZFEE (Move to Staff Above)l&l FTODERICHEE (Move to
Staff Below)]T. CNoDTIHILEDF—FR—Fa—rAyvkE [At]+[N] &
[Alt]+[M] &V FET (TR (Edit)I>TFERFTHIET (Cross Staff) 1> EDFE

FFETHIET (Cross to Staff Above) | ETTDFERFTHIEXT (Cross to Staff
Below)IDT 74 ILEDF—HR—Fa—bhvk [N] & [M] IZEERISETLVED),

SNEDIATURIE ERLEBEFLREDTATLERADERINSUIVERY ., ThE
EDNTORERIIR—ALT2E%E%E 1 DOBRETETIEET . ChIESFIFL
WRTETHEFLGHEETT , X E MIDI T7AIUDSF—R—RD/\—+E5H
HRAAEER. BIOBEREAFOERINSEFOERA. FLIEFEFORRIS
EFDERABHSEILENHIEEO. FIREOIIRTO—RFEEY T
—REERALIE. BRORA VT E2RABETIVENHHEELREITERNTT,

BFICERIDEMELNTORRICBHIIESE. EFOHRFLAEN (F=
[FHAR) TEDLOFETERICEFN TGN E EFIFLETOERICEEET. &
FITERSETNREELGYET OTIEELTIZEL,

REEFZENTOHEKRICERTS: T LOERICHEE (Duplicate to Staff Above)]
LTTDEERIZHER (Duplicate to Staff Below) A\, [#REE (Edit)>T4&7E4R05Y
f$1F (Paste Special)J¥TA=a—IZFHLGEMSNFELIZ, COATURIE. TE®D
ERICFEE (Move to Staff Above) &l TDEERIZFEE) (Move to Staff Below)]
ERTOET N, AYRTURR—=RITIRGEAE =T U RR—RMEATE5T=8 . FEiR
LIE-EREFTOERICELENS ENTORRICERTEET,
)Fa—R: YFHY23y (JT21—2R) TlE.1 DUEDAURRYIL AV D HEE
EHL T, KUDBNADV RIS ILAVE (F—R—FYF a0 DFEEIE 1 DDA
DARGILAUR) IZEIVETEY . COFREOMNDFRIZM BB T B
HIz. THRE (Edit)-THEERY T (Paste Special)l»)Fa1—2X (Reduce)l
M#FHLGEMENFELT,
FI.IT1—RTEHEREZMERE (Edit))>Mad— (Copy)iTHoJvTR—KIZaE
—LFETRIC.AE—LEERDUTa1—R5%EEED 1 DULDAVREYILATE
ZRIRLT.THE Edit) >THKEBY T (Paste Special)J»l)Fa1—2X
(Reduce)lZ:E&IRLFET

Dorico [FAE—L=BRER—XNFBRIC. ROLSLEBRETLHEVET VXL
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A—HILERFE-—DFEHITY—ULES . A=V OEFITHIBRL . FTE DAL
EDRLERIZE 1 FOHANR—RALENELIILET, RS DERE. +94
— T8, Fa—(TWMYKREFET,

AE—LEERZBIRLEAV AR AVMMIR—I T BZEOE|YIRY (B BRI
RESN AR—RFEDAVRIGIILAVMETARTLLEES 1 DDAV ARG LAY
FDOBEFEZITIRY . BREIZHELTEDAVARIIAVRDEFEERULET . F2EZ
(.4 DDAVARYIAVEHNSLEFREFIE—LT 2 DDAV RMYILAVKIYT 2
—RATBEE. BRIELDAVRIYILAVEDLIEIZ, 2 DDAV RS ILAV Y
ZIZHBNINFET .5 DDAVARYIILAVINSLERFIE—LT 3 DDAV ARRY
WAV F1—RFTBBEE UTA—RED 1 DHDAUARYILAVKZIET
E—t®D 1 2HE 2 DODAVRARYILAVENG, BFRIZ 2 DOHIZIE 3 D&
4 DHMBH.3 DHIZIE 5 DONSDEENENYHTONET,

IHRTO—K: THRTO—KEIE, LKDH BE 1 D 2 D) DAV RRYILA
VEDEEEEBRLT, JFYBLDAVRMYILAVMNIR—RMN BT EEITHRTH
—RIEEVERDLIEZLDTY . O TERE (Edit) 1 >TRERGRIEY 1+ (Paste
Special) X TTHRXFO—F (Explode)IMbRITTEDKIIZHYZFELT=,

FITHRE (Edit)>TaE— (Copy)lZEALT. TVRTO—FEEHEREY Y
THR—=FITAE—LFT, RIZ AE—LEEREIIVRTO—REIE LDV Ry
ILAVRE 1 DULEEIRLT, T$RE (Edit) I>THE&%GREY F+ (Paste Special)]>
[THRFTA—F (Explode)l&&RLET,

Dorico &, HAFDAVRRYILAV I ENE N, TELEHRB DO LEMSIRIZ, @b
$ 1 BRZHTIMALIICLET . MBEERTEIEROEAENEDA R
AV E—BTBHEE . AVARYILAVNEFNEFN 1 BEIOZITBYET . 1T
T AEROBNENEDAVRRIILAVMIEY DIENEE. 2 DU EDA
DARSIIVAUNIEILERMNEIY B TONET,
AS—OBEREEHEDFTFTIIEVVTATLE BHAXDENEADAY
ARYILAVKZEREINET,
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BEREITA45—

ks i-I§E (Engrave)I>[J®EHE (Playing Techniques)IZA47R5 &Y.,
BEOBEEBEERELTHIDFILEFERTESLSIZHYELT -,

= Edit Playing Techniques
Playing Technique Category: Name: Snap Pizzicato

Single / Above Appearance Below Appearance

Overpressure (Down Bow)

Overpressure (No Bow Direction) (.IA) G)

Overpressure (Up Bow) - f
Overpressure Possibile (Down Bow)
Overpressure Possibile (Up Bow)
Pizzicato
Pluck With Fingernails
st
Punta d'arco
Snap Plzzicato
Sul Ponticello {Bow on Bridge)
Sul Tusto Default placement: -ﬂl
Thumb Position
UpBow Popover text: ‘.%I
Playing technique: [ Bartok/snap pizzicato v I | Edit.. l
‘ Now | New from Selection
Duration: W
‘ Save as Default | | Revert to Factory —
Shown In Cues: —JS not shown in Cues |

[ ] IED

BEFDBERREEHRET D BFEOERIEEH/ETHICE. FA4T7O0JDELRE
2 BEEBEEDHTI)— (Playing Technique Cateory) JA=a—h @)%
AT —ZBIRLFET  CNITEEE—FDONEEHE (Playing Techniques)1/X
FIVISRRENDATI)—ITRIELET  EBRLATIT—DESREEN A=
—DITDYRNMIRREINET , BIRLTWSERBEN . #4707 0 A%
EHOBA VI TAEI—IZRTFSINET,

IT45—I&, BIRLIZEZBEDO A TITIECTHEAEDYET . [TFRE
(Text) IQERHRFRAITICRREINSITIAMERTLET . [FUT (Glyph)l
DEREEETST40V(&BRBBERTLET EEETBEEILVMHOOXF
%

1 DUEFERALETH, ERIEFEI+U M, TERNTHUb, SHICIXEBRI7AIL
FTEHRICHAEGHOETHERATEEY),

[FXRb (Text)IDEREEIE. COFA(T7OJ CTEERETEET, [TFRL
(Text) ] 74— LR EREL TR RINDITHFRANBEEREL. ZDT<CHADA=Z1—
MOERATETAV RN EERLTIEELES . TI4ILATIE ERT LT+
FREAILIE, TEEREBI4+20 (Playing technique font)JIZEESNTLNVE
ER
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T2 (Glyph)IDEZREEATIE. MEDT-OIZE 2 OFAT7AJT#HEFT, &%
ROLLET T EBEREONBLECHELGIMNIE>T . FAT7RT LFEHBOKT
LEa—@D792avnN—ITRET7AaVMN 1 D FIE 2 DONRICHET( D
UM 1 DFORTENFET RETAIVEDIVITEEE 2 DI TA3—H B
EFd.

Edit Playing Technique

Name: | comp.stringsSnapPizzicatc

m Text Graphic Composite

( )
E I mlul v | A
OO0
m [S8) -
~= ol = ¥
> Soed gs bl >
<
Zoom:—{_} Select: | Previous ‘\m ) ™)
Component ‘,‘1. Ak
xoffset: [000 [ Xscale: [10000 [  Attachment from:
vofset: [000  [3 vscate: [10000 [5 Attachment to:
Z order.
Stem )
Stem attachment: X [ AddGiypn |
Cancel m

BERBEAICHROERTEMTBICIE. A7 ERD RIS RIRLET,
(72 (Glyph) 127 Wl FED I+ MDIEBEDXFERIRTEET . [TFR
b (Text)IZTDBIE FEEDTAVCREAILDEEE 1 DU EAATEET [
57494 (Graphic)]27h5l&, SVG. PNG, £zl JPG 74— vbDT 574
VI AR—bTEFET, A EDHE (Composite) 12T h 5L, TOD IR
THEASNIBFEOETEREZTEMTEET,

BMLE-EHRF, ROARSYSEEE [A+XEF—TBETEET, BEXRFTEFN
TR NAVELOWETRD 1 DEIVYILTRIVTTHH.TX Ry—IL (X
scale)]&lY R—JU (Y scale)lWAE AV bO—)LEFERAL TR REERELER
TEFET VSTV ERIIKFEFARELEESRADBEREMILTCERTEETH
G TFERAM A ELEDERICEVTE., EREIHARICHETEET S
ENHYES,

BEHOEZNELYASIBEIX. THIROIEF (Z orden)I/REZFALTEIRL
FERZARICBHIELLET. RERDRTORIRBERERETEET,

BEREODTHAUNTRLIZ0. TOKIZV)YILTE 2 DI T452—%FLC., #
AFA7ATIZRYET .
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AMUDTUELA—NRRIILDTFIZHEIEDMDF T av(E LTFTDESYTY,

AT3'Y)— (Category): h73)—%FRL T, COERFEZIREEE
(Playing Techniques) I/ ARILDE DI IVITRTTINERELET,

FI+ILEDEIE (Default placement): EEHEZEDTIAILIDRRUEE.
RDIE (Above) AT (Below) IMEELET

581 (Appearance): JYUIRATDBEEBEDOHITERASNE T [LTELE
C (Same above and below)ll&, SBRIEZERD LF-[ETICRRT D,
WThRICEEBEEATHEEZERLET . [ ETFICE->TRLS (Different
above and below)ITlE, ERD L TFICK>TERLGLEEEIBETEET,

RyFA—/R—FF X+ (Popover text): COEEREZRETH-OIC
[Shift]+[P] DRYTA—N—ICARNTETFRANEEELE T I TICHDES
BEICEVATONTOASTHRRNEIEET 5L TTA3—MNEEFEEHLET,
BEH% (Playing technique): BERFICERICRH T HEERETT , KIE
ZSHRL TS,

Talb—33> (Duration): FESNTWSEEBENDERBRTOA T3y
A Dorico [TFRTREINTIILEL=O FREDTIDHEYRLERIZM
AT 2B BR. BLUSESELEBHEOXRNMNEMEINDIFETY). BFR
TOMRIEEONFTH . SEORRICKY., BRRENT IAHILNTERRE
£7:95 (TaL—avdHY (Has duration)]) A, 1 HFFDELED 5@ F
shd (FalL—aviEl (Has no duration)]) MEIEETESELSIHYE
ER

Fa1—TDFRER (Shown in cues): Fa—MNSBITDAUVALYILAVIIDE
EREEZEDDIREITHEOTVDGE . COEREEEF1—(CRRIHMLE
WAEEELET,
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BEROESRRE: %8 (Engrave)I»[EZEB% (Playing Techniques)l& A
7O THBRERELIZIERRZEEIANT. BEAQOESREACEEM oA TL
FI . EBEREONBEZHRETHLEIC. TEERE (Playing Techniques)lA=
A—hDBIRTEET, £, [EEHE (Playing Techniques) | A=a1—HEID
MR&E (Edit))REVED)vITHE UTOIAT7RIThR RSN BEOBLER
DEBREERELTAHIDFILDOERETHEAET,

® Edit Playing Techniques

Playing Technique Group: Name: | Pizzicato

Pick scrape Group: | Techniques
Pinch harmonic

Alias for: (Unset)

II

Pincé Fallback: (Unset)

A Ping

Pizzicato Articulation type: Attribute [SIIEERET

Pizzicato alla chitarra

Pizzicato secco

i New I I New from Selection I

I Save as Default | | Revert to Factory |

(et | 2N
T ==~

ELBONEES XD IL—F (Playing Technique Group)lA*=a—I&. DY

W—TIIRT 2BERADERTELRET HINEBIRTEET . ChoDTIL—T

(& VST THRTLvLaveyIBRATERSIN. EFOBEICTSEZLMRDEA

TEERELET.

m JEEHE (Techniques): 2KMLBHOUFDMEICEEF SR 5EEREAT
ER

» HEHEES (Dynamics): Y OURDEBEEFRIITAVIICEEEFS5Z 5EREE
TY,

» RBX (Lengths): BREERTEHTAL—3v0 LA—MPTE IO LK
YOURDUEICHEETEZHERRETY,

» EHE (Ornaments): EZRAFENEVFISHLEMD S OELEZEEMAT-
Y, BOEYFOET I EELSERYTHERIETT .

115 R—2 Steinberg Media Technologies GmbH



Dorico 2 /N\—2av R

@ steinberg

TR DOIEa (Name)lld. & E (Engrave) 1> E®EZE B & (Playing

Techniques)l. TB& (Play) M TH9RXFLvyiar<yF (Expression Maps)l.

HXUTEE (Play)»[/—hyParwyF (Percussion Maps)IDFA TR AN

DIVAMIBEWNT, COBERBENEDLIIITRITIEININERELET . BERD

BEREICFENZTNUTOEERETEET,

n TAYF7RF (Alias for): ShRZEMMTSBERDERTEEFIBELET,

» JIL—T (Group): COBEADEREENKRRIINDGT IL—TEEELET,

» % (Fallback): COEZREENERATELGNMGS . MDOYICERTSIBEER
DERBEEEELEY,

» P—T4¥al—arDR4F (Articulation type): BAERADBERRENE R
EMBDT2AL—2aVERELET, THE (Attribute) IIEZDREDEFD
AITEREIN (RIVA—LDT—T14F2L—23275 ), [E#E (Direction) &
LIBEO TR THOEFIC MOBEBEREICI > TRYESNIEFTHREZEZ KT
F9 (EFH—LDIETRREE),

ERERALIOKIZY Y ILES . T EFEHFRIEBRSN-BERAD
BEREZIOC I CHATEDLSITAYET,

WELLERBZZMOTOADcINTHEATESLIICT S 8 (Engrave)l>
RZF|HGE (Playing Techniques) | TiTH>T=#REILT AT, TIHIILMTIERE
DOTAVT IR ICEREINE T FRERFIREL-BEROERREES
BIERT DI ATOTODIMTHATESLIICTAICIE. FA47RTERDYR
EVBSEZY T HEEHEZTEIRLT. [TIHILMELTRTE (Save as Default) 1%%
Y PLET , COBERBEL. SEERSNSITRTOFHRTAODIMIRBREN
E3 R

TIAHILEDEEBRICMA-REFTICETICIEZ. 4700 ER/ID) AN BHE
LI HEEFGEEFRIRLC. THEBOREIZET (Revert to Factory)1%&9')v9
LET,
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FESERIA M Petalumal

Dorico 2 IZI&. FEEZDFE I+ I73)—THSPetalumal B FfzIZinhHY E
Lz 2DT773)—I[&, IPetaluma]. Petaluma Text]. [Petaluma Script|j® 3 D
DI+ TEBEINTOET, [Petalumalld,. RA7HD TR TOFEEEIZME
RAEINBAO DI+ ETT, [Petaluma Textll&, AA/—LT—9, 3—FEEE.
BBRELE. THFRAMNDIIGTATLIZEZTAFNLIBTERESICHERAINET,
Petaluma Scriptll&. RA7HFDZ DT X TOTHFALTOERIZELIZRVT
FI+2hTY,

INTRO
Bsmaj7 Esqen

7P 77

.y

Petaluma 773!)—I&. Jazz Standards &5 —RMLGEEETHERAINSGFE
FRFMIVISHEB I TEINTVETH, 1350 U EDFEIEFL 500 LI EDFR
DOLIN—R)—ZFL. INIEEAEYFTHITSN TOWSHRMDO B TH, (THHIC
NIITA—ICETHDELRYFET,

JAYz IR T Petaluma #FEATHICIE. B E (Engrave) IPTEE I+ b
(Music Fonts) 1% ZEiRL . FRATESEE T+ VLD Al PetalumalZEA T
TOK1ZEZUvILET, ZhizkY, IPetaluma Script$ 7O TICDTIAILED
THERRIAVMIBYEST MOTFRACNIA VL E2EATIHEEET. THE
(Engrave) >[4 hR24)L (Font Styles)IDITFI4ILbDTFRANATAVF
(Default text font)l, BLUI&EE (Engrave) I>TER&E X2 AJL (Paragraph
Styles) 1D TI4ILEDTH XL (Default text) IZHwmELET .

Petaluma & SMuFL BE#tOEE T+ MTHY. SIL Open Font License (OFL)
DALV RERITTVES, LI=A>T.OFL OFTEEZVI—RTBHRYIE. B
HICHERA, EE. BAETHEIET ., [Petalumal iSO T4 I7I)—DFH T+
VRBTHY . RETAVMEICD T NBEERTEF A REIC,. T bT73
|)—TPetalumal B LUV ZDIRET+ &, ERIICERFTETEFEH AN, TSNS/
Vr—SD—EELTERATEET .
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NotePerformer 3 MHHKR—k
Dorico 2 &, Wallander Instruments [2&% NotePerformer 3 MHHR—rHEA
LTULET, NotePerformer &, ZiEERY IV I T ICEHABEDT=OIZHFAIIZER
HENFN—FVILA D RRGILAVRTT,

C

NotePerformer 3
Fuo  Obos  Cldel  Basoor  FHm  FHm  Trurpet Trombon o 55 m = Dt Vot
[ ] [ ] ® ® | ® @ [ ]
R6 (81) L7 R R11 R21 R32 R3 c L4

100 100 00

0 100 100 100 100 100 1
II L] L] L] I . L] L] o . . II . .
REVERE REVERB REVERR REVERS REVERS REVERD REVERE REVERS REVERS REVERE AEVERE REVERB AEVERS A
L L L L

100 100 10
0

" 15

NotePerformer 3 (& Dorico 2 IZ A B ch TWFEFHE AU NN .
www.noteperformer.com KYRIREBEATEET . £/=. ZChn 30 HERISA
TILRES Do O—KTEET,

NotePerformer 3 #8ALA > X+—J)LL 1= Dorico THERATBIZIX.
NotePerformer AL TBEEZTH57A0zIMERE. THBAE (Play) " TBA
ToFL—F (Playback Templates)1&#Z#IRLFET . BETUTL—FDYRDDS
INotePerformer |ZR#IRLTIOKIZ V) v ILET,

NotePerformer # 4 R TOFR IO/ NCHERATHIHEE (L. RERE
(Preferences) DI £4& (Genera)IR—CDIB/E (Play) 1o avIichdlT7
FILEDBETUTL—bF (Default playback template) 1% NotePerformer 11Z5%
ELFET,
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FREFECS

HALion Sonic SE ®ZFDfthd VST /—rIHRTL vy 3 xthits VST 3 12X+
HILAVMNZIBWT. BERBLURE FOSHERBORLEZDOEIZ. oS0
St EANERICEBEShALSZHYFELT .

F—T1FEEHL

Mac &Y Windows T A—TA44ZZHLIDEB T/ T7OTHARTIND K
SITHY EFTHOEBROEBS LY EREICIEBIETELILSICHYELE:,

IMETHR

BETRAAILD RE/NE#E: The New English Hymnal %ED—ERDEETEIC
(F. RE/NROMBLEHEENRONFET , TR TOAR—RDMEITEANKRRE
N HlDLREAVRDOHEAEHLEDIDLYIZ 2 KOHLVMNIRNEINET, =
L. MR D FAIR I E [XFIS T INEIRNEC 4 DDOREZTNRERISINET, FE
AT aDUNG#R Barlines)IR—UICHBTRCHEICHIRETLS (HRd)
D58 (Coincident repeat barline appearance) Iz #ILME#HEER (Double thin
barlines)lI=. TYE—FD EDH (Repeat dot frequency)1ZIERAD T RTD
AR—ZR (All spaces in the staff)l[CERE T HET. CORERAICHETES
FIIBYELE,

MBS

RAFONEESOHE: RAFICEFENLDEHESOEHEZR T TESLIINE
YELIz. CNERAFOETICRREINES . ChEBRITTAICE. LATIE
Ta nlIMNGES (Bar Numbers) IR—UICHhAIRAFTII/IHESDER
#%:®7= (Show ranges of bar numbers under multi-bar rests) 14 IZLET,

FBEXFT A DMRE (Rests)IR—UIZHLWLWA T avhBMESh, SEREZTD
TONBEDERARTEDT IAILCDIEBMDLERL, SEERTRD 1 DHE 2
DHDINEFBESDRYUYXFDIREFITHRZDEIITHEYELT,

ERBHLATIMIBTHNEEBSDONE: LAT I T aonlNGES (Bar

Numbers) JR—JIZINSTSTREAAIDFHLWNA T avELTEMSh, TS
IEDELATIMIEDINTTZTREAINEFERTEINEBIRTESHLIITHYEL
o HRTADIHITIE, FNRATELVHRZLROT7HATIMGES (R37)
(Bar numbers (score))ID/NST STRAMI\WEFERTEH—H. /\—kLATIRE
MBS (/3—b) (Bar numbers (parts)) 1D/ NS5 57X 24 ILEERALET , Bk
FOTODIHIRTIE, RATLATIREN—FLATOROWVWTRENINGHEE (R
a7) (Bar numbers (score)) 1N /ST STREAJLEFERLETH. Ztlk Dorico
1x TEAINDDEHESDIAVEAZMILONRIC—HITDLIICEHFRINTE
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Y. Dorico 2 TV VMRV TH/NEHESDABNEDLLLENEIITLTNE
ER

TI7AILLTIE, IMNFES (R3a7) (Bar numbers (score)) 1ETNIES (718—F)
(Bar numbers (parts))IN/NSTSTR AL LIEWTNERCHEREFLETH. E
AMZRBANEFEDEIZKY  TIVARATICHEEEZ T2 IN— AT IrD N
B EDIT+U b YA X RV EHHEICERTEET .

J—FEES

HZ5—: a—FREEHN. TanT«DI—§ (Common)F IL—TDIHS5— (Color)]
TONRTADEREITHSKSITHEYFELT,

K o

B

BEHLUBAE CTEASNSDEREESEIEET 4: Dorico IZT)ybEh TS
AVRARY AL TICIE RELEBRBOEELTRTTIRICENTNELDLE
HEEEHEATLILDOAHYES . BEIZHLT, 70—DEHREEFNEFNIZC
FEBRIEETED &SIV EL, TIRE (Edit)>TEEEE (Clef)l1 T A=a—
(2. T5EE (Concert Pitch)1&T#BEAE (Transposed Pitch)JD 2 DOHTA=
A—AFHLGEMESNFELz, SISO BIE, BBEE—FDOIFEEES (Clefs)l/iR)LhH
SHATEDT R TCOEHRBEINBIRTEET,

ISR S

EBRENHERETEYDSY: BERESBRSICEETFANELEIXETFAL
AIKBE . THF A —RADREFAFESNNIRZEECIHEE ., FEIE
NIGRREL T, RBESHERORNAIICERESNTLEIGE. BIBEL B T/ME
ROERED—EZEY DS EDLIICTHILET, BBESHNEYHRA LT L
WET.

TO/IRT4NRNRILDIBRBEE (Dynamics) T IL—TIZ. TEREZEYDAL
(Erase background)lZB/ST4DFifzIZBMESNFEL Iz, ChiE, B EE—FTO
HARTINET, COTANTAEAUIZTHE, BBF RS EDLOBEEMNDLEYD
AENFET . RBESALORBDTIHILEDRESIE BEA T3> DIAH
25 (Dynamics) IR—UICHzICHRBSN-[ABREERALOEREEZEY DAL
1=&B8 (Padding around dynamic with erased background)ID{EIZ&VYRTE
SNFET, TANTARILDIEFEES (Dynamics) | IL—TIZH=ICHESH
t-T&B%H%E (Erasure padding)l7ANNT4ZEMICLTHREE LEZTEIL
{TEET,

RADHKERET DHHE., Dorico [TABETFANBLIUVRETFRAMNE . FA4F3yY
IULRIVETRTR—ILEAR) RN XFEIFIRALTRET =6, f risoluto D&
SHRPILBICRAZHRITAEE.f DE=HDRAIL risoluto DI=HDRALYE

RGYET . RAK. TIFILITXFO L TADQEREHLBAITLRBEN ST
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O.EBEEDEDID TIEIREFCHITKLTIE, BYD RSN BB
BEULICKECRADBENHYET LA BRBELEBSTOXRETH XL
espressivo MIp I TIEELTs I DEBH TIMEHREZF-CHE. RBELEDTORA
DREFTELDISICRZAFT . COMRERELT. BBLEFRALOKRAD 4 AA*T
NENORESEEFNCLEEETEET . TFRAMDEEHLE R LYV TETREST
LIFREVWESICTRAZELLT, BYDALEEENAXFO LT THMIZRZAS L
JIFHELET,

BYDSSN-RBMEEIL. RBELESOERERHADERREEBH TS —MMELT
RiGEh%xd,

BIRDLI2IATEY: BIRDEN2IATEVIE. FA4FIVILRILD R
BARFELTEDERTOIC—HBOEHREBEICI>THEASN . [RBEATEY 1E
FIENBI5E5ELHYET . ATELDRIFICENYVERTBIZIE ATEVERIRL
T, HLEMEN-TRIED LMY (Flared end)17ON\T4ZAICLET, 2D
TRNTAIATELELTHMINDEFEHRIEEEF T, ERTHEIMINDILDTOH
ERATEET,

BIGDELYD T IAILED YA XE, BEA T3> DI85 E (Dynamics)]
R—ODIEXREMETEEE S (Gradual Dynamics)ltoavIc#sksn-IkiEH
[Eh>f=TFHAL> (Flared end design)|Z IL—TRDF T avE=EBLTHEEL
FTHARDATELDRIFDIENY DY A XL, FEE—F T, HILGEMShT
[EMRYDHAX (Flare size) I TO/T+DIME (W) IETEE (H)IZEELTHRE
LFET,

T4IL3—

[$REE (Edit)I>T70ILE8— (Filter) ] A=a—[2v—h— MY E—MEEBE LU R
Sy afBENEBMENELz, T-TAIINE—AZa—IF  BAYYIIZ&BAVTF
ARMAZa—DHRIZEFNDESIH ST BHHEIZFUHITENTEET,

245V

HRALEE: TO/IRTARRIDII40HY2S (Fingering)1F IL—TIZ TR —
JU (Scale)17B/N\T4HFHLGEMENFELz, CNIEFEE—FTOHRTRIAN.
T4A) T DRRMEEE . TNDETIERORTERLEANICERTEEY,

B4 HIT ONER: TRITARRIDIT42H Y25 (Fingering) 15 )L—
FIZHLCGEMSN=-THYEERE S (Cautionary) IDD., BYI T4 HU T D4VE
ZEMNCLEEETEDLSITHRYELz, CNIEFEE—FT (T4 HILT TIEEK)
BRPBIRSNTOSEZLETRREINETS, COTANTAIX RBUT10HIYT
TNV -BERDIGEETOHAVICTEEY . TAUSNOERTHEBNICATIZRE
ENFET . TANRTADNFTUICHEDE UTOENSBIRTESLSICTHYET,
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" T4 (Default): FEFTLav THRESNIZROI10H) T DNVEERE
FALET,

= }E304L (No parentheses): 4> H) I EFIMELTRRLET,

» $FIDF (With parentheses): FEME FTIAAH) T ERRLET

= #PFl (Suppress): BUITHI T EFELITERTFICLETS,

RFEFLETHRAEDIT«HILT: TaoAVDT IR REILTHRE
FHHIENTELLIITHYFEL, COLILGEMEITIA—TAF DT HIY
JTHERAINDGENHY B TALTTERIATERTHLERLET . Tt
AT BT T4 HIVTBEBEERLT. TONRTANRRIDII42HI YT
(Fingering)17 L= 2 LGEMEN=TFaL— 3> (Decoration) | 7A/\T 4
EAUILET . CNIEEEE—FTOARTINET  FELF T3040 HY)
>4 (Fingering) IR—C DI TH ALY (Design) 1ty a> TCIHEMETE
(Advanced Options)1H 70 a3 BT AL AV EAHRD YA X BOKS
BEDATLaVvEH/ETEET,

FyL—Ea—
2 EHAOBES LB LUR LBORED LO/NMIBEEOY A LM EAKE
éhgsbf:o

HALion Sonic SE
Dorico 2 [& HALion Sonic SE 3 ##E8&8H LELT-. HFILLWN—Ca  BICEFH SN
ARL—2307ZaF7ILIZDWWTIK UTFTOH A RESRBRL TS,

https://steinberg.help/vst-manuals/halion/halion-sonic-se-3/

SEY—
R)a—LT7z—F—Ff=Z/varka—ILIZENT, [Crl]+21)v% (Windows)
F7=I& [Command]+7Jy%y (Mac) 9 5&. TI4HILMEIC) 2y TESLSITRY
EJO

BH

FREEZLOER: T7ONnNT4N\RILOIEHFEARFF (Notes and Rests)|F IL—TIZ
[FRBEIERT (Hide stem)1TANTAHFHIZBMENEL -, THIFEFEE—F
TOHRTREINFET . AUICTEHE BRLE-BROFELARIINGGY | RIS
FHLERTRICHBVET EBRLEZBFANENOTIL—TITA-TLSIGE. FE
(FIERTRICHYET O EMIEBELEBYICRRSINET, 1L, EHDTIL—TF
BT HEFIARTCTIHREEIERT (Hide stem)ITANTAHFUITERESNTZ
HEE EMLIERTIEYET,
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BHDAS

BEOEFEEFICHAAD: BIRLEBEOEHNE 1 DULOERFICHEARA
HBEINTIEYEL = ERFICER T DERZERLT. ;) (E230Y) 28LFET,
BERFORYTA—N—DRHE, BRLE-EFROHET 2L —2avhbiRESND L
ERRTINFT RESKIZLEBOFE, FLEEEOLEREAALTHS,
[Return] L TRYTA—N—2HELET . ERLE-BRNVEELIZLLEDE
B 1 DICNFEZIEEXEFS 1 DEHERShET 5 E LI RARIRLT-
BRIRTEHRARTICET TR THASEEIE BIRLE-TRTOEFIERIC
INFELETEMDEFIMERSNET,

EHOTiL—2avIiinddXE 2h=2 £5HF.w= £5%.h=2 3.
q=4 7ER.e =8 NERLE) FEBBFANDTIAHILIDF—HR—KRIa—
bAYMIEITETaAL—avIC/HGTEHF 9 =2 £B/.8= £2FF.7=2
NEM.6 =4 PEF.5 =8 NEMNLE) ZAMTEHILICKY . ERFOBDELL
ZEFORY T —/N—ICEEIEETEDLIITHYFELIz, 2.1 DU LDO#LE
F(EVAR) XFEMAAILT HRAMEDHOBELERETEET . TaL—
IVDIEEICHFEHERT 56 . AREADEAEIR—ZANNATU TR Sk
BELBHYET . EAE 154911 TFR 4 B 4 DORSICTED 5 EFFIE
Y.

[3:2-2wllEM2 £FR/F 2 DDOERSICTELD 3 EFILHYET,

BEBHOAR—IVY

MNILTEFE: BT HEROMILTHFEAEMLENELSIZ. FEDKIHICH
IOERENEAONEL BMLESRGE 3, SERMEICEFIAIIEREA S
nFEy,

HE S

HEBOLOIVR TRBOLIIVER UN—HLY—IBLUTURIERTF
ZORBISEESND&SITHYFELL,

BETUIL—H

BETUTL—MIIE VST 412 RRSILAVRETIE MIDI T/IAA ADDDH IR
2700 OMDAV ARG ILAVMIERE T 51812 Dorico AMERT S/L—ILHEE
BINTOWET . CNETIE. TIAHILNOBETUTL—ME 1 2FZFT. 7AYx
JEDOBEAEIZ HALion Sonic SE DAV RIVABLIUABESNTLYS HALion
Symphonic Orchestra & HALion Sonic SE D54 73)—Da ToY%EFERALT
WELE= FUVSHILDHHIURFEE VST AVRRYIILAVREEIYHTT, T4
LWEOBETUTL—rOERE LEETTHILETEELRLA . TNEITLESE. T
T+ ILEDBETUIL—DOERZERLUELRY. Dorico (FBATYOURFDE
YETEITHEOELG>TULVELT,
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TI+IEDBETUTL—b: HIESZSDOAMHETHS Dorico Elements (&,
HALion Symphonic Orchestra BiREBEL TGS, TIFILFOBETIE
HALion Sonic SE S4735)—0a>TUVICEEITIKFELET, 2D 1=, Dorico
Pro T I4ILEDBEETFLTL—RELT. THSSE+HSO (Pro) ] &M HSSE
(Elements)I® 2 D&RELTLVET, BIFE (L Dorico 1.x DT IAHILEDBET
VIL—rERLTY, #%%F(E HALion Symphonic Orchestra DY o2 RE—H){E
FA&9 . Dorico Elements DT 74 ILEDBETUTL—FERLBDELRYET,

FRIOC M EDBETUTIL— & FERTEHINEIEE T H1-OIC. [REBEHRTE
(Preferences) IO 2% (General) IN—CDIHB4E (Play) 122 avIZIFI4)LE
NDEETUTL—k (Default playback template) 147 avhEimshELT=,

BEDODTOCIHOMNIBEBLRZBETUIL— BIRT S, FHIETIHILNOBAET
VIL—FOWT A EBERITZICIK.TEBE Pay)l»TBETFVYTL—Fk
(Playback Template)1Z#ERL. VR OFERTIHEAETUIL—FEERLE
ERS

BETUTIL—MESHIZEMT S: Dorico [, BAETYTL—EESITEMT 51

OIS, VRTLERFFA—F—EEDT7T ) r—2avT 274 ILF—IME

9 5. [PluginPresetLibraries 1 & U T PlaybackTemplateGenerators | &LV5 7

FIWE—ADY T IHIWE— Do T—REHRAHRAAET  THIVF—HREFUTDE

HBYTY,

= Windows:%PROGRAMDATA%¥Steinberg¥Dorico 2 (AT LEK) Fi=(%
%APPDATA%¥Steinberg¥Dorico 2 (A—H—EH)

» macOS:/Library/Application Support/Steinberg/Dorico 2 (¥ XTLEK)
FE1=1X ~/Library/Application Support/Steinberg/Dorico 2 (1—H—[EH)

NBDITHILE—RADETTIAILE —DLRIA. Dorico IZHITHABETVTL
—rDERTEHELGYET,

[PluginPresetLibraries INDIEESNI=H T IHILE—HS LUTD 2 DDIT7

AILHBBE—RShFET,

m Presets.xml: N—F¥ILAVRARYILAVRDZATZ)—RADTATOT vk
FENNVFOVRTY  KFIEBICH G T HITIRT Ly avwyTE = IF/ 31—
HvarTvIDEMEERLET .

= Presets_for_instruments.xml: Dorico RIZHERTESRT IAHILEDAV ALY
IWADRRALTTRTE ZDAVRRG LAV T IHILETEHRAREND T+
YEDY AT,

[PlaybackTemplateGenerators INDIEE SNI=H T I+ LT —IZIE,

playbacktemplategen.xml EWV3T77AILBNFELGITNIEGYER A NIE,

FARAEND VST AVARYILAVE @ UID, AT BIPluginPresetLibraries |
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DT—E. BEUVFDMNLDOMND/IIGA—F— (F=EZIE AV RRDILAVRIDIR
#HEND MIDI FYoRILEB A—TAFTHADE. TTIVMF YU RILVADTI4
ILED Send FLR)ILIEE) #HRELET . U T 7+ LT —I2lEATarv el
T .pluginstate Z7MILDBEENDZENHY . VST AV AMS LAV D VEREF
[SAVRARYIILAUCDRIERAFRAENET

IVRA—H—DNINoDT—2I77MINEFRALTHRBEDBETVITL—FEER
FTHRIELEFERESNTOWERE A COERIE. —F/S—F4—& VST 412 XYJL
AVEBEUHHIURSATS)—DREEDFED-HICIREShTWET,

EMOERE: BEA T avDIF4205 (Timing) IR—DIZHEIEEAENT-T

al—av® % THEE: (Play as % of written duration) 147 3> A,

ROEFOEBVNTURTEASWAEEDERNERINTELROLIITHYEL,

BN 4 P ERUTOTaAL—23>THAGEF. EESh-RSEZITEREISN

FI. BN 4 PEREHALSRSITHAGSE. EFOEDY 4 2ERORS
DEBREZFLEERREGYET . D 4 PEFORSOBACIETZOHRICE

(F2TURBRBEIN. EFIEIRAT 1 26 4 28F 120 AOTURDEED
4 NEFRISKHT HIEEDNEI S TRERESNET,

BAEANYREERUEICEET S BRSN-HHORODTATLOMEIZEAE
~NYREBEISE S, FHLWLWF—R—Fa—rhyk [Alt]+[P] (T74/LF) AEBME
NFELIz CNITHRHETATHEETHLE ETB LOBEDUENETFDEDT
L—AISHIE T 2N EHERETES=0. EEIZERTT,

WEBE

BEBEEERTFICT S FELGRYERLEZ#E(TH-OGE | BEREEIERRIC
FTADNEELIMEELHYET . BRREZIERTICTTAICIE, BREEELTERL
T7OanRTDIEEHZEZ (Playing Techniques) 17 IL—FI1ZH BT ERF
(Hidden)17ANT4&FUICLET , MDA RTINET , B EIZHKHL T, TEa—
(View)I»THAF (Signposts)I*TEZEH % (Playing Techniques)1%:&R35&.
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ID # Component Issue
STEAM-4241 : Changing the pitch of a grace note before a barline no longer incorrectly considers the
Accidentals : :
STEAM-4294 accidental state of the following bar.
STEAM-5539 Accidentals Whep using the Second Vlennegg School accidental system, grace notes are now
considered correctly when determining whether or not to repeat an accidental.
STEAM-7472 Accidentals Under some rare cqcumstances, |t- was not possible to change the pitch of a note that
had been respelled in a part layout; this problem has now been resolved.
STEAM-7910 Accidentals The enharmonic spelling of rising chromatic passages in minor keys has been improved.
STEAM-7905 Audio export A progress dialog now appears during audio export on.both Windows and Mac, and
accurately reflects the actual progress through the operation.
STEAM-7047 Barlines pashed b_arllne_s to show subdivisions in additive time signatures no longer fail to appear
if the bar is split across a break.
STEAM-7077 Barlines Creating a tlrn.e.5|gnature chaqge at a dashed subdivision no longer causes previous
dashed subdivisions to appear in the wrong place.
STEAM-7132 Barlines Repeat barlines no Ionger draw !ncorrectly at the end of a system if they coincide with a
key change to a key with no accidentals.
STEAM-7301 Barlines Inserting a t_)arlln_e at the same rhythmic position as an existing dashed subdivision in an
aggregate time signature now works correctly.
STEAM-4846 Beaming pragglng the end of a stemlet now works correctly when the stemlet belongs to an
implicit rest.
Chord Toggling the Show as mode property on and back off again for a diminished half/whole
STEAM-7562 . . .
symbols scale chord symbol no longer results in the chord symbol showing as a different chord.
Collision Mysterious problems where deleting an item can cause an item in another bar to move
STEAM-7504 . X - .
avoidance vertically in galley view have been resolved.
STEAM-7716 Collision The extent of items is now always correctly considered for collision avoidance when
avoidance editing an item that is graphically wider than its rhythmic position and duration.
STEAM-7018 Cues If a cue abuts the end of a flow, a redundant restorative clef change is no longer created.
STEAM-7029 Cues Cues are now automatically removed if they are invalid under more circumstances.
Edits that affect where instrument changes occur no longer sometimes cause system
STEAM-7505 Cues objects to disappear if a cue is located within the range affected by the edit.
STEAM-5064 Dynamics Edit » Reset Appearance and Reset Position now work correctly on dynamics.
STEAM-6385 Dynamics If a dynamic has a color set via Properties, it now shows cor.re.ctly in the blqe linked color
rather than the orange selection color when another dynamic in the group is selected.
STEAM-6651 Dynamics A series of gradual dynamics interspersed with immediate dynamics and shown as a

single hairpin no longer draws incorrectly in galley view.
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ID # Component Issue
STEAM-7328 Dynamics Under rare circumstances, edits thgt affect the .\/el"tIC§| placement of gradual dynamics
would not be propagated to all music frame chains; this has now been resolved.
STEAM-7742 Dynamics Adding an immediate dynamlc.to the.end of an existing group of dynamics now correctly
extends the length of the flow if required.
STEAM-7782 Dynamics Hairpins that extend precisely to the end of the flow now draw correctly in galley view.
STEAM-7257 Fingering Thg In_dlcate shift to next note and Shift dl_rectlon properties for_stnrlg fingering shift
indications are now correctly reset when pasting notes onto non-string instruments.
STEAM-7384 Fingering Deferred f{ngerlng sybstltutlon now works correctly on notes and chords that are tied
between different voices.
STEAM-7409 Fingering Under some C|rcumst.ances., fingering substitutions could fail to draw as slurs, despite
the options or properties; this problem has been resolved.
STEAM-7217 Flows Duplicate Flow and Split Flow now correctly copy the flow info for the original flow into
the new one.
STEAM-7697 Graphics I_mported graphics are now exported at a much higher resolution when exporting PDF
export files.
Graphics It is no longer possible to change focus to another project in the middle of a graphics
STEAM-7767 . : . -
export export operation, which could cause graphics from the wrong project to be exported.
STEAM-7848 Holds and In some circumstances, a fermata on a bar rest could be incorrectly positioned at the
pauses start of the bar, rather than over the bar rest; this has now been resolved.
Key Adding a clef change at the same location as a key change now always correctly
STEAM-4826 . ) :
signatures updates the cancellation naturals, if shown.
Key Changing the current tonality system in the Tonality System section of the Key
STEAM-7618 . .
signatures Signatures panel now always takes effect correctly.
STEAM-7628 Key Creating a key signature from the Used in this flow section now always uses the
signatures tonality system selected in the Tonality System section of the Key Signatures panel.
STEAM-7796 K_ey The _tonahty sy§tem shown in the panel in Write mode is now always used when
signatures creating a key signature.
Changing the keyboard language on the Key Commands page of Preferences now
STEAM-7374 Localization works correctly when there are unsaved changes to the key commands in the current
language.
STEAM-7563 Localization The default key command for Write » Res.pell d Respell Using Note Above now
works correctly in the German-language version (Windows only).
STEAM-7361 Lyrics Using the Ief? or right arrow key to navigate off the first or last lyric no longer incorrectly
loses any edit made to that lyric.
Multi-bar . .
STEAM-6243 rests Multi-bar rests are now broken by both the starts and ends of repeat ending segments.
Multi-bar The presence of a system break no longer sometimes causes the width of a multi-bar
STEAM-7065 .
rests rest at the end of the previous system to change.
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ID # Component Issue
MusicXML Exporting with Export layouts as separate files switched off now correctly finds and
STEAM-7423 .
export uses the most appropriate full score layout for the selected flow.
MusicXML . i .
STEAM-6118 import Imported MusicXML and MIDI files now respect the Default text font family preference.
MusicXML A problem that could cause Dorico to crash when importing MusicXML files from
STEAM-7391 . .
import PDFtoMusic Pro has been resolved.
Moving the selection between non-note items with the arrow keys no longer sometimes
STEAM-7957 Navigation causes the selection to jump unexpectedly to the start of the previous system in page
view or backwards several bars in galley view.
Notation The Overlapping notes in the same voice in a kit or grid presentation option on the
STEAM-7487 - . . . . .
options Percussion page of Notation Options now works correctly for chords split by a barline.
STEAM-5499 Note input Inputting the first note in a new voice between rhythmic grid positions now works
correctly.
Under some circumstances, extending the duration of a note that ends within a tuplet in
STEAM-5555 Note input Insert mode could cause other later notes in the same voice to be deleted; this problem
has now been resolved.
STEAM-6546 Note input Changing the_ voice of a sel_ectlon_ (_)f npt_es no longer somet!mes causes tl_1e not_es to be
moved to a different rhythmic position if items already exist in the destination voice.
STEAM-7411. Note input Pasting a selection beglnnlng. with implicit rest§ immediately followed by a tuplet no
longer causes some non-note items to be offset incorrectly.
STEAM-7411 Note input Pasting a.selectlor_l that begln_s Wlt_h implicit rests fgllowe_d_ by a tuplet no longer results in
non-note items being pasted into incorrect rhythmic positions.
STEAM-7425 Note input Pasting a selec_tlon including tuplet_s into an eX|s_t|ng passage with |d_ent|c:_’:1l tuplets with
chord mode active no longer sometimes results in some of the material being offset.
STEAM-7449 Note input _Pastlng materl_al of the same d_uratlon as an existing tuplet will now remove the tuplet,
instead of pasting the material into the tuplet.
STEAM-7561 Note input Updplng the creation of a tuplet no longer sometimes fails if a non-note item is located
within the range of the added tuplet.
: Making a selection on a percussion kit using the five-line staff presentation type now
STEAM-7609 Note input correctly uses the extent of the selection from all components, rather than only the first.
STEAM-7657 Note input Copy and_ paste for instruments W|th|n_ a percussion kit using the single-line instruments
presentation type now works more reliably.
. Dorico no longer hangs when attempting to shorten with Shift+Alt+left arrow a note or
STEAM-7748 Note input rest of the minimum valid duration (1024th note).
STEAM-7880 Note input I\{Iovm_g the caret after priming a new voice no longer causes a voice with the wrong
direction to be created.
STEAM-7939 Note input When multlple |_tems gre selected_, hitting Return now starts note input, rather than
attempting to edit the first selected item.
STEAM-7490 Notes Stems in opposing directions on adjacent staves are padded by a small amount to

prevent them from becoming so close they may appear to touch.
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ID # Component Issue

Rhythm dots on stemless notes— i.e. a whole note (semibreve) or longer — in down-stem

STEAM-7508 Notes . . . S
voices are no longer incorrectly snapped to spaces in the wrong direction.

Glissandos between invalid note positions (for example, two notes of the same pitch tied

STEAM-7436 Ornaments .
together) are now correctly automatically removed.

Making a selection on the lower or left-hand staff of a piano instrument and then pasting

STEAM-7568 Pedal lines .
the pedal line now works correctly.

Pedal lines that span multiple systems no longer sometimes disappear when making

STEAM-7684 Pedal lines unrelated edits.

The notation option to remove overlaps for percussion kits did not always work correctly

STEAM:748/ Percussion for a chord split across a barline; this problem has now been resolved.

Piano Pasting piano pedal lines now works correctly when selecting something in the left-hand

STEAM-7568 pedaling staff of the piano.

It is no longer incorrectly possible to use the Shift+l key command to add an additional

STEAM-7516 Players . )
instrument to a section player.

The chosen page range for printing is correctly preserved when leaving and re-entering

STEAM-7290 Print mode .
Print mode.

Choosing a page range that does not include the first page of the layout, then switching

STEQE2s Print mode back to All pages now updates the print preview correctly.

STEAM-7764 Print mode Cancelling a print or graphics export operation no longer sometimes causes a crash

Repeat

STEAM-7199 s
endings

It is now possible to create a repeat ending when an explicit bar rest is selected.

Setting a property on an implicit rest no longer causes all other selected items to be

STEAM-6760 Rests removed from the selection.

The Bar rest design in long time signatures option on the Rests page of Notation

STEAM-7012 Rests Options now works correctly when adding bars to the end of the flow.

The presence of local time signatures on one staff no longer prevents multi-bar rests

STEAM-7545 Rests from appearing in the other staff if they line up with the bars of the global time signature.

Expanding a group in the Players panel will no longer cause the cards for the players
STEAM-5501 Setup mode within the group to be truncated incorrectly when the group is partially scrolled out of
view.

Tempo items with dx/dy offsets are no longer sometimes positioned inconsistently in

STEAM-5817  Tempo relation to other items.

The spacing of rhythm dots in metronome marks has been improved, particularly for

STEAM-7473 Tempo durations shorter than a quarter note (crotchet).

When the font style for gradual tempo items is set to absolute rather than staff-relative

TEAM-77 Tempo . . h S .
S 06 P size, the dashed or dotted continuation line is now correctly drawn at absolute size too.

Gradual tempo items with no drawn continuation line now draw a handle and attachment

STEAM-7723 Tempo line at the right-hand end in Write mode.
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ID # Component Issue
STEAM-6777 Text System-gttgched text can now be edited correctly if the top staff of the system is hidden
because it is empty.
STEAM-7536 Text Right-aligned text is no longer sometimes slightly truncated within a text frame.
When considering ties for the purposes of collision avoidance, the inside of the tie was
STEAM-7578 Ties incorrectly being considered instead of the outside. This problem has now been
resolved.
Time Under rare circumstances, notes and rests could be grouped incorrectly in irregular time
STEAM-7075 . . s . . .
signatures signatures within an aggregate time signature; this problem has been resolved.
Time Undoing the addition of a local time signature to an individual instrument now always
STEAM-7587 . . . - .
signatures correctly reinstates the previous global time signature.
STEAM-7561 Tuplets Undomg the creation of a tuplet where a non-note item’s position overlaps with the new
tuplet will no longer go wrong.
STEAM-3656 User interface D_rop-down menus in dla_logs _and pa_nels no longer _sometlmes appear on the wrong
display when running Dorico with multiple displays (Windows only).
STEAM-7510 User interface Focus no longer gets Iogt after _cllcklng_the_ buttons in the _note input toolbox, resulting in
key commands not working until you click in the score (Windows only).
. It i ibl ign k h File »1 > Fl Fil
STEAM-7637 User interface t is now possible to assign key commands to both File » Import ows and File
» Export » Flows.
STEAM-7647 User interface The various annotations that appear at the top and bottom of the caret are now correctly
scaled relative to the current staff size.
STEAM-7663 User interface Maximizing the document window while a modeless dialog was open could in rare

circumstances lead to Dorico hanging; this has now been resolved (Mac only).
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Known issues and solutions

Frequently asked questions

Answers to frequently asked questions about Dorico can be found online in the
Dorico forum.

Knowledge base

For the latest information about issues and solutions you may encounter when
running Dorico, please consult the Knowledge Base.

Entering the eLicenser Activation Code (Mac only)
When you first run Dorico and are prompted to enter your Activation Code, you
may find that after you have successfully activated your Soft-eLicenser, you must
quit and restart Dorico for the application to detect that it is fully licensed.

Key commands to transpose notes by an octave (Windows only)

The Intel Graphics Adaptor drivers used by many Windows computers define a
default key command to flip the screen by 90, 180 and 270 degrees via a shortcut
Ctrl+Alt+up/down/left/right arrows.

Ctrl+Alt+up/down option conflicts with the key commands in Dorico note input for
transposing notes by an octave.

For information about how to disable the default Intel Graphics Adaptor key
command, consult the Knowledge Base.
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